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Preface

This guide describes how to use NetBackup to back up and restore files and folders that
reside on a Microsoft Windows PC.

Audience

This guide is written for the end user and for the system administrator.

Organization

This guide is organized to help you find the information you need in the chapters and
appendices described below:

& Chapter 1, “Introduction”, provides an overview of NetBackup, describes how the
end user operates NetBackup, and describes technical terms and concepts.

& Chapter 2, “User-Directed Operations”, explains how to use NetBackup to perform
backup, archive, and restore operations.

¢ Chapter 3, “Reference”, describes the various windows, screens, and menus
associated with NetBackup.

¢ Appendix A, “System Administrators”, contains information important to the
NetBackup system administrator.

¢ Appendix B, “NetBackup Commands”, provides a detailed listing of commands
available for use on the NetBackup client.

¢ Appendix C, “Open Transaction Manager Parameters”, gives information on
configuring the Open Transaction Manager (OTM) parameters in the Windows
registry.




Related Documentation

Related Documentation

The following documents provide related information. For a more detailed listing of
NetBackup documents, refer to NetBackup Release Notes.

4

NetBackup Installation Guide for PC Clients

Explains how to install NetBackup PC client software. The PC clients are Windows,
Mac OS, and Novell NetWare.

If you have a UNIX server, refer to these documents:

4

NetBackup Release Notes

Provides important information about NetBackup DataCenter and BusinesServer
products on UNIX- and Windows-based servers, such as the platforms and operating
systems that are supported and operating notes that may not be in the NetBackup
manuals or the online help.

NetBackup DataCenter System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup DataCenter on a UNIX server.
NetBackup BusinesServer System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup BusinesServer on a UNIX server.
NetBackup Troubleshooting Guide for UNIX

Provides troubleshooting information for UNIX-based NetBackup products.

If you have a Windows server, refer to these documents:

4

NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and
operating systems that are supported and operating notes that may not be in the
manuals or the online help.

NetBackup DataCenter System Administrator’s Guide for Windows
Explains how to configure and manage NetBackup DataCenter on a Windows server.
NetBackup BusinesServer System Administrator’s Guide for Windows

Explains how to configure and manage NetBackup BusinesServer on a Windows
server.

NetBackup Troubleshooting Guide for Windows

Provides troubleshooting information for Windows-based NetBackup products.

NetBackup User’s Guide - Microsoft Windows



Accessibility

Accessibility

NetBackup contains features that make the user interface easier to use by people who are
visually impaired and by people who have limited dexterity. Accessibility features
include:

& Support for assistive technologies such as screen readers and voice input (Windows
servers only)

& Support for keyboard (mouseless) navigation using accelerator keys and mnemonic
keys

For more information, see the NetBackup system administrator’s guide.

Conventions

The following explains typographical and other conventions used in this guide.
Type Style

Typographic Conventions

Typeface Usage

Bold fixed width  |nput. For example, type cd to change directories.

Fixed width Paths, commands, filenames, or output. For example: The default installation
directory is /opt /VRTSxx.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your
file.

Serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.
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Conventions

Notes and Cautions

Note This is a Note. Notes are used to call attention to information that makes using the
product easier or helps in avoiding problems.

Caution This is a Caution. Cautions are used to warn about situations that could cause
data loss.

Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example,
holding down the Ctrl key while pressing another key. Keyboard command sequences are
indicated by connecting the keys with a plus sign. For example:

Press Ctrl+t

Command Usage
The following conventions are frequently used in the synopsis of command usage.
brackets [ ]
The enclosed command line component is optional.

Vertical bar or pipe (])

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command argl|arg2

the user can use either the argl or arg2 variable.

- xii NetBackup User’s Guide - Microsoft Windows



Getting Help

Terms

The terms listed in the table below are used in the VERITAS NetBackup documentation to
increase readability while maintaining technical accuracy.

Term Definition
Microsoft Windows, Terms used as nouns to describe a line of operating systems
Windows developed by Microsoft, Inc.

A term used as an adjective to describe a specific product or
noun. Some examples are: Windows 95, Windows 98,

Windows NT, Windows 2000, Windows servers, Windows
clients, Windows platforms, Windows hosts, and Windows GUI.

Where a specific Windows product is identified, then only that
particular product is valid with regards to the instance in which
it is being used.

For more information on the Windows operating systems that

NetBackup supports, refer to the VERITAS support web site at
http://www.support.veritas.com.

Windows servers A term that defines the Windows server platforms that
NetBackup supports; those platforms are: Windows NT and
Windows 2000.

Windows clients A term that defines the Windows client platforms that
NetBackup supports; those platforms are: Windows 95, 98, ME,
NT, 2000, XP (for 32- and 64-bit versions), and LE.

Getting Help

For updated information about this product, including system requirements, supported
platforms, supported peripherals, and a list of current patches available from Technical
Support, visit our web site:

http://www.support.veritas.com/

VERITAS Customer Support has an extensive technical support structure that enables you
to contact technical support teams that are trained to answer questions to specific
products. You can contact Customer Support by sending an e-mail to
support@veritas.com, or by finding a product-specific phone number from the VERITAS
support web site. The following steps describe how to locate the proper phone number.

Preface
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Getting Help

1. Openhttp://www.support.veritas.com/ inyour web browser.
2. Click Contact Support. The Contacting Support Product List page appears.
3. Select a product line and then a product from the lists that appear. The page will

refresh with a list of technical support phone numbers that are specific to the product
you just selected.
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Introduction 1

During installation, the Backup, Archive, and Restore interface is configured to work with
a specific NetBackup client. When a user starts an operation using the Backup, Archive,
and Restore interface, the software sends the appropriate messages to its designated
NetBackup client. The software on the NetBackup client then communicates with the
server and handles the client side of the operation.

The Backup, Archive, and Restore interface enables server-directed backup, archive, and
restore operations on entire folders or individual files that reside on your NetBackup
client. This interface also allows you to perform user-directed backup, archive, and restore
operations on your NetBackup client, without logging into the NetBackup master server.
Once you start a user-directed operation, the NetBackup process runs under the control of
the NetBackup master server. You request the service and the NetBackup master server
manages the rest, including the storage and retrieval of data.

In NetBackup terminology, the system that requires the backup or archive is the
NetBackup client. The system that manages the storage and retrieval of the backup data is
called the NetBackup master server.




Backup and Archive Operations

Backup and Archive Operations

A backup saves copies of selected files and folders from a NetBackup client to a storage
device on a NetBackup master server or a NetBackup media server.

An archive saves copies of selected files and folders from a NetBackup client to a storage
device on a NetBackup master server or NetBackup media server, then deletes the original
files from the NetBackup client.

User-Directed Backups and Archives

You can perform a user-directed backup during the time period scheduled by the
NetBackup system administrator. NetBackup allows you to select a combination of files,
folders with files, or entire drives to back up.

Files can be backed up through the Backup, Archive, and Restore interface or, if
NetBackup Explorer Extensions are installed and enabled, through Windows Explorer.

Server-Directed Backups and Archives

The NetBackup administrator can schedule full backups and incremental backups to
occur automatically and unattended, under the control of the NetBackup master server.
Full, incremental, and true image backups can only be performed by the NetBackup
master server. When properly scheduled, the server-directed backups will meet most of
your backup requirements.

Note In previous versions of NetBackup for Windows, server-directed backups could be
only partially successful since some applications retain locks on files when left
open. NetBackup DataCenter is packaged with OTM (Open Transaction Manager),
which resolves this problem. If OTM is disabled, be sure to shut down all
applications on the NetBackup client before proceeding with server-directed
backups. See the NetBackup Installation Guide for PC Clients for more information on
installing OTM.

Note OTM is a separately-priced option for BusinesServer.

- 2 NetBackup User’s Guide - Microsoft Windows



Backup and Archive Operations

Full Backup

When the NetBackup master server is configured to perform a full backup, NetBackup
backs up all files in a specified folder or volume to a storage unit. The archive bit is cleared
as each file is backed up. If the full backup fails, NetBackup will attempt another full
backup at the same time each day until successfully completed. A successfully completed
backup will include all files.

Cumulative-Incremental Backup

When the NetBackup master server is configured to perform a cumulative-incremental
backup, NetBackup backs up all files that have changed since the last successful full
backup.

Cumulative-incremental backups can be configured to use either the datetime stamp or
the archive bit. If the datetime stamp is used, the cumulative-incremental backup includes
all files with a datetime stamp that is more recent than the last full backup. If the archive
bit is used, the cumulative-incremental backup includes all files that have their archive bit
set. Archive bits are not cleared on cumulative-incrementals. Refer to “General Tab” on
page 61 for more details on performing incremental backups with archive bits.

Differential-Incremental Backup

When the NetBackup master server is configured to perform a differential-incremental
backup, NetBackup backs up all files that have changed since the last successful backup.

Differential-incremental backups can be configured to use either the datetime stamp or
the archive bit. If the datetime stamp is used, the differential-incremental backup includes
all files with datetime stamps that are more recent than the last full or incremental backup.
If the archive bit is used, the differential-incremental backup includes all files that have
their archive bit set. Archive bits are cleared on differential-incrementals if all files are
successfully backed up. Refer to “General Tab” on page 61 for more details on performing
incremental backups with archive bits.

True Image Backup

A true image backup takes place when the Collect true image restore information
attribute has been set on the NetBackup master server. When this attribute is set,
NetBackup collects additional information necessary to restore a folder to exactly what it
was at the time of the full backup or incremental backup.

Only those backups performed with this attribute set can be used for the true image
restore. For complete details, refer to the NetBackup System Administrator’s Guide for UNIX
or the NetBackup System Administrator’s Guide for Windows.

Chapter 1, Introduction 3 v



Restore Operations

Restore Operations

A restore reads backups from the storage device on the NetBackup master server or the
NetBackup media server and restores them to the NetBackup client. NetBackup allows
you to select a combination of files, folders with files, or entire drives to restore.

File Permissions and Open Files

File permissions require write permission on the destination folder in order to restore a
file. A file will not be restored when a file with the identical name is open on the
NetBackup client.

Access Control Lists

If the access control list to a file on a Windows NT or Windows 2000 system has changed
since the file was backed up, it will be restored to what it was at the time of the backup.

A file will be restored by NetBackup as follows:

& A user that has been granted access to the file since the backup will not have access to
the file after the restore.

& A user that has had access to the file removed since the backup will again have access
after the file is restored.

Server-Directed Restores

The administrator on the NetBackup master server can direct restores to any NetBackup
client (regardless of which NetBackup client the files came from). Refer to “Redirecting a
Restore to a Different Client” on page 88 for details.

A client can prohibit server-directed restores by clearing the Allow Server-Directed
Restores option in the General tab. This option can only be cleared by the system
administrator. Refer to “General Tab” on page 100 for more information.

User-Directed Restores

A user can start a restore operation at any time. Restored folders and drives include all
files that were backed up or archived during a range of backups. NetBackup is also able to
restore from Backup Exec images, redirect a restore to a different client, and perform true
image restores.

! NetBackup User’s Guide - Microsoft Windows



Restore Operations

Restoring from Backup Exec Images

NetBackup 4.5 can read Backup Exec media written by Backup Exec 7.3 or later. To be able
to restore from Backup Exec images, the Backup Exec catalogs need to have been
converted to the NetBackup catalog format, using the catalog converter utility. The
Backup Exec Tape Reader option also needs to be installed on the NetBackup server. See
your system administrator for more information.

Redirected Restore to a Different Client

With the necessary permissions and configuration, users can browse the NetBackup
database for files backed up by another NetBackup client and restore files to their own
computer.

System administrators can direct restores to the client that originally backed up the files or
to different client. This type of restore must be performed on the master server and is
called a server-directed restore.

Refer to “Redirecting a Restore to a Different Client” on page 88 for details on using the
Backup, Archive, and Restore interface on the NetBackup server for redirected restores to
different clients.

Restores from True Image Backups

True image backups can be restored only on server-directed backups and archives in
which the Collect true image restore information attribute has been set. Refer to the
NetBackup System Administrator’s Guide for UNIX or the NetBackup System Administrator’s
Guide for Windows for details.

A true image restore of a folder, by default, restores the folder so its contents are exactly
what they were at the time of the most recent server-directed full backup or incremental
backup. Files deleted prior to the specified backup are not restored.

During a true image restore of a folder, NetBackup determines which files belong in the
folder and then reconstructs it by using the most recent backup of these files.

NetBackup does not allow a true image restore that is based on the time of a user
operation. However, NetBackup does use the backups from a user-directed operation if
they are more recent than the latest server-directed full backup or incremental backup.

A true image restore is the best choice if, for example, you have recently cleaned up a
folder by deleting unwanted files and now want to restore the latest version without
having to repeat your cleanup. It is also possible to restore the true image of an earlier
version of a folder.

Chapter 1, Introduction 5



View Status

View Status

You can view, print, and delete status reports from within the View Status dialog box.
Refer to “View Status Dialog Box on page 69 for more information.

File Permissions Required By NetBackup

You need backup privileges to back up or archive a file. Without backup privileges, you
must have read access to a file in order to back up the file and read and delete access to a
file in order to archive the file (since the archive operation removes the file from the disk).

Listing and restoring files and directories require the following permissions:

& To list or restore files in a directory owned by someone else, you must have restore
privileges. Without restore privileges, you can only restore from a user-directed
backup you have performed (unless Free Browse is turned on). (Refer to “Free
Browse” on page 85 for more details.)

& To restore afile to its original location, you must have write access to the file (if the file
exists), or to the directory (if the file does not exist).

The following table shows how NetBackup restores files in various situations (for
example, if a copy of the file or directory already exists).

File Permissions

Type of Restore Attempted Results

Restore a file that already exists If you have restore privileges, NetBackup restores the file and sets
and overwrite the existing file.  file ownership to the same owner as the backup image.

If you do not have restore privileges, NetBackup restores the file
only if you have write access to it. In a case where the file is read
only, but you have write access to the parent directory, NetBackup
removes the file and restores the backup image with the original
owner as the owner.

Restore a file that already exists Whether you have restore privileges or not, NetBackup does not
and not overwrite the existing  restore the file and places a message in the progress log.
file.

Restore a file that doesn’t exist. Whether you have restore privileges or not, NetBackup restores the
file and sets file ownership to the owner that originally owned the
file.

- 6 NetBackup User’s Guide - Microsoft Windows



File Permissions Required By NetBackup

File Permissions

Type of Restore Attempted

Results

Restore a file when a directory
exists with the same name as the
file.

Restore a directory when a file
exists with the same name as the
directory.

Restore a file in a directory that
does not exist.

Whether you have restore privileges or not, NetBackup places a
message in the log file indicating that the directory will be replaced
with the file after the next system reboot. After the system boot, the
directory is not replaced and the file is restored with a temporary
filename in the parent directory of the directory. This occurs only
when overwrite existing files is enabled. The log file will indicate
the name the file was given and to which directory it was restored.

The directory will not be restored.

NetBackup creates the directory with the owner set to the account
used to start the NetBackup client service. The file is then restored
in the same manner as one that does not exist (see above).

Chapter 1, Introduction
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User-Directed Operations 2

This section provides step-by-step instructions on using the Backup, Archive, and Restore
interface to perform backups, archives and restores. For information on scheduled
backups and other server-directed operations, see the NetBackup System Administrator’s
Guide for UNIX or the NetBackup System Administrator’s Guide for Windows.

Starting the Backup, Archive, and Restore Interface

& Click the Windows Start menu, point to Programs, point to VERITAS NetBackup,
and click Backup, Archive, and Restore.

The Backup, Archive, and Restore interface displays.

Toolbar

For most operations, it is easiest to use the buttons on the toolbar. The horizontal toolbar
on the Backup, Archive, and Restore interface opens windows to browse for backups or
restores and to view the progress report of a NetBackup operation.

The NetBackup Backup window or the NetBackup Restore window has a vertical toolbar
with buttons for frequently used menu commands. Clicking a button on a toolbar has the
same effect as using the menu command. Any action initiated by the buttons on the
vertical toolbar only pertains to the window it is associated with.

Helpful Hints

Marking Files and Folders
& To mark a file for backup or restore, select the checkbox to left of a file.

& To mark a folder for backup or restore, select the checkbox to the left of a folder. A
check mark will appear in the box. A slash mark in the box indicates only some of the
files or subfolders within that folder are marked.




Starting the Backup, Archive, and Restore Interface

& To mark all the files (and folders) that currently appear in the Contents of "<folder>’
pane, click Mark Displayed Files from the Edit menu.

Unmarking Files and Folders
& Tounmark afile, clear the checkbox to the left of the file.

& Tounmark a folder, and all the files and subfolders marked within that folder, clear
the checkbox to the left of the folder.

& To unmark all files and folders that currently appear in the Contents of "<folder>’
pane, select Unmark Displayed Files on the Edit menu.

& To unmark all previously marked files and folders, select Unmark All on the Edit
menu. You can also click the Unmark All button on the NetBackup Backup window
or NetBackup Restore window toolbars.

~ 10 NetBackup User’s Guide - Microsoft Windows



Performing Backups and Archives

Performing Backups and Archives

This section includes a tutorial which goes through a simple backup of the
Readme Client.txt file installed in the NetBackup folder.

You can back up a file either through the Windows Explorer, by using the NetBackup Bin
feature, or through the Backup, Archive, and Restore interface.

Backing Up a File Through Windows Explorer

Note Explorer Extensions must be enabled in order to be able to back up files through
Windows Explorer. To enable this feature, open the Backup, Archive, and Restore
interface and on the File menu select NetBackup Explorer Extensions.

1. Open Windows Explorer. (Click on the Windows Start menu, point to Programs,
point to Accessories, and choose Windows Explorer.)

2. Locate the file (or folder) you wish to back up and right-click on it. For example:
a. Openthe Program Files\VERITAS\NetBackup folder.
b. Find the Readme Client.txt file and right-click on it.

3. Click Backup Now.

To show the progress of the backup operation, select Automatically Show Progress
Log.

4. To begin the backup operation, click Yes.

Backing Up a File Using NetBackup Bin

Note Explorer Extensions must be enabled in order to back up files using NetBackup Bin.
To enable this feature, open the Backup, Archive, and Restore interface and on the
File menu select NetBackup Explorer Extensions.

1. Open Windows Explorer. (Click on the Windows Start menu, point to Programs,
point to Accessories, and choose Windows Explorer.)

2. Locate the file (or folder) you wish to back up. For example:

Chapter 2, User-Directed Operations n



Performing Backups and Archives

a. Openthe Program Files\VERITAS\NetBackup folder.
b. Findthe Readme Client.txt file.

3. Drag the file to NetBackup Bin. You can do this by either:
- Dragging the file to the NetBackup Bin icon on your desktop.

or

- Dragging the file to the NetBackup Bin folder in Windows Explorer.

5‘ Exploring - HetBackup Bin

File Edit “iew Toolz Help
|AII Falders Contents of 'MetBackup Bin'
@ Desklop File | Client Host | b aster |
=12} My Computer
[+ 3% Floppy (&)
wgp [0
Ee (0]
g2 [E)
(=] Control Panel
(] Printers
Scheduled Tasks
-8 web Folders
I:I-- Metwark Meighborhood
% Fecycle Bin
5 My Briefcase
4] | Bl

|NetB ackup: 0 Files

4. To view the files in the NetBackup Bin folder:

- Double-click on the NetBackup Bin icon on your desktop.

or

- Right-click on the NetBackup Bin folder in Windows Explorer and click Open.

5. Right-click on NetBackup Bin icon, or on the NetBackup Bin folder in Windows
Explorer, and click Backup Now.

To show the progress of the backup operation, select Automatically Show Progress
Log.

6. To begin the backup operation, click Yes.
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Backing Up a File Through the Backup, Archive, and Restore
Interface

1. Start the Backup, Archive, and Restore interface as described in “Starting the Backup,
Archive, and Restore Interface” on page 9.

The Backup, Archive, and Restore interface displays.

2. On the File menu, choose Select Files and Folders to Backup.

The NetBackup Backup window is displayed.

s_Tﬁ Backup, Archive, and Restore - NetBackup - [Backup: Server: windows Client: folip ;|g|5|
3 Bl Edit View Actions Window Help == =]
13 Select For Backup | 3, Select for Restore ~ | 2 View Status | &
g All Folders Contents of C:,
— | B Dé‘ A Mame [a. | Size I Time Modified | -
& O apoBEARR d-- 0 10/11/2001 4:18:36 PM
H O check-ins d-- 0 1/9/2002 10:13:20 &AM
— O Cdpirections d-- 0 12{17(2001 10:35:22 AM
O A oocuments and Settings d-- 0 10/9/2001 2:17:19 M
O CaFrameboc d-- 0 12{17/2001 10:54:43 AM
(A Localization_4.5 d-- 0 1/2/2002 4:43:22 PM
O Camy Download Files d-- 0 7/26/2001 6:17:07 &M
O Camy Music d-- 0 7/26/2001 6:17:29 &M
A rrogram Files d-r 0 1/15/2002 11:13:55 AM L
O CARECYCLER dsh- 0 10/10/2001 12:17:15 PM
[ 5ystem Yolume Information  dsh- 0 7/25/2001 3:29:55 PM
O CaTeme d-- 0 1/6/2002 7:35:17 PM
O (Catest d-- 0 12{12(2001 3:06:37 PM
[ £ Test WinHelp d-- 0 10/26{2001 2:27:05 PM
[ £ windows Update Setup Files  d-— 0 7/26/2001 5:55:44 AM
O Cawnnr d-- 0 1/15/2002 11:33:54 AM x|
Ready v
————
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3. Mark afile to backup.

a. Openthe Program Files\VERITAS\NetBackup folder.

b. Findthe Readme Client.txt file and select the checkbox to the left of the item.

ackup, Archive, and Restore - NetBackup - [Backup: Server: windows Client: folip] - |EI|1|
3 Fle Edit Wiew Actions Window Help -8 x|
_@Select for Backup | B3, Select for Restore - | ) View Status | @
Q All Folders Contents of C:\Program Files' YERITAS NetBackup
— -] L] Metscape ;I Mame | A | Size: I Time Modified |
B =00 R O Cvin d— 0 1/15/2002 11:46:27 AM
=N C1C3 Outlook Express Ol Cabina.4.164 d— 0 1/15/2002 11:33:37 AM
= (21 Quadrala
_ ] Q Real ¥ [ d--- 0 115/2002 11:33:37 AM
DED g:: ot Viower Ok d— 0 7/26/2001 5:51:47 AM
=00 Sym';ntec O lags d--- 0 1/15/2002 11:33:44 AM
-] 23 Uninstall Infarmatior O Qe d-- 0 1/14/2002 3;09:22 PM
=] D VERITAS d--- 0 7f26/2001 5:51:43 AM
D1C3 Help - B185 2/14/2001 2:41:00 AM
[2] = NetBackup 8309 11/13{2001 7:23:56 PM
w-01 03 vxHelp 4477 B/16(2001 2:49:38 PM
= (21 windows Media Play 7437 11)13{2001 7:23:56 PM
[]---D D Windows NT 104 1/14/2002 11:56:56 AM
M- L3 windowsUpdate
..... 010 winzip
-] [Z] Ws_FTF Pro -
4 | = | »
Ready v

4. On the Actions menu, choose Start Backup of Marked Files.

The Specify Backup Options dialog box is displayed.

Specify Backup Dptions

g Back up to MetBackup server: windows

General Options |

Itemz marked to be backed up:

Mame |
C:\Program Files\WERITAS \MetB ackuptReadme_Client. tat

[~ Archive files [delete files after successful backup)

Eepword phraze to azzociate with the backup [optional]

Cancel Help
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a. Review your selections in the Name list box.

b. If you wish to associate the backup with a keyword phrase, enter a keyword in
the Keyword phrase to associate with the backup (optional) box. Later, you can
search for this keyword if you wish to restore the items that were backed up. In
this example test is used as the keyword.

Specify Backup Dptions

B

windows

g Back up to MetBackup server:

General Options |

Itemz marked to be backed up:

Mame

C:\Program Files\WERITAS \MetB ackuptReadme_Client. tat

[~ Archive files [delete files after successful backup)

Eepword phraze to azzociate with the backup [optional]

Itest

Cancel

Help

c. Click Start Backup.

The backup request goes to the NetBackup master server. A NetBackup message
displays, indicating that the backup was successfully started.

@ The backup was successfully initiated,

Do you wank to view the progress of the backup?

5. Click Yes on the NetBackup Message dialog box to open the View Status dialog box.

The View Status dialog box allows you to view the progress report of a NetBackup
operation. For more information see “View the Status of a User-Directed Operation”

on page 22.

Note The NetBackup operation may take a few minutes to complete. You can close the
Backup, Archive, and Restore interface after starting a backup operation.
NetBackup will continue the backup operation in the background.
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Backing Up Shared Folders

For information on backing up shared folders, refer to the “Backup Network Drives” topic
in the NetBackup System Administrator’s Guide.
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Performing Restores

This section walks you through a simple restore of the Readme Client.txt file backed

up in “Performing Backups and Archives” on page 11 of this manual.

1. Start the Backup, Archive, and Restore interface as described in “Starting the Backup,
Archive, and Restore Interface” on page 9.

2. On the File menu, point to Select Files and Folders to Restore, then click

from Normal Backup.

The NetBackup Restore window displays.

B Bl Edit View Actions Window Help

s_Tﬁ Backup, Archive, and Restore - NetBackup - [Restore: Server: windows

g [l
=@l x|

13 Select For Backup | 3, Select for Restore ~ | 2 View Status | &
@ MNetBackup History
— 2002 2001
o Jan Dec
—_— 15 14 13 12 11 10 9 5 7 6 5 w2 1 3130 29 28 27
& & & & = & & & &
Mg
A [« | o
@ All Folders Contents of 'folip’
E||:| falip A | | Mame | Time Backed Up | Attributes I Size I Time Modified |
=¢c O=c 1/15/2002 12:27:56 PM
8 8 ""EOiE""PP O= 1/5/2002 3:49:35 FM de-- 0 1/5/2002 9:34:06 FM
Check-ins G
S8 System_...  1/14/2002 5:49:41 PM
-3 Config.Msi D YStem.- 14
-] Directions
- @0 Documents and Set
4 | | »
Ready v

There may be a delay before lists display in the NetBackup Restore window.
NetBackup has to obtain the file information from the catalogs on the NetBackup

master server.

If files or folders do not display in the NetBackup Restore window, it can be due to

one of the following:

- Perform Default Search is not enabled. In this case, start a search manually by
clicking Search Backups on the Actions menu. Or to display the files in a backup,

click a backup image.

- The NetBackup server does not have any backups of files for your client. Ensure
that the client is connecting to the correct server (see “Servers Tab” on page 65).
Also, ensure that you are using the correct client name (see “Clients Tab and
Clients/Policy Type Tab” on page 67). You can also refer to the title bar, which

Chapter 2, User-Directed Operations
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displays the names of the client and the server the client is connected to. If these
settings are correct and you believe there are backups available, contact your
system administrator.

3. Select a file to restore.

If you know the backup image (or the range of images) you can select the file from the
NetBackup History pane without going through the Search Backups dialog box.

In this tutorial, we are going to use the Search Backups feature to restore the
Readme Client.txt file backed up in “Performing Backups and Archives” on
page 11.

Tip Before initiating a search, collapse the tree in the All Folders pane as much as
possible. NetBackup will expand the tree to the folders that match your search
criteria.

a. On the Actions menu, click Search Backups.

The Search Backups dialog box displays.

b. Inthe Search Folder box, type the path to the backed up file.

For this example the path is C: \Program Files\VERITAS\NetBackup\.

c. Type test in the Keyword phrase (optional) box.

Search Backups x|

Search Folder:

IE:\Program Filez"WERITASYMetB ackuph

¥ Perform case-insensitive search

Kepword Phraze [optional):
Itest

Start Date:
|12/27/2001 3.02:55 PM 4|
End Date:
|1/15/2002 7.48:.43 PM 4|

Search I Cancel | Help |
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d. Click Search. NetBackup will display the tree to the lowest levels of folders which
contain files that were backed up.

Backup, Archive, and Restore - NetBackup - [Restore: Server: windows

=Bl ]

)} Eile Edt Wew Actions Window Help ==

2 view Status | @

13 Select For Backup | B3, Select for Restore -

@ NetBackup History

— 2002
Jan

‘{E All Folders Contents of 'C:%Program Files', YERITAS \NetBackup®
ED Folip Mame | Time Backed Up | Al Size I Tirme Modified |
e-J=c [[£] Readme_Client.txt 1{15/2002 12:27:56 FM - @308 11/13{2001 7:23:56 PM

E|D [_1 Program Files
=1 vERITAS

4
4. Select the checkbox to the left of the Readme Client.txt file.
Backup, Archive, and Restore - NetBackup - [Restore: Server: windows =] |
File Edit Wiew Actions Window Help - |ﬁ'|1|
_@Se\ect for Backup | 3, Select for Restore + | View Status | @
MNetBackup History
&
— 2002
i Jan
— 15
o
B
’E All Folders Contents of 'C:Program Files ¥ERITAS' NetBackup®
Tame | Time Backed Up | .Ql Size: I Time Modified |
Readme_Client.bet 1/15/2002 12:27:58PM - 5309  11/13/2001 7:25:56 PM
- [#] [£5 MetBackup
A
N N ——
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The Restore Marked Files dialog box will

6. Click Overwrite the existing file.

Restore Marked Files

Restore Marked Files

5. On the Actions menu, click Start Restore of Marked Files.

open.

— Restare Destination Chaice
' Restore evenything to its original location

Source;

" Restore everything to a different location [maintaining existing structure):

IE:\Program Filez"WERITASYMetB ackuph

Destinatian:

IE:\Program Filez"WERITASYMetB ackuph

" Restore individual folders and files to different locations [double-click ta madify):

Browse... |

Source

| [Drestination |

C:\Program Files\YERITAS \MetB ackupiReadme_Client. tat

l |

il

— Restore Option:
If the destination file already exists:

& Ovenwite the existing file
" Restore the file using a temporary filename
" Do not restore the file

Cancel

Help |

7. Click Start Restore.

A NetBackup message displays, indicating that the restore was successfully started.

MNetBackup Message

<

The restore was successfully initiabed.,

Do wou wank ko view the progress of the restore?

no |

Click Yes on the NetBackup Message box to open the View Status dialog box.

The View Status dialog box allows you to view the progress report of a NetBackup
operation. For more information see “View the Status of a User-Directed Operation”

on page 22.

20
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Note The NetBackup operation may take a few minutes to complete. After starting a
restore operation, you can close the Backup, Archive, and Restore interface and

perform other tasks on your computer. NetBackup will continue the restore
operation in the background.

. . ————
Chapter 2, User-Directed Operations 21 =



View the Status of a User-Directed Operation

View the Status of a User-Directed Operation

1. On the File menu, click View Status.

2’_% Yiew Status {EBlaufus)

Backup

[~ Werhose

Progress:

Operation Type

— Selected Operation:

Fiefrezh Rate [seconds]: |5 ill
w

Time Requested Operation Status | |

Lloze |

=10l x|

1/15,/2002 11:56:49 A
1A15/2002 17:4219 AM

S uccesshul
Successhul

Delete |
Help |

12:32:42 INF

12:34:35 INF

1

12:32:39 IMF -
- WWaiting for mount of media id DO035 on server carrat,
12:3310IMF -
12:33:34 INF -
12:33:34 INF -

BACKUP START

OTH: enabled
Tatal Size:8309
Client completed sending data for backup

- Waiting for pogitioning of media id DO035 on server carot,
12:36:09 IMF -
12:36:37 IMF -

Beginning backup on server carmot of client folip.
Backup by EBlaufuz on client folip: the requested operation waz su

CCE
-
3

The status of the operation displays under the Operation Status column.

Click Refresh.

Select the operation for which you want to check the progress.

The lower pane will reflect the progress of the item selected in the top pane.

Select a refresh interval from the Refresh Rate box. The default setting is 0 seconds,

which means the status will not be automatically refreshed.

By default the progress file is displayed in an abbreviated form. If you wish to view

the entire contents of the progress file, select the Verbose option.

The NetBackup operation is finished when the Status changes to Successful. If
NetBackup was unable to back up or restore all of the requested files, a status code
appears a few lines before the end of the progress report. The NetBackup Troubleshooting
Guide for UNIX or the NetBackup Troubleshooting Guide for Windows list the meaning of the
final status code.

22
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Advanced Restore Procedures

The following sections give detailed explanations of how to perform different types of
advanced restore procedures.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed
up from the time of the last full backup to the most recent backup. If the client belongs to
more than one policy?, the default display starts with the last full backup that occurred
first. For example, assume that the client belongs to PolicyW1 and PolicyW?2. Also assume
that full backups occur for both of them: PolicyW1’s most recent full backup occurred on
Feb. 2 and PolicyW2’s most recent full backup occurred on Feb. 10. The display shows files
ranging from the time of the PolicyW1 full backup on Feb. 2.

The default range will satisfy the majority of your needs to restore files. There will be
times, however, when you must restore a file that was not backed up during the default
time period. For example, a file that was deleted prior to the last full backup does not
appear in the default display. In this case, you must use the NetBackup History pane to
select a backup that contains the file.

Searching for Files to Restore

1. Open the NetBackup Restore window.

2. Onthe View menu, choose Show All Backups. This will display all copies of files and
folders from all of the backups. To display the most recent copy of the file or folder,
choose Show Most Recent Backup from the View menu.

3. Select the images from the NetBackup History pane that you believe contain the files
and folders you want to restore.

4. Narrow the search range as much as possible to speed up your search by doing the
following:

- Select a specific backup image in the NetBackup History pane.

- Toselect a range of backup images, select the first one in the range and then, while
holding the Shift key, select the last one in the range. In this case, NetBackup
searches all of the backup images in the selected range. The range search will start
after the second image is selected.

1. A NetBackup policy defines the backup policies for a specific group of one or more clients that have similar
backup requirements. The NetBackup system administrator configures the policy for your PC.
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- Cancel previous selections by selecting another backup.

5. To open the Search Backups dialog box, click Search Backups on the Actions menu.

Search Backups x|

Search Folder:

IE:\Program Filez"WERITASYMetB ackuph

¥ Perform case-insensitive search

Kepword Phraze [optional):
Itest

Start Date:
|12/27/2001 3.02:55 PM 4|
End Date:
|1/15/2002 7.48:.43 PM 4|

Search I Cancel | Help |

6. Type the search path that you want NetBackup to use in its search.

Note The number of files you can list during a search is limited by the amount of free
memory you have on your computer. If you reach the limit, modify the date or file
path parameters to narrow the scope of the search.

By default, the Search Backups dialog box shows the information for the folder that is
currently selected in the All Folders pane of the NetBackup Restore window. See
“Search Backups Dialog Box” on page 75 for more information.

7. Click Search.

When the search is complete, NetBackup updates the NetBackup Restore window.

Restoring an Earlier Version of a Folder or File

This procedure will restore all files that were backed up during the range of backup dates.
This includes files that were deleted from your online folder after they were backed up. If
you do not want to restore the deleted files, refer to “Restoring a True Image of a
Directory” on page 25.

1. Open a NetBackup Restore window.

2. Open the backup NetBackup History pane.
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If the NetBackup History pane is not open, click and drag the horizontal split bar
down.

3. Inthe NetBackup History pane, select backup images for the dates of the backed up
files or folders you want to restore.

NetBackup will search the backup images, and display the contents of the backup
images in the All Folders and Contents of '<folder>’ panes.

- To restore a version of a folder or file that existed prior to the last full backup,
select only the backups that include the desired version of the folder or file.
Continue with step 4.

- To further narrow your search for a specific folder, file or keyword, go to step a.
a. On the Actions menu, click Search Backups.
b. Enter afilename or keyword.

c. Click Search. When the search is complete, the NetBackup Restore window is
updated.

4. Select the folder you want to restore in the All Folders pane of the NetBackup Restore
window.

5. Select the files or folders you need in the Contents of '<folder>’ pane. By default,
NetBackup restores files and folders to their original location.

6. On the Actions menu, click Start Restore of Marked Files.

Restoring a True Image of a Directory

Note You can restore a true image of a directory only if the NetBackup policy that is
backing up your files and directories is configured to collect true image restore
information prior to backup. If in doubt, ask your NetBackup administrator.

What Is a True Image Restore?

A true image restore of a directory, by default, restores the directory so its contents are
exactly what they were at the time of the most recent automatic full or incremental
backup. Files deleted prior to the specified backup are not restored.
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A true image restore is the best choice if, for example, you have recently cleaned up a
directory by deleting unwanted files and now want to restore the latest version without
having to repeat your cleanup. It is also possible to restore the true image of an earlier

version of a directory.

Example of a True Image Restore

To illustrate the concept of a true image restore, refer to the following table, which shows
the contents of a directory named c : \doc during a series of backups performed between

12/01/00 and 12/04/00.

Day 12/01/00  12/02/00 12/03/00  12/04/00 12/04/00
Type of Backup  (Full) (Incr) (Incr) (User Back) (Incr)
filel filel filel filel filel
file2 file2 file2 file2 file2
dirAffileA  dirAffileA dirAffileA dirAffileA -
dirB/fileB - - - -
file3 - - - -
dirC/fileC -
file4 file4

Assume that you are going to restore the most recent version of the directory.

4

If you perform a standard restore, NetBackup will restore all files and subdirectories
that were backed up during the time period from 12/01/00 (last full backup) through

12/04/00.

filel
file2
dirA\filea
dirB\fileB
file3
dirc\fileC
file4

If you restore a true image backup, NetBackup restores only the files and directories
that existed at the time of the incremental backup on 12/04/00.

filel
file2
file4

NetBackup does not restore anything deleted prior to the 12/04/00 incremental

backup.
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Notice that the restored directory does not include the dirA and dirC subdirectories,
even though they were backed up on 12/04/00 with a user-directed backup.
NetBackup did not restore these directories because they did not exist at the time of
the incremental backup that was the reference for the true image restore.

True Image Restores and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that
are currently in the directory but not in the true image restore backups.

Using the previous example, if you had created a file5 after the incremental backup
occurred on 12/04/00, but before doing the restore, then the contents of the directory after
the restore would have been:

filel
file2
file4
file5 (thisisthe new file that is not in any of the backups)

V¥ To restore atrue image of a directory

1. Onthe Actions menu, point to Select Restore Type and click True Image Backups.

Note You can perform a true image restore only if the TIR (True Image Restore) option on
the NetBackup server is set AND if a backup with the TIR option set has been
previously performed. If you getaNo Entity Found message at this point, notify
your NetBackup administrator.

2. Inthe All Folders pane of the NetBackup Restore (True Image) window, double-click
the parent of the folder you want to restore.

The double-click updates the NetBackup Restore (True Image) window to show the
folders that are available for true image restores. Notice that the lists show only
folders. Individual files do not appear because true image restores are intended only
for restoring entire folders. To list or select individual files, use Normal Backups.

If NetBackup cannot find any folders, click Search Folder in the Search Backups
dialog box. Also check the range of backups that you are searching (NetBackup
History pane). If all of these settings are correct and no folders are found, ask the
administrator to see if the NetBackup policy that is backing up your files and folders
is configured to collect true image restore information.

3. Select the folder you want to restore by marking it in the Contents of '<folder>’ pane of
the NetBackup Restore (True Image) window (you must select from this side of the

window).
. . e
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Note When afile in the folder has the same file name as a file in the true image backup,
NetBackup will delete the file from the folder and replace, or restore, the file from
the true image backup. NetBackup will not delete files from the folder that are not
in the true image restore.

4. On the Actions menu, click Start Restore of Marked Files.

By default, NetBackup restores the folder to its original location.

Restoring from Backup Exec Images

v

It is possible to restore Backup Exec images or both Backup Exec and NetBackup images
in a single NetBackup restore job. To be able to restore from Backup Exec images, the
Backup Exec catalogs need to have been converted to the NetBackup catalog format, using
the catalog converter utility. NetBackup 4.5 is able to convert on-disk catalogs of Backup
Exec 7.3 or later. See your system administrator for more information.

Backup Exec backup type descriptions in the NetBackup Restore window differ from the
descriptions of the NetBackup types. The differences are as follows:

NetBackup Backup Type Backup Exec Backup Type
Full Copy

Differential Incremental

Cumulative Incremental Differential

Note NetBackup 4.5 is able to read Backup Exec media written by Backup Exec 7.0 or
later.

Note The Backup Exec Tape Reader for NetBackup option should be installed on the
NetBackup server. Refer to the NetBackup DataCenter System Administrator’s Guide for
Windows for more information.

To restore from Backup Exec images
1. Start the Backup, Archive, and Restore interface.

2. Select the desired restore type.
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- To restore Backup Exec images: on the File menu, point to Select Files and
Folders to Restore and click from Backup Exec Backup.

- To restore Backup Exec and NetBackup images: on the File menu, point to Select
Files and Folders to Restore and click from Normal and Backup Exec Backups.

The NetBackup Restore window displays.
3. Select the files or folders to restore.

4. On the Actions menu, click Start Restore of Marked Files.

The Restore Marked Files dialog box displays.

5. If desired, files can be redirected to a different path. Refer to the next section,
“Redirecting Files to a Different Path,” for more information.

Note When both Backup Exec and NetBackup images are being restored, files cannot be
redirected to a different path.

6. Select the desired restore options.

7. Click Start Restore to start the restore operation.

Redirecting Files to a Different Path

In some instances, you may want to restore items to a file or path other than the one from
which they were backed up. All items can be restored to a different path or individual
items can be restored to different paths.

Restoring Everything to a Different Path

Note If restoring from both Backup Exec and NetBackup images, files cannot be
redirected to a different path.

V¥ To restore all items to a different path
1. Start the Backup, Archive, and Restore interface.

2. Select the desired restore type.

- To restore from NetBackup images: on the File menu, point to Select Files and
Folders to Restore, then click from Normal Backup.
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- To restore from Backup Exec images: on the File menu, point to Select Files and
Folders to Restore and click from Backup Exec Backup.

The NetBackup Restore window appears.
3. Select the items to restore.

4. On the Actions menu, click Start Restore of Marked Files. The Restore Marked Files
dialog box will appear.

5. Click Restore everything to a different location.

6. Inthe Source box, enter the folder from which the items were backed up.
By default, the lowest level folder common to all the items being restored appears in
the Source box. If this is changed to a folder that only contains some of the items, only
those items will be restored to the folder specified in the Destination box. All other

items will be restored to their original location.

7. Inthe Destination box, indicate the folder to which you want to restore the items.

Note When redirecting a restore from a Backup Exec image, and restoring to a specific
drive on your Windows client, the sharename for that drive must be specified in the
path. For example, if you wanted to redirect a restore to C: \temp, and the
sharename for drive C: is C$, you would need to specify the path as \C$\ temp. For
more examples, please refer to “Redirecting a Restore to a Different Client” on
page 88.
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Restore Marked Files x|

Restore Marked Files

— Restare Destination Chaice
" Restore everything to its original location

' Restore everything to a different location [maintaining existing structure):
Source:
IE:\Program Filez"WERITASYMetB ackuph

Destination:
IE:\temp Browse. .. |
" Restore individual folders and files to different locations [double-click ta madify):
Source | [Drestination I Time
C:\Program Files\YERITAS \MetB ackupiReadme_Client. tat 1415
4] | i
— Restore Option:

If the destination file already exists:

& Ovenwite the existing file

" Restore the file using a temporary filename
" Do not restore the file

Start Hestorel Cancel | Help |

8. Under Restore Options, click the desired option.

Note The Restore the file using a temporary filename option is not available when
restoring from Backup Exec images.

9. Click Start Restore.

NetBackup will restore the items to the new destination folder.

Restoring Individual Items to Different Paths

Note If restoring from Backup Exec images or both Backup Exec and NetBackup images,
files cannot be redirected to a different path.

V¥ To restore individual items to different paths
1. Start the Backup, Archive, and Restore interface.

2. Select the desired restore type.
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- To restore from NetBackup images: on the File menu, point to Select Files and
Folders to Restore, then click from Normal Backup.

- To restore from Backup Exec images: on the File menu, point to Select Files and
Folders to Restore and click from Backup Exec Backup.

The NetBackup Restore window appears.
3. Select the files or folders you wish to restore.

4. On the Actions menu, click Start Restore of Marked Files.

The Restore Marked Files dialog box will appear.

5. Click Restore individual folders and files to different locations.

The individual items you marked for restore will appear in the Restore individual
folders and files to different locations list box. If you mark a folder to be restored,
that folder name, not the individual files, will appear in the list box. To be able to
restore individual files to different locations, files must be selected individually.

6. To change the destination location for a file:

a. Double-click on the file name in the Source window. The Enter New Destination
dialog box opens.

b. Type a new path to restore to.
or

Click the Browse button to browse for and select a new path to restore to.

c. Click OK.
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The new path entered appears in the Destination column.

Restore Marked Files

Restore Marked Files

— Restare Destination Chaice

" Restore everything to its original location

" Restore everything to a different location [maintaining existing structure):
Source:

IE:\Program Filez"WERITASYMetB ackuph

Destination:

IE:\Program Filez"WERITASYMetB ackuph Browse... |

' Restore individual folders and files to different locations [double-click ta madify):
Source

| [Drestination |
C:\Program Files\WERITAS \MetBackup'\Readme_Client.tat - C:\temphsample’s

l

il

— Restore Option:

If the destination file already exists:

" Do not restore the file

temporary filename

Start Restare I

Help |

d. Repeat these steps for each file or folder you want to restore.

7. Under Restore Options, click the desired option.

8. Click Start Restore.

Restoring Using a Temporary Filename

Note If restoring from Backup Exec images or both Backup Exec and NetBackup images,
a file cannot be restored to a temporary filename.

1. Open the NetBackup Restore window.

2. Select the desired restore type.

- To restore from NetBackup images: on the File menu, point to Select Files and
Folders to Restore, then click from Normal Backup.

To restore from Backup Exec images: on the File menu, point to Select Files and

Folders to Restore and click from Backup Exec Backup.
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The NetBackup Restore window appears.

3. Select the item to restore.

4. On the Actions menu, click Start Restore of Marked Files.

The Restore Marked Files dialog box will appear.

5. Click Restore the file using a temporary filename.

Restore Marked Files x|
Restore Marked Files
— Restare Destination Chaice
' Restore evenything to its original location
" Restore everything to a different location [maintaining existing structure):
Source;
IE:\Program Filez"WERITASYMetB ackuph
Destinatian:
IE:\Program Filez"WERITASYMetB ackuph Browse... |
" Restore individual folders and files to different locations [double-click ta madify):
Source | [Drestination |
C:\Program Files\YERITAS \MetB ackupiReadme_Client. tat j
1| |
— Restore Option:
If the destination file already exists:
' Ovenwite the existing file
' Restore the file using a temporary filename
" Do not restore the file
Cancel Help |

6. Click Start Restore.

NetBackup will restore the item to £ilenameXXXXXX . TMP. Where filename is the
name of the file being restore and XXXXXX is generated based on the current date and

time.

Restoring from a Disk-Image Backup

A restore of a disk-image backup can be performed using the Backup, Archive, and
Restore interface. When restoring a backup of a disk image, only an entire drive can be
restored. Individual files or folders cannot be selected.

Before you restore from a disk-image backup, make sure that you shut down all
applications that are running on either the source or the destination drive.
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Note The from Raw Partition sub-menu option on the Select Files and Folders to

Restore option from the File menu should be used only to restore raw partition
backups of UNIX clients. To restore a backup of a Windows disk image, choose the
from Normal Backup option.

Restoring the Drive to the Same Location

A backup of a disk image can be restored to the drive from which it was backed up. The
restored files will overwrite all of the information currently on the drive. You cannot select
individual files or folders to restore.

V¥ To restore the drive to the same location:

1.

2.

Shut down all applications that are running on drive that you want to restore.
Open the NetBackup Restore window.

Click on the arrow on the right edge of the Select for Restore button, then click
Restore from Normal Backup.

Select the drive that you want to restore.

Choose Start Restore of Marked Files from the Actions menu.

The Restore Marked files dialog box displays.
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Restore Marked Files x|

Fiestare Marked Files

— Restare Destination Chaoice
% Restare everything to its original location

" Restare everything ta a different location [maintaining existing structure):
Source:
fruc:

Destination:

I A Browse... |

" Restore individual folders and files to different locations [double-click to modify):

Source | [ estination I Time Backed Up | Time Modified

AC 2/15/2002 1:54:59 P 2/15/2002 2:01:00 PM

<| B
— Restore Option

If the destination file already exists:

' Ovenurite the existing file

¢ Restore the file uging a temparary filename
" Do not restore the file

Start Restare I Cancel I Help |

a. Choose the Restore everything ot its original location option.
b. Choose the Overwrite the existing file option.

6. Click Start Restore to start the restore process.

Restoring the Drive to a Different Location

A backup of a disk image can be restored to a drive that is different from the drive that
was backed up. The restored files will overwrite all of the information currently on the
drive. You cannot select individual files or folders to restore.

To restore the drive to a different location:

1. Shut down all applications that are running on the drive that you want to restore to.

2. Open the NetBackup Restore window.

3. Click on the arrow on the right edge of the Select for Restore button, then click
Restore from Normal Backup.

4. Select the drive that you want to restore.
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The Restore Marked files dialog box displays.

Restore Marked Files

Restore Marked Files

— Restore Destination Chaice:

" Restore everything to its original location

" Restore everything to a different location [maintaining existing stiucture];
Source;
|c:\
Destinatiar:
|c:;\

Browse... |

% Restore individual folders and files to different locations [double-click to modify]:

| TimeBackedUp | Time Madified
2/15/2002 1:54:59 PM 2/15/2002 2:01:10

| Destination
JARNInE

Source
JARNTeS

| | 2l

— Restore Option:
If the destination file already exists:

& Oyvenwrite the existing file

" Restore the file using a kemporary filename
Do ot restore the file

Cancel |

Start Restore I

Help |

The Enter New Destination dialog box displays.

Enter Mew Destination

Source: C:4

Hew
IJ\\.\D:

Cancel |

o]

Browse |

5. Choose Start Restore of Marked Files from the Actions menu.

6. Choose the Restore individual files and folders to different locations option.

7. To specify the destination drive, double-click on the line of text in the window.

a. Inthe New field, enter the drive in which the restored information should be
placed. To avoid getting a syntax error message, the drive path must be entered as

follows:
/ \\.\D: (where D is the drive in which the restored information
should be placed)
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b. Click the OK button to save your entry.
The Restore Marked Files dialog box is displayed.

Restore Marked Files x|

Restore Marked Files

— Restore Destination Choic
" Restare everything to its original lozation
" Restore evervthing to a different location [maintaining existing structure):
Saurce;
Jiue

[estination;
I N Browse,..

(* Restore individual folders and files to different locations [double-click ta modify)

Source | Destination | Time Backed Up | Time Modified
A MNAD: 2/15/2002 1:54:59 PM  2/15/2002 2:01:00 PM

< | |

—Restare Option;
If the destination file alieady exists:

% Ovenwite the existing file

" Rlestore the file uging a temporary filename
" Da not restore the file

Cancel | Help

8. Choose the Overwrite the existing file option.

9. Click Start Restore to start the restore process.

Proxy Restore

In some environments users store their files on a file server rather than on their PC. A
proxy restore allows backups of the file server to be restored to the file server from the

user’s desktop PC.

Note Though you are able to view and mark any of the folders and files in a selected
backup, you will not be able to restore any items you do not have write access to.
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V¥ To perform a proxy restore
1. Open the NetBackup Restore window.

a. On the Actions menu, point to Select Restore Type, then click Proxy Normal
Backups.

The Browse for Computer dialog box displays.

Browse for Computer 2=l
Select Proxy Server
..... ;I
..... L
[
Cancel |

b. Select the file server to which you want to restore folders and/or files and click
OK. For this tutorial we will select a computer called sasweed.

R R ————
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The NetBackup Restore window displays.

The NetBackup server will change to the master server of the selected file server.

o) Backup, Archive, and Restore - NetBackup - [Proxy Restore: Server: sasweed Source Client: folip - Ellll
M File Edit Wiew Actions ‘window Help _ ﬁl|1|
183 select for Backup | B3 select for Restore = | {myview Status | @
ﬁ MetBackup History
—_— 2002
Al Feb
= 15
&
@ All Folders Contents of 'folip
EDM Mame I Time Backed Up |
0= c O=c 2/15/2002 1:54:58 P
4
2. Select the item you wish to restore.
&.% Backup, Archive, and Restore - NetBackup - [Proxy Restore: Server: sasweed Source Client: folip 10l x|
() Fle Edit Yiew Actions Window Help - |ﬁ||5|
Bl sslect for Backup | B3 Select For Restore - | T view Status | @&
ﬁ MNetBackup History
— 200z
=l Feb
— 15
2| @
'&3 All Folders Contents of 'C:\Program Files', YERITAS NetBackup®
=] Folip Mame | Tirne Backed Lp | Al Size I Tirme Modified |
- Readme_Client.kxt  2/15/2002 115059 PM  — 8307  1/29/2002 10:24:18 PM
=-[#] 1 Program Files
=-[71( vERrITAS
- [PlEZ NetBackup
A

3. On the Actions menu, click Start Restore of Marked Files.

The Restore Marked Files dialog box will open.

4. Click Overwrite the existing file.

5. Click Start Restore.
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This chapter provides reference information on the Backup, Archive, and Restore
interface. It includes a description of the menus, windows, and dialog boxes.

NetBackup Icons

The following table describes NetBackup icons you may see on the Microsoft Windows

desktop.
Icon Description
i Represents NetBackup. It is used on the title bar in the Backup, Archive, and

Restore interface, in the Windows Start menu, and Windows Explorer.

Indicates that the NetBackup Client Job Tracker is running, but there are
currently no backups or restores processing. Used in the system tray.

Indicates that the NetBackup Client Job Tracker is running, with at least one
restore processing. Used in the system tray. When the yellow arrow is blinking,
you can open the NetBackup Client Job Tracker for an estimate of the restore
operation.

Indicates that the NetBackup Client Job Tracker is running, with at least one
backup processing. Used in the system tray. When the yellow arrow is blinking,
you can open the NetBackup Client Job Tracker for an estimate of the backup
operation.

Indicates that the NetBackup Client Job Tracker is running, with at least one

backup and one restore processing. Used in the system tray with the yellow
arrows blinking.

@ @ ]

[

[ &
L1

k

Menus

This section explains the menu bar commands on the Backup, Archive, and Restore
interface.
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File Menu

The commands on the File menu provide overall control of your NetBackup session.

s_Tﬁ Backup, Archive, and Restore -

WY Fle Edt Wiew Actions Windo

MNetBackup - [Backup: Sery - |EI|1|
w  Help 18] =

F 73 Select Files and Folders to Backup. .. l, chatne | [P0 X

Select Files and Foldets ta Restate...

W B From SlormalBasc.,

g MetBackup Client Properties. ..
o Specify MetBackup Machines. ..

2 |

from Archived Backup. ..
From Raw Partition Backup...

from True Image Backup...

Wiew Skatus, .,

from Backup Exec Backup...

[ | |7 MetBackup Explorer Extensions

from Mormal and Backup Exec Backups. ..

Close
Exit

Ctrl+F4 from Mormal Backup as a Proxy...
from Archived Backup as a Proxy...

from Raw Partition Backup as a Proxy...

from True Image Backup as a Proxy. ..

-
1| | 3

These menu options are available on the File menu.

Select Files and
Folders to Backup

Select Files and
Folders to Restore

from Normal
Backup

from Archived
Backup

from Raw
Partition Backup

from True Image
Backup

Opens the NetBackup Backup window. From this window, you can
select files, folders, or registry keys to back up, and then start a
backup or archive operation.

Opens the submenu and provides access to the following
commands:

Opens a NetBackup Restore window. From this window, you can
select files, folders, or registry keys saved during previous backups
and start a restore operation.

Opens a NetBackup Restore (Archive) window. From this window,
you can select files, folders, or registry keys saved during previous
archives and start a restore operation.

This menu option is not supported in NetBackup 4.5 for Windows.
To restore a raw partition backup, use the from Normal Backup
menu option.

Opens a NetBackup Restore (True Image) window. From this
window, you can select files, folders, or registry keys saved during
previous true image backups and start a true image restore
operation.
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from Backup
Exec Backup

from Normal and
Backup Exec
Backups

from Normal
Backup as a
Proxy

from Archived
Backup as a
Proxy

from Raw
Partition Backup
as a Proxy

from True Image
Backup as a
Proxy

NetBackup Client
Properties

Specify NetBackup
Machines

View Status

Opens a NetBackup Restore window. From this window, you can
select files, folders, or registry keys saved during previous backups
and restore Backup Exec images.

Opens a NetBackup Restore window. From this window, you can
select files, folders, or registry keys saved during previous backups
and restore both NetBackup and Backup Exec images.

This feature allows a user on a Windows NT/2000 machine to
browse the backups of another Windows NT/2000 machine. The
remote user can select files, folders, or registry keys from the
backup and restore to the remote machine. NetBackup will see all
the requests as if they were coming from the remote Windows
NT/2000 machine.

This feature allows a user on a Windows NT/2000 machine to
browse the archive backup of another Windows NT/2000 machine.
The remote user can select files, folders, or registry keys from the
backup and restore to the remote machine. NetBackup will see all
the requests as if they were coming from the remote machine.

This feature allows a user on a Windows NT/2000 machine to
browse the raw partition backup of another Windows NT/2000
machine. The remote user can select files, folders, or registry keys
from the backup and restore to the remote machine. NetBackup
will see all the requests as if they were coming from the remote
machine.

This feature allows a user on a Windows NT/2000 machine to
browse the true image backup of another Windows NT/2000
machine. The remote user can select files, folders, or registry keys
from the backup and restore to the local machine. NetBackup will
see all the requests as if they were coming from the remote
machine.

Opens the NetBackup Client Properties dialog box. From this
dialog box, you can specify the parameters that control backups,
archives and restores for your client. See “NetBackup Client
Properties Dialog Box” on page 61 for more information.

Opens the Specify NetBackup Machines dialog box. From this
dialog you can change the settings for the master server and client
machines. See “Specify NetBackup Machines Dialog Box” on
page 64 for more information.

Opens the View Status dialog box. From this dialog box, you can
review the progress report of a user operation in progress. You can
also review logs from past user-directed NetBackup operations.
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NetBackup If the NetBackup Explorer Extensions feature is installed, this item
Explorer Extensions toggles this feature off and on.

Close This command appears in the File menu when a NetBackup
Backup window or a NetBackup Restore window is open. Use this
command to close an active window.

Exit Terminates the Backup, Archive, and Restore interface. Any
backups or restores in progress will continue to completion.

Edit Menu

This menu is available when either the NetBackup Backup window or the NetBackup
Restore window is opened.

4 Backup, Archive, and Restore - NetB. (=] ]

3 File [Edt visw Actions Window Help -8 x|

Bl sele Mark Displayed Files b | Gy view Status | &

I Unmark Displayed Files —
2 Unmark Al

Preview List of Marked Files. ..

@ |

4

The commands on the Edit menu modify your selections in the currently selected backup
or restore window.

Mark Displayed Marks only the files, folders, or registry keys that currently appear in
Files the Contents of '<folder>’ pane of the NetBackup Backup window or
NetBackup Restore window.

Unmark Unmarks only the selections that currently appear in the Contents of
Displayed Files ’<folder>’ pane of the NetBackup Backup window or NetBackup
Restore window.

Unmark All Unmarks all files, folders, or registry keys in this window. You can
also execute this command by clicking the Unmark All button on the
NetBackup Restore window toolbar or the NetBackup Backup
window toolbar.
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Preview Listof  Opens the Preview List dialog box. This command is enabled when

Marked Files files, folders, or registry keys have been selected in the NetBackup
Backup window or the NetBackup Restore window. You can also
execute this command by clicking Preview List of Marked Files on
the NetBackup Restore window toolbar or the NetBackup Backup
window toolbar.

View Menu

The commands on the View menu control the contents of the NetBackup Backup window
and the NetBackup Restore window.

s_:'j Backup, Archive, and Restore - NetBackup - |EI|1|
File | Wiew Actions Help
_@ l_ Status Bar r Restore  + | (3yView Status | @

E Description Bars

@ad Toolbar Options...

|7 Save Settings on Exit

During a backup or archive operation, the following menu is available.

s_:'j Backup, Archive, and Restore - NetBackup - [Bal:kl.l:E - |EI|1|
3 Fle Edit | view Actions Window Help _ &) x|
23l Select For 'ﬁ Status Bar - | {2y view Status | d
— E Description Bars e
% @da Toolbar Options. ..
B Split
|7 Save Settings on Exit
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During a restore operation, the following menu is available.

45 Backup, Archive, and Restore - NetBackup - [Restore: Server: windows. -0l = |
[l File Edit | View Actions ‘Window Help 18] = |
23l Select For 'ﬁ Status Bar | & ‘
__’E Description Bars
NetBack
% @3a Toolbar Options. ..
|7 Show MetBackup History as a Timeline
:B: ’,'h Show Al Backups
'ﬁ Show Most Recent Backup
by Split
,@ All Folde MetBackup History Split
Refresh NetBackup History F5 K. | AL, | Size I Tirne Mo... | Horme: | Tab... | Skatus | |
|7 Save Settings on Exit
4L
Status Bar Shows the NetBackup status bar. Deselect this option to hide the

Description Bars
Toolbar Options

Show NetBackup
History as a
Timeline

Show All Backups

Show Most Recent
Backup

Split

NetBackup status bar.

Shows the description bars on the backup and restore window
panes. Deselect this option to turn off the description bars.

Opens the Toolbar Options dialog box. Go to “Toolbar Options
Dialog Box™ on page 73 for more details.

Displays the NetBackup History pane as a timeline. To show the
NetBackup History pane as a detailed list, clear this checkbox.

Shows all instances of files, folders, or registry keys in the
currently selected image(s). You can also execute this command on
the NetBackup Restore window toolbar.

Shows the most recent backup of files, folders, or registry keys
from the currently selected backup image(s). You can also execute
this command on the NetBackup Restore window toolbar.

Changes the cursor to a double bar with two arrows and positions
it over the vertical split bar between the All Folders and Contents
of '<folder>’ panes. You can then move the cursor left or right to
position the split bar.
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NetBackup History
Split

Refresh NetBackup
History

Save Settings on
Exit

Actions Menu

Changes the cursor to a double bar with two arrows and positions
it over the horizontal split bar between the NetBackup History
pane and the All Folders and Contents of '<folder>’ panes. You can
then move the cursor up or down to position the split bar.

Updates information in the NetBackup History pane.

When selected, this command will save window specific settings
upon exit.

The following menu items appear when the NetBackup Backup window is active. These
commands control backup operations.

&4 Backup, Archive, and Restore - MetBackup - [Backup: Serv: w 10l =|
3 Fle Edit View | Actions Window Help _18] x|
B3} Select For Backup Specify Policy and Schedule. .. Fabus | &
g All Folders g Skart Backup of Marked Files. .. fC:
—~ Add to Excluds List [a. ] Size | Time Mg
:B: Add ko Include List
Administer; Oracle Templates

-
1| | 3

4

Specify Policy Opens the Backup Policy and Schedule dialog box. See “Backup Policy
and Schedule and Schedule Dialog Box” on page 74 for more details.

Start Backup of  Opens the Specify Backup Options dialog box. You can also execute
Marked Files this command by clicking Start Backup of Marked Files on the
NetBackup Backup window toolbar.

Add to Exclude Adds the selected files, folders, or registry keys to the Exclude File

List List. For more details, refer to “Exclude List Tab” on page 103.

Add to Include Adds the selected files, folders, or registry keys to the Include File List.
List For more details, refer to “Include List Tab” on page 104.

Administer Allows you to list, remove, rename, edit, and run existing Oracle

Oracle Templates templates.
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The following menu items appear when the NetBackup Restore window is active. These
commands control restore operations.

&% Backup, Archive, and Restore - NetBackup - [Restore: Server: — o]
Bl) File Edit View | Actions ‘Window Help ===
Bl select for Backup BRI 3arch Backups... atus | &
& NetBackup His (=) Start Bestors of Marked Files..
i [ (v normal Backups
1 ’
= Administer Oracle Templates Archived Backups
o Raw Partition Backups
Trus Image Backups
Backup Exec Backups
|« | Mormal and Backup Exec Backups |
4 [N Folders Contents of * Eroxy Marmal Eackups
— ﬂ Hame Proxy Archived Backups e Modified
Prozy Raws Partition Backups
Prosey True Image Backups
<] | 3 4] Il
A

Search Backups

Start Restore of
Marked Files

Select Restore
Type
Normal
Backups

Archived
Backups

Raw Partition
Backups

True Image
Backups

Backup Exec
Backups

Normal and
Backup Exec
Backups

Opens the Search Backups dialog box. You can also execute this
command by clicking Search Backups on the NetBackup Restore
window toolbar.

Opens the Restore Marked Files dialog box. You can also execute this
command by clicking Start Restore on the NetBackup Restore
window toolbar.

Opens the submenu and provides access to the following commands:

Opens the NetBackup Restore window. You can select files, folders, or
registry keys saved during previous backups and start a restore
operation.

Opens the NetBackup Restore (Archive) window. You can select files,
folders, or registry keys saved during previous archives and start a
restore operation.

This menu option should be used to restore raw partition backups of
UNIX clients. To restore a backup of a Windows disk-image, choose
the Normal Backups menu option.

Opens the NetBackup Restore (True Image) window. You can select
files, folders, or registry keys and start a true image restore operation.

Opens the NetBackup Restore window. You can select files, folders, or
registry keys saved during previous backups and restore Backup Exec
images.

Opens the NetBackup Restore window. You can select files, folders, or
registry keys saved during previous backups and restore NetBackup
and Backup Exec images.
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Proxy Normal
Backups

Proxy
Archived
Backups

Proxy Raw
Partition
Backups

Proxy True
Image
Backups

Administer
Oracle Templates

Window Menu

This feature allows a user on a Windows NT/2000 machine to browse
the backups of another Windows NT/2000 machine. The remote user
can select files, folders, or registry keys from the backup and restore to
the remote machine. NetBackup will see all the requests as if they
were coming from the remote Windows NT/2000 machine.

This feature allows a user on a Windows NT/2000 machine to browse
the archives of another Windows NT/2000 machine. The remote user
can select files, folders, or registry keys from the backup and restore to
the remote machine. NetBackup will see all the requests as if they
were coming from the remote Windows NT/2000 machine.

This menu option should be used to restore proxy raw partition
backups of UNIX clients. To restore a proxy backup of a Windows
disk-image, choose the Proxy Normal Backups menu option.

This feature allows a user on a Windows NT/2000 machine to browse
the true image backups of another Windows NT/2000 machine. The
remote user can select files, folders, or registry keys from the backup
and restore to the remote machine. NetBackup will see all the requests
as if they were coming from the remote Windows NT/2000 machine.

Allows you to list, remove, rename, edit, and run existing Oracle
templates.

The Window menu has commands for arranging your NetBackup windows. It becomes
available when the NetBackup Backup window or the NetBackup Restore window is

opened.

A Backup, Archive, and Restore - NetBack 10l =|
File Edit View Actions | window Help =1 |
13 Select For Backup | 5 Cascads Shift-+FS 5
% Tile Horizontally Shift+F4 L
NetB. Hist
@ & Tile Yertically L
Arrange Icons
Close &l
:B: 1 Backup: Server: windows  Client: Folip
v 2 Restore: Server: windows  Client: Folip
Rld | o
%L% All Folders Contents of *folip*
ﬂ ame | Time Backed Up
-
4 | » 4 | |
4
——
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These menu options are available on the Window menu:

Cascade
still be visible.

Tile Horizontally
horizontally on the desktop.
Tile Vertically
on the desktop.

Arrange Icons
desktop.

Close All
windows.

Help Menu

Arranges NetBackup windows so they overlap, but the title bars will
Modifies the size of NetBackup windows and arranges them
Modifies the size of NetBackup windows and arranges them vertically
Arranges icons so they are located in the lower left corner of the

Closes the NetBackup Backup windows and the NetBackup Restore

This menu provides access to the online instructions for using NetBackup.

s_Tﬁ Backup, Archive, and Restore - NetBackup - [Restore:
File Edit View Actions Window | Help

Blsclct for Backup | By selec for o € Contents
Search for Help On...

MNetBackup History

g [l
=@l x|

i3] How to Use Help .
w @ VERITAS Web Page
' —_— i i
| | ﬁ L — MetBackup Third Party Software Information
27 sbout NatBacklp Glisnt
LA 1
,@ All Folders Contents of *folip*
E ;I ame | Time Backed Up | A | 1
- -
3 4 | » 1| | 1
4,

These menu options are available on the Help menu:

Contents

Opens the table of contents in the online help.

Search For Help Opens the search facility for the online help.

On

How to Use Help Describes how to use the online help.

VERITAS Web
Page

Opens the VERITAS Web site in your internet browser.
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NetBackup Third Displays additional copyright information for third party software
Party Software  used in NetBackup.

Information

About Displays information about NetBackup, including the version
NetBackup number.

Client
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Windows

This section explains the windows on the Backup, Archive, and Restore interface.

NetBackup Window Icons

This section describes all icons displayed in the windows.

1 S
- =]

"
Fl

b

i dl g L DGR

g Do

O &

Description

Represents NetBackup. It is used on the title bar in the Backup, Archive, and
Restore interface, in the Windows Start menu, and Windows Explorer.

Represents a backup. It is used on the title bar of the backup window.
Represents a restore. It is used on the title bar of the restore window.

Represents a floppy drive. Used in the All Folders pane.

Represents a logical hard drive. Used in the All Folders pane.
Represents a CD-ROM drive. Used in the All Folders pane.

Represents a networked drive. Used in the All Folders pane.
Represents a client PC. Used in the All Folders pane.

Expand or collapse these structures to see more or fewer subentries. A plus sign
indicates that the folder can be expanded. A minus sign indicates that the folder
can be collapsed. Used in the All Folders pane.

Represents a closed folder that may or may not contain other items. Used in the
All Folders pane where only folders are displayed under drives. Also in the
Contents of '<folder>’ pane.

Represents an opened folder that may or may not contain other items. Used in the
All Folders pane where only folders are displayed under drives.

Represents a file or a folder, with all of its contents, that has been marked for
backup or restore. Used in the All Folders pane and the Contents of "<folder>’
pane.

Represents a folder with some of its contents marked for backup or restore. Used
in the All Folders pane and the Contents of '<folder>’ pane.

Represents a file or folder that has not been marked for backup or restore, but
could be. Used in the All Folders pane and the Contents of ’<folder>’ pane.
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Icon  Description

Represents an object with all of its contents marked for backup or restore, but the
object itself cannot be marked. Used in the All Folders pane and the Contents of
‘<folder>’ pane.

Represents an object with some of its contents marked for backup or restore, but
the object itself cannot be marked. Used in the All Folders pane and Contents of
‘<folder>’ pane.

] Represents an object that cannot be marked for backup or restore but contains
other objects that can be marked for backup or restore. Used in the All Folders
pane and Contents of '<folder>’ pane.

Represents a folder that wasn’t specifically backed up, but at least some of its
contents were backed up. Used in the All Folders pane of the NetBackup Restore
window.

Represents a file that doesn’t have an icon associated with it. Used in the Contents
of <folder>’ pane.

Represents the entire registry. Used in the All Folders pane.

The registry opens to two base keys: HKEY_LOCAL_MACHINE and
HKEY_USERS.

Represents a registry key. Used in the All Folders pane. Also used in Contents of
‘<folder>’ pane if it contains subkeys.

Represents the entire network. Used in the All Folders pane.

Represents a specific network. Used in the All Folders pane and the Contents of
‘<folder>’ pane.

Represents a domain within a network. Used in the All Folders pane and the
Contents of '<folder>’ pane.

B 084, & B [
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Backup, Archive, and Restore Window

This window displays when you start NetBackup.

s_:'j Backup, Archive, and Restore - NetBackup _ |EI|1|
File Wiew Actions Help

tyview status | &

13 Select For Backup | B3, Select for Restore -

Ready v

The following buttons appear on the toolbar.
Button Description

Opens the NetBackup Backup window.
Opens the NetBackup Restore window.

Opens the View Status dialog box.

Updates the list of backup images. This button is only available when a
Restore window is open and is the active window.

Opens the online help.

Lo
=
=
&
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NetBackup Backup Window

This window shows the files, folders, or registry keys you can mark for back up.

s_Tﬁ Backup, Archive, and Restore - NetBackup - [Backup: Server: windows Client: f - |EI|1|
3 Bl Edit View Actions Window Help _ &) x|
13 Select For Backup | 3, Select for Restore ~ | 2 View Status | &
g All Folders Contents of C:,
— =m0 s Marne A Size I Time Modified | -
i |B0= E O apoBEARR d-- 0 10112001 4:18:36 PM
=0 O Cacheck-ns de-- 0 1/9/2002 10:13:20 AM
OS e [ Caoirections d-- 0 12{17(2001 10:35:22 AM
O=rF O A oocuments and Settings d-- 0 10/9/2001 2:17:19 M
=2n
=1 O CaFrameboc d-- 0 12{17/2001 10:54:43 AM
&[] 5 Network (A Localization_4.5 d-- 0 1/2/2002 4:43:22 PM
-] 3 Redistry O Camy Download Files d-- 0 7/26/2001 6:17:07 &M
D% System_ State O Camy Music d-- 0 7j26(2001 6:17:29 AM
N A rrogram Files d-r 0 1/15/2002 11:13:55 AM L
O CARECYCLER dsh- 0 10/10/2001 12:17:15 PM
[ 5ystem Yolume Information  dsh- 0 7/25/2001 3:29:55 PM
O CaTeme d-- 0 1/6/2002 7:35:17 PM
O (Catest d-- 0 12{12(2001 3:06:37 PM
[ £ Test WinHelp d-- 0 10/26{2001 2:27:05 PM
[ £ windows Update Setup Files  d-— 0 7/26/2001 5:55:44 AM
O Cawnnr d-- 0 1/15/2002 11:33:54 AM x|
Ready v

To access this window:

& On the File menu, click Select Files and Folders to Backup

¢ Click the Select for Backup button on the Backup, Archive, and Restore interface

toolbar.

You can position this window separately. You can also cascade, tile or minimize the
window by using commands from the Window menu.

Buttons

These buttons are available in the NetBackup Backup window.

Button Description

E the backup operation.
a5~

w5

Opens the Specify Backup Options dialog box. From this dialog you can start

Unmarks all files, folders and registry keys in this window. You can also
execute this command by selecting Unmark All from the Edit menu.

Opens the Preview List dialog box during a backup operation. You can also
execute this command by selecting Preview List from the Edit menu.
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Panes

The NetBackup Backup window contains two panes: All Folders and Contents of
‘<folder>’.

& To adjust the width of the panes, position the cursor over the split bar. The cursor will
change to a double-headed arrow. Press the left mouse button and move the cursor
left or right to position the split bar.

& To resize columns in a pane, move the mouse over the column header until the cursor
changes to a double-headed arrow. Hold the left mouse button down and move the
mouse left or right to decrease or increase the column width.

& To sort information in a pane, click on the column header for the information you
wish to sort by. For example, to sort the pane by “Size,” click on the Size column. This
will sort the list from the smallest to largest size. Click the Size column again to sort
from largest to smallest.

NetBackup Restore Window

This window shows the files, folders, or registry keys that you can mark for restore.

&% Backup, Archive, and Restore - NetBackup - [Restore: Server: windows i ]
Eile Edit View Actions ‘Window Help - |E’|5|
13 select for Backup | B3, Select For Restore - | {2y view Status | &
@ MNetBackup History
— 2002 2001
bl Jan Dec
—_— 15 14 13 12 11 10 9 8 76 ) 2 1 31 30 29 28 27
i - = &l & & & & @ [l
(™ [ [
= !
% 4 | i
@ All Folders Contents of folip®
E|E| falip | | Mame | Tirme Backed Up | ateributes | size [ Time Modified |

= O=c O=c 1/15/2002 12:27:58 PM

Eg "‘505:”""’ O=o 1/5/2002 314338 M d 0 1/5/2002 3:34:06 PM

: Zheck-ins (el

i S Swstern_... 1/14/2002 5:49:41 PM

DD Canfig.Msi D YR il

DD Liirections

- @[] bocuments and Set

4 I I »

Ready Az
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To access this window:

& On the File menu, click Select Files and Folders to Restore, then click the desired
type of restore.

& To open the same type of restore as opened previously, click Select for Restore on the
toolbar.

& To open a different type of restore, click the arrow next to the Select for Restore
button, then select the desired type of restore.

The folder trees in this window contain only files and folders that were backed up. You
can position this window separately. You can also cascade, tile, or minimize the window
by using commands from the Window menu.

Notes:

& Ifthe client belongs to more than one policy, the default display starts with the last full
backup that occurred first. For example, assume that the client belongs to Policy A
and Policy B and full backups occur for both of them. If the last full backup for Policy
A occurred before the one for Policy B, then the display shows files ranging from the
time of the Policy A full backup.

& Ifyou are restoring from a true image backup, the NetBackup Restore window shows
only the folders that were included in true image backups. Files do not appear in this
window because you cannot select individual files for a true image restore.

Buttons

These buttons are available on the NetBackup Restore window:

Button Description
Opens the Search Backups dialog box.

Opens the Restore Marked Files dialog box. From this dialog you can start the
restore operation.

Unmarks all files, folders, or registry keys in this window. You can also execute
this command by selecting Unmark All from the Edit menu.

w5~

w5~

Opens the Preview List dialog box during a restore operation. You can also

=] execute this command by selecting Preview List of Marked Files from the Edit
menu.

” Shows all instances of the files, folders, or registry keys in the currently selected
&E image(s). You can also execute this command by selecting Show All Backups
from the View menu.
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Button Description

QQEEE Shows the most recent backup of files, folders, or registry keys in the selected

backup images. You can also execute this command by selecting Show Most
Recent Backup from the View menu.

Panes

The NetBackup Restore window is split into three panes: the NetBackup History pane on
the top, the All Folders pane on the left and the Contents of '<folder>" pane on the right.

4

To adjust the height of the NetBackup History pane, position the cursor over the
horizontal split bar. The cursor will change to a double bar with two arrows. Press the
left mouse button and move the cursor up or down to position the split bar.

To adjust the width of the All Folders pane and the Contents of '<folder>’ pane,
position the cursor over the vertical split bar. The cursor will change to a double bar
with two arrows. Press the left mouse button and move the cursor left or right to
position the split bar.

To resize columns in a pane, move the mouse over the column header until the cursor
changes to a double-headed arrow. Hold the left mouse button down and move the
mouse left or right to decrease or increase the column width.

To sort information in a pane, click on the column header for the information you
wish to sort by. For example, to sort the pane by “Size,” click on the Size column. This
will sort the list from the smallest to largest size. Click the Size column again to sort
from largest to smallest.

NetBackup History Pane

The NetBackup History pane shows the NetBackup image(s). When first opened, the
following backup images are selected by default:

*
*

4

The most recent full backup.

All cumulative-incremental backups and differential-incremental backups that have
occurred since the most recent full backup.

All user-directed backups that have occurred since the most recent full backup.

If there is no full backup, only the most recent image will be selected.

V¥ To Open the NetBackup History Pane

4

Position the cursor over the horizontal split bar. The cursor will change to a
double-headed arrow. Press the left mouse button and move the cursor up or down to
position the split bar.
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or

¢ On the View menu, click NetBackup History Split. This changes the cursor to a
double-headed arrow. Move the cursor up or down to position the split bar. Click the
left mouse button to hold position.

V¥ Backup History as a Timeline

To show the NetBackup History pane as a timeline, from the View menu click Show
NetBackup History as a Timeline.

The icons, representing images, appear directly underneath the date of the backups. Icons
with a square represent selected backup images. Several backup image icons may appear
below a date. The most current backup image is on top of the list. As you move the cursor
over the icons, tool tips will show the schedule type and the date and time of the backup.

Tip If you do not see tool tips, open the Toolbar Options dialog box from the View
menu and select Show tool tips.

Icon Description
This green icon represents a full backup.

This blue icon represents a differential incremental backup.

This light blue icon represents a cumulative incremental backup.
This red icon represents a user-directed backup.

This yellow icon represents a user-directed archive.

This grey icon represents an unknown type of backup.

DEQPOC

V¥ To Select Backup Images
¢ Select a single backup image by clicking on it.
& Select a range of backup images by clicking on the first, holding down the Shift key,
and clicking on the last image.
V¥ Backup History as a Detailed List

To show the NetBackup History pane as a detailed list, clear the Show NetBackup
History as a Timeline option on the View menu. The list starts with the most recent
backup and includes the following information (reading from left to right).

¢ Date and time when the backup occurred.
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¢ Date when NetBackup will expire the backup and delete it from the NetBackup
History pane.

Number of files in the backup.

Size of the backup in kilobytes.

Whether the backup is compressed (Y for yes, N for no).
Type of schedule.

* & & o o

Name of the policy associated with the backup. The system administrator configures
the policy names, as explained in the NetBackup System Administrator’s Guide for UNIX
or the NetBackup System Administrator’s Guide for Windows.

¢ Keyword assigned to the backup.
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Dialog Boxes

This section describes the dialog boxes used in the Backup, Archive, and Restore interface.

NetBackup Client Properties Dialog Box

This section explains the tabs found in the NetBackup Client Properties dialog box. To
open this dialog box, choose NetBackup Client Properties on the File menu.

General Tab

NetBackup Client Properties x|

General |Exclude ListI Include List ﬁackupsl ﬂetworkl lroubleshootingl

Client name:

List files timeout: Bestore retries:

|3DD _,::' seconds 0 =

Time overlap: User-directed operation timeout:

IBD _|::' minutes IBD _|::' seconds

Keep statug of user-directed backups,
archives, and restores for:

|3 _,::' days

v Peform incrementals based on archive bit
V' Allow server-diected restores

[+ Perform default search

QK I Cancel Help |

Use this tab to set any of the configuration parameters for your client.

To access this tab:
1. Onthe File menu, click NetBackup Client Properties.

2. Click the General tab.

Only the system administrator should change the following parameters. Refer to “General
Tab” on page 100 for details on these parameters:

& Client name
& List files timeout

& Restore retries
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Time overlap
User-directed operation timeout

Perform incrementals based on archive bit

* 6 o o

Allow server-directed restores

The NetBackup client user as well as the system administrator can change the following
parameters.

Keep status of Specify the number of days to store progress reports before the system
user-directed will automatically delete them. Default is 3 days. The minimum
backups, allowable value is zero. The maximum is 9,999.

archives, and

restores for

Perform default If selected, NetBackup will automatically search the default range of
search backup images and display the backed up folders and files whenever
a restore window is opened.

Clear this box to disable the initial search. The NetBackup Restore
window will not show any files or folders when initially opened.
Clicking a backup image, or selecting a range of backup images, will
initiate a search.

By default, this box is selected.
OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Exclude List Tab

Only the system administrator should change the parameters on this tab. System
administrators should refer to “Exclude List Tab” on page 103 for details on these
parameters.

Include List Tab

Only the system administrator should change the parameters on this tab. System
administrators should refer to “Include List Tab” on page 104 for details on these
parameters.
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Backups Tab

Use this tab to specify the policies and schedules to use when you start a backup from the
client.

NetBackup Client Properties x|
ﬁenerall Exclude List | Include List  Backups |ﬂetwork| lroubleshootingl

Backup Policy:

=

Backup Schedule:
Iany

Archive Policy:
Iany

Archive Schedule:
Iany

QK I Cancel Help |

To access this tab:
1. Onthe File menu, click NetBackup Client Properties.

2. Click the Backups tab.

Note Changes made to this tab will not apply to currently open backup windows. The
changes will apply to all backup windows opened after the tab modifications have
been saved.

Backup Policy  Specify the policy to use for user-directed backups of this client. If you
set this value to “any” (which is the default), NetBackup uses the first
policy that it finds with both the client name and a user-directed
backup schedule.

Backup Schedule Specify the schedule to use for the user-directed backups for this
client. If you set this value to “any” (which is the default), NetBackup
uses the first user-directed backup schedule in the first policy that it
finds with both the client name and a user-directed backup schedule.
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Archive Policy  Specify the policy to use for user-directed archives of this client. If you
set this value to “any” (which is the default), NetBackup uses the first
policy that it finds with both the client name and a user-directed
archive schedule.

Archive Specify the user-directed archive schedule to use for user-directed

Schedule archives of this client. If you set this value to “any” (which is the
default), NetBackup uses the first user-directed archive schedule in
the first policy that it finds with both the client name and a
user-directed archive schedule.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Network Tab

Only the system administrator should change the parameters on this tab. System
administrators should refer to “Network Tab” on page 107 for details on these parameters.

Troubleshooting Tab

Only the system administrator should change the parameters on this tab. System
administrators should refer to “Troubleshooting Tab” on page 108 for details on these
parameters.

Specify NetBackup Machines Dialog Box

This section explains the tabs found in the Specify NetBackup Machines dialog box when
using the Backup, Archive, and Restore interface for the client. To open this dialog box,
choose Specify NetBackup Machines from the File menu.

For information on the tabs available when using the Backup, Archive, and Restore
interface on the server, see “Specify NetBackup Machines Dialog Box for System
Administrators” on page 96.
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Servers Tab

Use this tab to add and remove NetBackup servers and to specify the current server to be
used for user operations.

Specify NetBackup Machines ﬂ

Servers | Clients |

Mew Server Mame:

Server List:
windowz[CURREMT]
carrat
cattail

Eemove |MakeEurrent|
QK I Cancel Help |

To access this tab:
1. Onthe File menu, click Specify NetBackup Machines.

2. Click on the Servers tab.

New Server Name  To add another NetBackup server to the Server List, type the
name of the new server in the New Server Name text box and
click Add. The name must be as defined by the system
administrator on that server.

If a new server is added to the list from this dialog box, it will
appear in the server list for all windows currently opened and any
new window that is opened. The new server will be saved in the
Server List box after the current window is closed.

Add Adds the server, entered in the New Server Name box, to the
Server List.
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Server List

Remove

Make Current

OK
Cancel

Help

Shows the names of the NetBackup servers that require access to
the client for scheduled backups, and any other servers used when
performing user-directed backups. The master server and any
remote media servers that perform scheduled backups of the client
must appear in this list. The machine designated as CURRENT
will be the server used for user-directed operations.

To mark a server as CURRENT, select a server from the Server List
and click Make Current. The word CURRENT appears in
parentheses beside the name.

Removes a server. First highlight the server in the Server List, then
click Remove.

Note The master server cannot be removed from the Server List. While
other servers can be removed from the list, be careful not to remove
any remote media servers. Doing so will prevent scheduled backups
from being performed. For more information on making changes to
the Server List, refer to the NetBackup System Administrator’s Guide
for UNIX or the NetBackup System Administrator’s Guide for
Windows.

First highlight the server in the Server List, then click Make
Current. Changing the current server will affect only the selected
window. This setting will not be saved after the currently selected
window is closed.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.
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Clients Tab and Clients/Policy Type Tab

If the NetBackup Backup window is active when you open the Specify NetBackup
Machines dialog box, the Clients tab is available:

Specify NetBackup Machines ﬂ
Servers  Clients |
Mew Client Mame:
Add
Llient List:
folip[CURRENT)
Eemove | Iake Current |
¥ | Wse this client list for future backup andrestore windows
QK I Cancel | Help |

If the NetBackup Restore window is active when you open the Specify NetBackup
Machines dialog box, the Clients/Policy Type tab is available:

Specify NetBackup Machines ﬂ
Servers  Clients/Policy Type |
Mew Client Mame:
Add
Llient List:
folip[CURRENT)
Iake Current |
V' Use this client list for future backup and restore windaws
Folicy Type:
| MS-Windows-NT 4|
QK I Cancel | Help |

Use this tab to select the remote client whose backups you want to restore to your client.
You can also add names of remote clients.

————
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To access this tab:
1. Onthe File menu, click Specify NetBackup Machines.

2. Click on the Clients tab or the Clients/Policy Type tab.

Note Most changes made to the this tab will not apply to currently open backup or
restore windows. If, however, a client is added, the open windows will be able to
switch to them.

New Client Name To add another client name to the Client List, type the name of
the client in the New Client Name box and click Add. The client
name entered must also be defined in a policy on the NetBackup
server.

If a new client is added to the list it will be in the client list for all
windows currently opened and any new window that is
opened. The new client will be saved in the Client List box after
the current window is closed.

Add Adds the client, entered in the New Client Name box, to the
Client List.
Client List The Client List contains the client name for your computer. It

can also contain the names of remote NetBackup clients. You can
select local or remote NetBackup clients on which to perform
NetBackup operations.

The NetBackup server administrator must set up the required
permissions before you can browse and restore from any remote
client.

To perform a NetBackup operation on a NetBackup client, select
the name from the Client List and click Make Current. The
word CURRENT appears in parentheses beside the name of the
new default client.

Remove Removes a client. First highlight the client in the Client List,
then click Remove.

Make Current Designates the client backup images you can browse for restore
operations. First highlight the client in the Client List, then click
Make Current. Changing the current client will affect only the
selected window. This setting will not be saved after the
currently selected window is closed.
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Policy Type

Use this client list for
future backup and
restore windows

OK
Cancel

Help

(Only available when a restore window is the active window.)
Specifies the policy type for the client selected in the Client List.
The policy type must be the same as specified in the
configuration for that client on the NetBackup server.

(Only available when a restore window is the active window.) If
selected, NetBackup applies any changes to the client list to all
backup and restore windows opened after the tab modifications
have been saved.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

View Status Dialog Box

Use this dialog box to view the results of each user operation in a progress report.

o

%5 ¥iew Status (EBlaufus)

=10l x|

Operation Type

Backup

Operation Status | | Lloze |

Delete |
Help |

S zful
Successhul

— Selected Operation:

Fiefrezh Rate [seconds]: |5 ill
w

[~ Werhose Frrint.... |
Progress:
12:32:39 INF - BACKUP START ;I
12:32:42 IMF - \Waiting for mount of media id DO035 on server carrat,
12:3310 INF - OTM: enabled
12:33:34 INF - Total Size:2309
12:33:34 IMF - Client completed sending data for backup
12:34:35 IMF - \Waiting for pogitioning of media id DO035 on server carot,
12:36:09 IMF - Beginning backup on server carrat of client folip.
12:36:37 IMF - Backup by EBlaufus on client folip: the requested operation was succe
| | _>l:I

To access this dialog box:

& On the File menu, click View Status.
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Note If a backup is split across more than one media ID, the Status lists all the media.
NetBackup uses only what it needs to restore the requested files, folders, or registry
keys.

Operations List  Lists operation status reports for NetBackup operations. The most
current NetBackup operation is on top of the list.

By default NetBackup operation status reports will be stored on the
NetBackup client for three days. Refer to “General Tab” on page 61
for more information on changing the configuration setting called
Keep status of user-directed backups, archives, and restores for.

Operation Shows the type of NetBackup operation for the selected progress
Type report: Backup, Archive, or Restore.
Time Shows the start date and time of the selected NetBackup operation.
Requested The format of the start date and time depends upon how the date and
time display has been configured on the computer.

Operation Shows the status of a NetBackup operation.
Status

Close Closes the dialog box. Close does not terminate NetBackup or affect

other dialog boxes or windows.

Delete Deletes the progress report selected in the Operations List. First select
the progress report in the Operations List then click Delete.

Operation status reports are automatically deleted after a specified
number of days. The Keep status of user-directed backups, archives,
and restores for parameter in the General tab in the NetBackup Client
Properties dialog box specifies the number of days.

Help To view online help for this dialog box, click this button.

Refresh Rate Changes the rate at which NetBackup updates the Status display for

(seconds) the selected operation. Recommended value is 10. This parameter can
be set at any time during a NetBackup operation. A value of 0 turns
off automatic refreshing.

Verbose Displays a more detailed progress report for the selected NetBackup
operation.
Refresh Updates the status display for the selected NetBackup operation.

Refresh is enabled when a NetBackup operation is selected from the
Operations List.

Print Opens the Microsoft Windows print dialog box and prints out the
progress report for the selected NetBackup operation.
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Progress Displays the progress of the selected operation. If the Refresh Rate
(seconds) parameter is set to 0, the user can click Refresh to view the
progress of the selected NetBackup operation. Select Verbose for a
more detailed progress report.

Each message begins with the time of the related event and an
acronym that indicates the nature of the message (see below).
Operation Status also lists all the media IDs used to store the data.

paT Informational messages that are helpful in debugging.
ERR Error message

FTL Fatal error message

iNF  Informational message (no error occurred)

TRV Trivial error message

WRN Warning error message

Note If the drive on which NetBackup is installed is full, no progress
messages are displayed except those indicating the job has been
initiated and the job has been completed.

Preview List Dialog Box

Use this dialog box to view all of the files, folders, or registry keys you have marked. This
is a view-only dialog box.

To access this dialog box:

& From the Edit menu, select Preview List of Marked Files. The Preview List dialog box
which appears depends upon whether the backup or restore window is the active
window.
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List of files to backup

Mame

C:ADirections’,

Help

List of files to restore

P

review List

x|

Mame

| Time Backed Lip | Time Madified |

C:hDirectionsWRecap ... 12/27/2001 20255 P 12/14/2001 1:51:34 PM

Lloze I Help

Name

Time
Up

Time Modified

Close

Help

Backed

When a Backup window is open, a list of the files or folders to be backed
up is displayed. When a Restore window is open, a list of the files or
folders to be restored is displayed.

Lists the time the backup was initiated.

Lists the time at which the backed up file or directory was changed.

Closes the dialog box. Close does not terminate NetBackup or affect
other dialog boxes or windows.

To view online help for this dialog box, click this button.
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Toolbar Options Dialog Box

Use this dialog box to control display options on the Backup, Archive, and Restore

interface.

Toolbar Options

v
V' Flat toolbars
™ Large buttons

.

o tool tps

Cancel |

To access this dialog box:

¢ On the View menu, click Toolbar Options.

Show toolbar
Show tool tips

Flat Toolbars

Large Buttons

OK
Cancel

Shows the NetBackup toolbars.

Shows tool tips. When the mouse pointer moves over the different
elements of the Backup, Archive, and Restore interface, the tool tips
appear.

When selected, the main (or horizontal) toolbar buttons are displayed
as two-dimensional buttons. If not selected, buttons are displayed as
three-dimensional buttons.

When selected, large button icons and text are shown on the toolbar
buttons. If not selected, only small icons are shown on the buttons.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.
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Backup Policy and Schedule Dialog Box

This section explains the tab in the Backup Policy and Schedule dialog box. To open this
dialog box, choose Specify Policy and Schedule from the Actions menu.

Backups Tab

Use this tab to specify a specific policy and schedule to use when you start a backup from
the client.

Backup Policy and Schedule x|

Backups |

Backup Policy:

=

Backup Schedule:
Iany

Archive Policy:
Iany

Archive Schedule:
Iany

QK I Cancel Help |

To access this tab:
1. Open a Backup window.

2. On the Actions menu, click Specify Policy and Schedule.

Backup Policy  Specify the policy to use for user-directed backups of this client. If you
set this value to “any” (which is the default), NetBackup uses the first
policy that it finds with both the client name and a user-directed
backup schedule.

Backup Schedule Specify the schedule to use for the user-directed backups for this
client. If you set this value to “any” (which is the default), NetBackup
uses the first user-directed backup schedule in the first policy that it
finds with both the client name and a user-directed backup schedule.
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Archive Policy

Archive
Schedule

OK
Cancel

Help

Specify the policy to use for user-directed archives of this client. If you
set this value to “any” (which is the default), NetBackup uses the first
policy that it finds with both the client name and a user-directed
archive schedule.

Specify the user-directed archive schedule to use for user-directed
archives of this client. If you set this value to “any” (which is the
default), NetBackup uses the first user-directed archive schedule in
the first policy that it finds with both the client name and a
user-directed archive schedule.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

Search Backups Dialog Box

Use this dialog box to narrow the backup history search parameters for a restore.

Search Backups

Search Folder:

|

¥ Perform case-insensitive search

Kepword Phraze [optional):

Start Date:

|12£2?£2DD1 9:02:55 Pt
End Date:

=

I‘I.-"I 5/2002 12:27:53 PM

Search I

Cancel |

=

Help |

Chapter 3, Reference

75 -



Dialog Boxes

To access this dialog box:

1. Open a Restore window.

2. From the Actions menu, click Search Backups.

Search Folder

Perform
case-insensitive
search

Keyword Phrase
(optional)

Start Date and
End Date

Search

Shows the folder or registry key for which you are searching. The
initial value for the Search Folder is “:\”. If you select a folder in the
NetBackup Restore window, that folder becomes the new default.

To change the path, enter a new value and press Return.

If you enter a full path name, NetBackup will search for the specific
path and file in the selected backup images. Or you can enter only the
filename (csb. tmp or * . tmp) and NetBackup will show, in the All
Folders pane, the folders where the specified files were found.

You can use these wildcard characters:

*

?

Tip Before initiating a search, collapse the tree in the All Folders
pane as much as possible. NetBackup will expand the tree to the
folders that match your search criteria.

Select Perform case-insensitive search to perform case-insensitive
searches.

The search path is case sensitive and must match what is in the
database on the NetBackup server. By default the checkbox is checked.

Enter a keyword phrase associated with a backup image.

View and select the Start Date and the End Date. The Start Date and
End Date show the range of backups that NetBackup will search. By
default, the start date will be the time of the last full backup and the
end date will be the time of the most recent backup.

To change the dates, click in the box and select from the list of
available backup images.

If you change the Start Date or End Date, NetBackup clears all the
restore selections that you have previously made.

Initiates a search for specified files, folders, or registry keys. The
NetBackup Restore window will show the folders that match the
search criteria.
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Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Specify Backup Options Dialog Box

Use this dialog box to view your selections before proceeding with the operation.

Specify Backup Dptions %i: %ﬂ
g Back up to MetBackup server: windows j

General Options |

Itemz marked to be backed up:

Mame |
C:\Program Files\WERITAS \MetB ackuptReadme_Client. tat

[~ Archive files [delete files after successful backup)

Eepword phraze to azzociate with the backup [optional]

Cancel | Help |

This dialog box displays after you have initiated a backup or archive by selecting Start
Backup of Marked Files from the Actions menu.

Back up to To change the NetBackup server that will perform the backup
NetBackup operation, select another server from the drop-down list.
Server
List box Contains a list of objects to be backed up.
Archive files Select this option to perform an archive instead of a backup. Files or
(delete files after folders will be deleted after they have been backed up successfully.
successful
backup)
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Keyword phrase
to associate with

Restore Marked Files Dialog Box

Restore Marked Files

Restore Marked Files

— Restare Destination Chaice
' Restore evenything to its original location

" Restore everything to a different location [maintaining existing structure):
Source;
IE:\Program Filez"WERITASYMetB ackuph

Destinatian:
IE:\Program Filez"WERITASYMetB ackuph

Browse... |

" Restore individual folders and files to different locations [double-click ta madify):

Source
C:\Program Files\YERITAS \MetB ackupiReadme_Client. tat

| [Drestination |

l | i

— Restore Option:
If the destination file already exists:
& Ovenwite the existing file
" Restore the file using a temporary filename
" Do not restore the file

Cancel

Help |

Specifies a keyword phrase, up to 128 characters in length, that
NetBackup will associate with the image created by this backup

the backup operation. You can then restore the image by specifying the keyword
phrase in the Search Backups dialog box.
All printable characters are permitted including period (“.”). The
default keyword phrase is the null (empty) string.

Start Backup Initiates the backup or archive operation.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

This dialog box appears after you have initiated a restore operation by selecting Start
Restore of Marked Files from the Actions menu.
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Use this dialog box to view your selections before proceeding with the operation. If the list
is longer than the list box, a vertical scroll bar appears along the right edge of the pane.

Restore
Destination
Choices

Restore
everything to
its original
folder

Restore
everythingtoa
different
location

Source

Destination

Browse

This pane contains radio buttons which determine the destination for
restored files. The user must choose one of the radio buttons in the
pane.

Restore files, folders, or registry keys to the folder from which they
were backed up. This is the default.

Enter the folder to which you want to redirect the files, folders, or
registry keys.

Enter the path from which the files, folders, or registry keys were
backed up. This field is enabled when the Restore everything to a
different location checkbox is selected.

Enter the path to which the files, folders, or registry keys will be
restored. This field is enabled when the Restore everything to a
different location checkbox is selected.

By default, the lowest level folder common to all the items being
restored appears in the Source box. If this is changed to a folder that
only contains some of the items, only those items will be restored to
the folder specified in the Destination box. All other items will be
restored to their original location.

This button is enabled when the Restore everything to a different
location checkbox is selected. Click this button to open the Browse for
Folder dialog box. You can then select a destination folder.

Note You will be browsing the local machine where the Backup, Archive, and
Restore interface is running, even if you are redirecting a restore to a
different client.
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Restore
individual
folders and
files to
different
locations

Restore Options

Overwrite the
existing file

Restore the
file using a
temporary
filename

Do not restore
the file

Start Restore
Cancel

Help

Restore files, folders, or registry keys to a different path on a file by
file, folder by folder, or registry key by registry key basis. The default
is to restore to the original path.

Select this option, then double-click on an item in the list, and the
Enter New Destination dialog box displays. In the new dialog box,
you can either manually enter a new destination path, or click the
Browse button to browse for a new destination path. If you click OK,
that path then displays in the Destination field of the list for that item.

The individual items you marked for restore display in the Restore
individual folders and files to different locations list box. If you
mark a folder to be restored, that folder name, not the individual files,
will appear in the list box. To be able to restore individual files to
different locations, files must be selected individually.

This pane contains radio buttons which specify how to restore files,
folders, or registry keys onto a system which may contain files,
folders, or registry keys with identical names. The user must choose
one of the radio buttons in the pane.

Overwrites existing files, folders, or registry keys. The default is to not
overwrite. In this mode, the restore does not occur if the files, folders,
or registry keys exist.

NetBackup will rename a file so as not to copy over an existing file.
NetBackup will restore the item to £ilenameXXXXXX . TMP, where
filename is the name of the file being restore and XXXXXX is
generated based on the current date and time. This option is only
valid when the restore has been requested by, and performed on, the
same machine. This option is not supported by server-directed
restores.

This is the default.

Initiates the restore operation.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.
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NetBackup Client Job Tracker Dialog Box

NetBackup Client Job Tracker’s purpose is to inform the user that a backup or restore is
being done on the client machine. The NetBackup Client Job Tracker gives an estimate of
the size of the job. It is not intended to replace the View Status dialog box available
through the Backup, Archive, and Restore interface or the Activity Monitor available
through the NetBackup Server.

Job Tracker only reports on the status of a backup, archive, or restore as it is running on
the client. Once a backup is sent to the NetBackup Server, it will not update the status of
that job. For example, the client sends all of the data to be backed up to the server
successfully. It reports the backup status as Successful. If at a later time an error occurs on
the server which causes the backup to fail, the status shown by the Job Tracker is not

updated.
NetBackup Client Job Tracker x|
Job 1D |f0|iD_1 011286463 Server Icarrot. null.com
Joh TypelBaCkUD StatuslSuccessfuI
Start Timne |1 A7/200210:55:16 &M End Time |1 742002 10:559:45 &M

Current Mame IE:\Program Files"VERITAS M etB ackupiReadme_Client. st

Current Size |8309 Bytes
—Actual
Filez |1 KBytes Data IS KBytes/Sec ID
Folders |4 KBytes Image |1 8
— Estimated
Filez |1 KBytes Data IS
Falders |4

To access the NetBackup Client Job Tracker dialog:

1. Start the NetBackup Client Job Tracker by pointing to Start, Programs, VERITAS
NetBackup, then choosing NetBackup Client Job Tracker.
When the NetBackup Client Job Tracker has been started, the NetBackup Client icon
displays in the system tray.

2. Right-click on the NetBackup Client icon in the system tray to display the Job Tracker
menu.
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3. Click the Start NetBackup Client Service menu option if it is available. If this menu
option is disabled, the Job Tracker service has already been started.

4. If the Details option is disabled, there have not been any backups or restores since the
NetBackup Job Tracker was started.

5. Perform either a backup or restore, then right-click on the NetBackup Client icon in
the system tray to display the Job Tracker menu, then choose the Details menu option
to display the NetBackup Client Job Tracker dialog box.

Once the NetBackup Client Job Tracker is started, it reports on server-directed operations,
scheduled operations, and user operations. When the NetBackup Client Job Tracker is
shut down, it “forgets” about the jobs it has been tracking (this includes logging off the

system).

Job ID
Server
Job Type

Status

Start Time
End Time
Current Name

Current Size

Actual
Files

Folders

KBytes Data

KBytes Image

KBytes/Sec
Estimated

Displays the NetBackup Job ID.
Displays the name of the server to which the file was backed up.

Shows the type of NetBackup operation for the selected job: backup,
archive or restore.

Displays the progress of the selected operation.
Displays the time the NetBackup operation started.
Displays the time the NetBackup operation stopped.

Displays the name of the file currently being backed up, archived, or
restored.

Displays the size (in bytes) of the file currently being backed up,
archived, or restored.

Displays the status of the NetBackup operation.

Displays the number of the files currently backed up, archived, or
restored.

Displays the number of folders backed up. A folder is counted each
time a file or sub folder contained in the folder is backed up.

Displays the amount of data, in kilobytes, currently backed up,
archived, or restored. This is rounded to the nearest whole number, so
it is possible this number may be 0 if the number of bytes being
backed up is less then 500.

Displays the current size, in kilobytes, of the image backed up or
archived.

Displays the rate of the NetBackup operation in kilobytes per second.
Displays an estimate of the finished NetBackup operation.
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Files

Folders

KBytes Data

OK
Previous

Next

Displays the total number of files to be processed by the NetBackup
operation.

Displays the number of folders being backed up. A folder is counted
each time a file or sub folder contained in the folder is backed up.

Displays the total amount of data, in kilobytes, to be processed by the
NetBackup operation. This is rounded to the nearest whole number,
so it is possible this number may be 0 if the number of bytes being
backed up is less then 500.

Closes the NetBackup Client Job Tracker dialog box.

Shows the operating status of the previous NetBackup operation in
the queue.

Shows the operating status of the next NetBackup operation in the
queue.
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This section contains information for the NetBackup Administrator.

Free Browse

The Free Browse feature allows users without restore privileges to restore from scheduled
backups. In previous versions of NetBackup, when a scheduled backup was performed by
a system administrator using a root user id, the client user was not able to restore from
that backup. The Free Browse feature allows the user to use a scheduled backup to restore
files. The user will be able to restore only those files to which they have write access.

There are three different settings: Use, Deny, and Allow.

& When the client is set to Use, the user will be allowed to browse scheduled backups if
the NetBackup server is set to Allow or Use.

& When the client is set to Deny, the user will not be allowed to browse backups no
matter how the NetBackup server is configured.

¢ When the client is set to Allow, the user will be able to browse scheduled backups if
the NetBackup server is set to Use.

The NetBackup master server setting is configured using the bpclient command.

Note By default, the NetBackup master server setting is set to Allow.

To set Use:

# bpclient <clientname> -free browse 2
To set Deny:

# bpclient <clientname> -free browse 1
To set Allow:

# bpclient <clientname> -free browse 0
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To verify the configuration:

# bpclient <clientnames> -1

The following table displays the different combinations.

NetBackup Client NetBackup

Server
Deny Deny
Deny Allow
Deny Use
Allow Deny
Allow Allow
Allow Use
Use Deny
Use Allow
Use Use

Use 'Free
Browse’

No
No
No
No
No
Yes
No
Yes

Yes

The Free Browse feature will only be used when either the NetBackup client or the
NetBackup server has been configured to Use it, and neither have been set to Deny it. By
default, all users get the Allow privilege.

In order to make use of the feature on the client, a registry key needs to be created for Use
and Deny using the Windows regedt32 . exe utility. A registery key does not need to be

set up for Allow, as Allow acts as the default.

1. Use the registry editor to create the following two keys.

’HKEY_LOCAL_MACHINE\
SOFTWARE\
VERITAS\
NetBackup\

CurrentVersion\

Security\

FreeBrowse\

and

’HKEY_LOCAL_MACHINE\
SOFTWARE\
VERITAS\
NetBackup\

CurrentVersion\
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Security\
FreeBrowse\

Deny’ .

2. Set the user share permissions on each key.

3. Enter a data value for each key with the name of Flag (type = DWORD). Only when a
key has a non-zero Flag value will that privilege be turned on. If both of the Flag
values are zero, then all users will get the Allow privilege.

For example:

Deny/Use Key Values and Privileges Given to User

Deny Key Use Key Deny Key Flag Use Key Flag Privilege
value value
Read access -- non-zero -- Deny
-- Read access -- non-zero Use
Read access Read access non-zero non-zero Use
Read access Read access non-zero zero Deny
No access No access -- -- Allow
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Redirecting a Restore to a Different Client

The administrator on the NetBackup master server can use the Backup, Archive, and
Restore interface on that server to direct a restore to any client of the same type that
backed up the files. However, it is not possible to perform a server-directed restore
through a database extension product such as NetBackup for Oracle.

Policy Type Settings

When redirecting from or to a different client, the source and destination clients must be
of same type. Refer to the table “Policy Settings for Clients” below to select the

appropriate policy type.

Policy Settings for Clients

Client Policy

UNIX Standard
Macintosh Standard
Microsoft Windows 98 or 95 Standard

Microsoft Windows NT/2000
NetWare Target
NetWare Non-Target

IBM OS/2 Warp

MS-Windows-NT

Standard

NetWare

0Ss/2

Restore Path Formats

When redirecting a restore to a different client, the appropriate path format must be used
when specifying the source and destination information. Refer to the table “Restore Path

Formats” below.
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Restore Path Formats

Client Path Format

Example

UNIX (from a Normal directory:\
Backup image)

UNIX (from a Backup Exec export_path\directory
image)

Macintosh folder/folder/

Microsoft Windows (from drive:\directory\
a Normal Backup image)

Microsoft Windows (from \NT_share_name\directory\

a Backup Exec image)
NetWare NonTarget drive:\directory\
NetWare Target

IBM OS/2 drive:\directory

/target/volume/data_path

usr:\openv\netbackup\

exported_path\netbackup

(where exported_path is defined in the
agent.cfg file)

NetBackup Admin/Configuration Files
Dist/

c:\Veritas\NetBackup\

\C$\VERITAS\NetBackup

c:\Veritas\NetBackup\
/SYS/MARGE/ veritas/netbackup/

c:\veritas\netbackup

Redirecting a Restore from a Backup Exec Image

When restoring a group of files from both Backup Exec and NetBackup images,
redirection is not allowed. Redirecting a restore from a Backup Exec image must be done
separately. Within the Backup Exec image, individual files cannot be restored to different
paths. All of the files in the image must be redirected to the same path.

The following types of restores are allowed when redirecting a restore from a Backup Exec

image:

& Redirecting a Restore to a Windows Client

Backups of a Windows , UNIX, or NetWare client can be restored to a Windows client

using the following redirection path:

\share name\dirl

For example, if you wanted to redirect a restore to C: \ temp, and the sharename for
the drive C: is C$, then the path should be specified as \C$\ temp.
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Note When restoring a NetWare client backup to a Windows client, the NetBackup
Windows client interface (nbwin . exe), or the NetBackup Java interface, the
bprestore command should be used. The NetBackup Windows NetWare client
(nbnwnt . exe) should NOT be used to restore NetWare client backups to Windows
clients.

¢ Redirecting a Restore to a UNIX Client

Backups of a Windows, UNIX, or NetWare client can be restored to a UNIX client
using the following redirection path:

export path\dirl

where export path is defined in the agent . cfg file on the UNIX client. The
agent . cfgfile is a Backup Exec configuration file for the Backup Exec UNIX client.
Files can be redirected and restored only to paths that have been exported in the
agent .cfgfile.

For example, if the agent . cfg file on the UNIX client contains the following lines:

export/space/home as space_ home
export/homel as homel

To redirect to /space/home/dirl the redirection path should be specified as
space _home/dirl. To redirect to /homel/dir1l the redirection path should be
specified as homel/dirl/

Note When restoring a NetWare client backup to a UNIX client, the NetBackup Windows
client interface (nbwin. exe) should be used. To restore a Backup Exec image to a
NetWare client, the NetWare client must also be a NetBackup NetWare client. Refer
to the NetBackup User’s Guide for Novell NetWare NonTarget for information on
restoring NetWare backups to NetWare clients.

& Redirecting a Restore to a NetWare Client

When restoring a NetWare client backup to a NetWare client, the NetBackup
Windows NetWare client interface (nbnwnt . exe) should be used. To restore a
Backup Exec image to a NetWare client, the NetWare client must also be a NetBackup
NetWare client. Refer to the NetBackup User’s Guide for Novell NetWare NonTarget for
information on restoring NetWare backups to NetWare clients.
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¥ Torestore files to a different client (server-directed restore):
1. Log on to the master server as administrator.
2. Start the NetBackup Administration Console.

5 - MetBackup Administration Conzole

File Edit Miew Action: Help

ENEEIE A

i VERITAS
Activity Monitor NetB ackupm B usin GSSQ rver™
MetBackup Management —
Reparts ma Getting Started
@ Palicies ‘54 Get step-by-step help setting up MetB ackup.
Storage Units

g Catalog Configure Storage Devices
Host Properties

Media and Device Management
@ Device Monitar

B Media

Devices

Defing robots and drives.

Configure Yolumes
Inventary robots and define volumes for uze in standalone drives.

Configure the Catalog Backup
Specify how and when MetBackup configuration and catalog information is to be backed up.

Create a Backup Policy
Define schedules for backing up data on a single client or a et of clients.

TR

- Import Images
Thiz wizard will assizt you in stepping through an import.

th,

For Help, press F1 [Master Server: tyche |Cormected 2

3. On the File menu, click Backup, Archive, and Restore.

The Backup, Archive, and Restore interface opens.

4. On the File menu, point to Select Files and Folders to Restore and click on the type of
restore desired from those listed.
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The Restore window displays.

ackup, Archive, and Restore - NetBackup - [Restore: Server: sasweed Source Client: saswe - |EI|5|
File Edit Yiew Actions Window Help = x|

_@SBIectFDrBach | 3, Select For Restore v| \u'iew Status | @

ﬁ MetBackup History
—_— 200z
Jan
— 15
i [
‘{E All Folders Contents of ‘sasweed’
=] D sasweed Narme I Time Backed Up |
sd=c OS¢ 11512002 3:53:20 PM
B 0 swap
Ready

5. On the File menu, click Specify NetBackup Machines.

Specify NetBackup Machines ﬂ

Servers | Source Clients/Palicy Type I Destination Clients I

Mew Server Mame:

Server List:

sl

zazweed[CURRENT]
silk.

hagar

hartstongue

zephir

windows

carrat

Femove | MakeEunentl

o]

Cancel | Help |

6. On the Servers tab, select the server that you are using and click Make Current. In
this example, sasweed was selected.
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7. Click on the Source Clients\Policy Type tab.

specify NetBackup Machines
Servers  Source Clients/Policy Tupe | Destination Clients |

Mew Client Mame:

Client List:

windows[CLURRENT]

sasweed
falip

v Use this client list for future backup and restone windows

Policy Type:

Iake Current |

[ M3-Windows-NT

~

Cancel |

Help |

Select the client whose backup image you are going to restore files from and click

Make Current. In this example, windows was selected.

8. Select the Destination Clients tab.

Specify NetBackup Machines

Servers I Source Clients/Policy Type  Destination Clients |

Mew Client Marne:

Select the policy type for the images that you are going to browse. Refer to the
Table, “Policy Settings for Clients’

’ on page 88.

Client List:

folipCURREMT]

zasweed

I ake Current |

Cancel

Help |
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e. Select the client to which you are going to restore the files and click Make
Current. In this example, folip was selected.

f. Click OK.
9. Inthe NetBackup Restore window, select the files for restore.
10. On the Actions menu, click Start Restore of Marked Files.

11. Select the desired option from the Restore Destination Choices.

For more information on redirecting restores to different paths, see “Redirecting Files
to a Different Path” on page 29.

The paths in the Source and Destination boxes must use the formats required by the
clients as shown in the table “Restore Path Formats” on page 89.

In this example, we are restoring a file from one Windows client (windows) to another
Windows client (folip) and specifying the path where the files will go on folip.

Restore Marked Files x|

Restore Marked Files |

— Restore Destination Choice
' Restore everything to its original location

” Restore everything to a different location [maintaining existing structure):
Source:
IE:\Program Filez"WERITASYMetB ackup'

D estination:
IC:\F‘rogram Filez"WERITAS WM etB ackuph. Browse,.. |
" Restore individual folders and files to different locations (double-click to modify):
Source | D estination I Tirrn
C:\Program Files\W'ERITAS \MelB ackup\Readme_Server.tst 147
4 | i
r— Festore Option:

If the destination file already exists:

€ Dvenwite the existing file

” Restore the file using a temporary flename
% Do not restore the file

Cancel | Help

12. Select the desired restore option.

For more information on restoring to a temporary file, see “Restoring Using a
Temporary Filename” on page 33.

13. Click Start Restore.
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Preventing Server-Directed Restores

To prevent server-directed restores, either add or delete settings on the client as specified
in the table below.

Client Type Location of Setting To Prevent
Server-directed
Restores

Microsoft Windows General tab in NetBackup Client Properties Clear Allow

dialog box on the client (click NetBackup Client server-directed restores
Properties on the File menu to display this dialog box

box)
UNIX /usr/openv/netbackup/bin/bp.conf Add
DISALLOW_ SERVER
FILE WRITES
Macintosh /NetBackup Admin/Configuration Files Add
Dist/bp.conf DISALLOW SERVER
FILE WRITES
NetWare General tab in NetBackup Configuration dialog Clear Allow
(Target and Non-Target) box on the client (click Configure on the Actions server-directed restores
menu to display this dialog box) box
IBM OS/2 c:\veritas\netbackup\bp.ini Delete
Allow_Server
Write
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Specify NetBackup Machines Dialog Box for System
Administrators
When the current window is a Restore window and the Specify NetBackup Machines
dialog is opened on a NetBackup server, the following tabs are available:
& Servers
& Source Clients/Policy Type

& Destination Clients

Servers Tab

Refer to “Servers Tab” on page 65 for more information.

Source Clients/Policy Type Tab

Use this tab to select the client whose backups you want to restore. Files or folders that
were backed up or archived from one NetBackup client can be restored to a different
NetBackup client. This is called a redirected restore to a different client.

Specify NetBackup Machines ﬂ
Servers  Source Clients/Policy Type | Destination Clients |

Mew Client Mame:

Client List:
windowsCLURBENT]
sasweed

folip

Iake Current |
¥ Use this client list for future backup and restore windows
Policy Type:
| MS-Windows-NT 4|

Cancel Help |
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To access this dialog box:
1. Make a Restore window active.
2. On the File menu, click Specify NetBackup Machines.

3. Click the Source Clients/Policy Type tab.

Notes:

& The NetBackup master server must be configured to allow restores to be redirected to
different clients. (Refer to the section on server-directed restores in the NetBackup
System Administrator’s Guide for UNIX or the NetBackup System Administrator’s Guide
for Windows for details.)

& For information on file permissions required, see “File Permissions Required By
NetBackup” on page 6.

New Client To add another client name to the Client List, type the name of the
Name client in the New Client Name box and click Add. The client name
entered must also be defined in a policy on the NetBackup server.

If a new client is added to the list it will be in the client list for all
windows currently opened and any new window that is opened. The
new client will be saved in the Client List box after the current
window is closed.

Add Adds the client entered in the New Client Name box to the Client
List.
Client List The Client List shows the names of the NetBackup clients that your

client can access. To change the name of the client whose backups you
can browse for files to restore, select a name from the Client List and
click Make Current. The word CURRENT displays in parentheses
beside the name of the new source client.

Make Current Designates the client backup images you can browse for restore
operations. First highlight the client in the Client List, then click
Make Current. Changing the current client will affect only the
selected window. This setting will not be saved after the currently
selected window is closed.

Use this client If selected, NetBackup applies any changes to the client list to all

list for future backup and restore windows opened after the tab modifications have
backup and been saved.

restore windows
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Policy Type View and select a policy type for the client selected in the Client List.
The policy type must be the same as specified for the client in the
NetBackup configuration on the NetBackup server.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Destination Clients Tab

Use this tab to select the client which will receive the restored backups. Restoring files to
another client is a type of server-directed restore.

Specify NetBackup Machines ﬂ

Servers I Source Clients/Policy Type  Destination Clients |

Mew Client Mame:

Llient List:

FATWEEL

Iake Current |

Cancel | Help |

To access this dialog box:
1. Make a Restore window active.
2. On the File menu, click Specify NetBackup Machines.

3. Select the Destination Clients tab.
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Notes:

¢ The NetBackup master server must be configured to allow restores to be redirected to
different clients. (Refer to the section on server-directed restores in the NetBackup
System Administrator’s Guide for UNIX or the NetBackup System Administrator’s Guide
for Windows for details.)

¢ For information on file permissions required, see “File Permissions Required By
NetBackup” on page 6.

& Aclient can prohibit server-directed restores by clearing the Allow server-directed
restores option on the General tab in the NetBackup Client Properties dialog box.
See “General Tab” on page 61.

New Client To add another client name to the Client List, type the name of the

Name client in the New Client Name box and click Add. The client name
entered must also be defined in a policy on the NetBackup server. If a
new client is added to the list it will be in the client list for all windows
currently opened and any new window that is opened. The new client
will be saved in the Client List box after the current windowv is closed.

Add Adds the client entered in the New Client Name box to the Client
List.
Client List The Client List shows the names of the NetBackup clients that your

client can access. To change the name of the client whose backups you
can browse for files to restore, select a name from the Client List and
click Make Current. The word CURRENT displays in parentheses
beside the name of the new source client.

Make Current Designates the client that will receive the restore operations. First
highlight the server in the Client List, then click Make Current.
Changing the current client will affect only the selected window. This
setting will not be saved after the currently selected window is closed.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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NetBackup Client Properties Dialog Box

This section contains information on the NetBackup Client Properties dialog box for the
system administrator.

Configuration information is kept in the registry key
\HKEY LOCAL MACHINE\Software\VERITAS\NetBackup
\CurrentVersion\Config.

General Tab

Use this tab to set any of the configuration parameters for your client.

NetBackup Client Properties x|

General |Exclude ListI Include List ﬁackupsl ﬂetworkl lroubleshootingl

Client name:

|m:

List files timeout: Bestore retries:

300 3 seconds =

Time overlap: User-directed operation timeout:

IBD _|::' minutes IBD _|::' seconds

Keep statug of user-directed backups,
archives, and restores for:

|3 _,::' days

v Peform incrementals based on archive bit
V' Allow server-diected restores

[+ Perform default search

QK I Cancel Help |

To access this tab:
1. Onthe File menu, click NetBackup Client Properties.

2. Click the General tab.

Client name This parameter should be changed only by a system administrator.
Specify the NetBackup client name of your client. This name is used
when backing up, archiving and restoring files, folders, or registry
keys. The client name in the NetBackup server policy configuration
must match the client name specified here.

~ 100 NetBackup User’s Guide - Microsoft Windows



NetBackup Client Properties Dialog Box

List files timeout This parameter should be changed only by a system administrator.
Specify the number of seconds to wait for a response from the
NetBackup master server when listing files. If this amount of time is
exceeded, the user receives the “socket read failed” error even if the
server is still processing the user’s request.

The default is 300 seconds. The minimum setting is 0. The maximum
setting is 36,000 seconds.

Restore retries  This parameter should be changed only by a system administrator.
Specify the number of times to retry a restore after a failure.

The default is 0, which is no retries. The maximum setting is 999.

Time overlap This parameter should be changed only by a system administrator.
Specify the extra number of minutes to add to the date range for
incremental backups when using date-based backups. This value can
be used to compensate for differences in the speed of the clock
between the client and NetBackup server.

The default is 60 minutes. The minimum setting is 0. The maximum
setting is 1,440 minutes.

User-directed Specify the number of seconds to wait for a response from the
operation NetBackup master server when performing user-directed operations.
timeout If this amount of time is exceeded, the user receives the “socket read

failed” error even if the server is still processing the user’s request.

The default is 60 seconds. The minimum setting is 0. The maximum
setting is 32,400 seconds.

Keep status of Specify the number of days to store progress reports before the system
user-directed will automatically delete them.

backups,
archives, and
restores for

Default is 3 days. The minimum allowable value is 0. The maximum is
9,999.
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Perform
incrementals
based on archive
bit

Allow
server-directed
restores

Perform default
search

OK
Cancel

Help

This parameter should be changed only by a system administrator.
Select this check box to have NetBackup include files in an
incremental backup only if their archive bit is set. The system sets this
bit whenever a file is changed and it will remain set until NetBackup
clears it. A full backup always clears the archive bit. A
differential-incremental backup clears the archive bit if all files are
successfully backed up within the number of seconds indicated by the
Clear Archive Bit Incr Wait parameter. A
cumulative-incremental backup or user backup has no effect on the
archive bit.

Clear this checkbox to have NetBackup include a file in an
incremental backup only if the file’s datetime stamp has been changed
since the last backup. For a cumulative-incremental backup,
NetBackup compares the file’s time stamp against the last full backup.
For a differential-incremental backup, NetBackup compares the time
stamp against the last full backup or incremental backup.

If you install or copy files from another computer, the new files retain
the datetime stamp of the originals. If the original date is before the
last backup date on this computer, then the new files will not be
backed up until the next full backup, whichever is most recent.
Windows 95/98 and Windows NT/2000 clients use the create and
modify datetime stamp.

This parameter should be changed only by a system administrator.
Select this check box to let the administrator on the NetBackup server
initiate restores to this client. The default is to allow server-directed
restores.

If selected, NetBackup will automatically search the default range of
backup images and display the backed up folders and files whenever
a restore window is opened.

Clear this box to disable the initial search. The NetBackup Restore
window will not show any files or folders when initially opened.
Clicking a backup image, or selecting a range of backup images, will
initiate a search.

By default, this box is selected.
To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.
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Exclude List Tab

Use this tab to view and change the list of files to exclude from a master server directed
backup. For example, if you add C:\ *.bat to the Exclude File List, all files with a .bat
extension that appear in the root of the C: drive will not be backed up. Exclude lists only
apply to full backups, cumulative-incremental backups, and differential-incremental
backups initiated by the NetBackup server. Refer to “Syntax Rules for Exclude and
Include Lists” on page 111 for more details.

Exclude lists can be created for specific policies and schedules. The first exclude list has
the policy and schedule disabled. The list cannot be deleted, but it can be empty.

Note Only the system administrator should change the parameters on this tab.

NetBackup Client Properties x|

General Exclude List |1nclude List ﬁackupsl ﬂetworkl lroubleshootingl

Policy: I
Schedule: I
Exclude File: I
Add |
Exclude File List:
Eemove |
Mew List | Delete List | <<Erevi0us| et 2 |
QK I Cancel | Help |

To access this tab:
1. On the File menu, click NetBackup Client Properties.

2. Click the Exclude List tab.

Policy The Exclude File List applies only to server-directed backups for the
specified policy. To create an exclude list with a different policy and
schedule combination, click the New List button.

Schedule The Exclude File List applies only to server-directed backups for the
specified schedule. This requires that a policy be specified. To create
an exclude list with a different policy and schedule combination, click
the New List button.
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Exclude File

Add
Exclude File List

Remove
New List

Delete List
Previous
Next

OK

Cancel

Help

Enter the file or folder that you want to exclude in the list box. Click
Add to move the file or folder to the Exclude File List.

The exclude list is case sensitive unless the
case_sensitive exclude list datavalue inthe registry issetto
no.

Click this button to add a file or folder to the Exclude File List.

The file list applies only to scheduled backups. It shows the names of
the files that will be excluded in a scheduled backup. To remove a file
from the list, select the name and click Remove.

Click this button to remove a selected file or folder from the file list.

Use this button to create a new list with a policy and schedule.
Duplicates of policy and schedule are not allowed.

Use this button to delete the current list.

Use this button to view the previous list.

Use this button to view the next list.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

Include List Tab

Use this tab to make exceptions to the list of files that are excluded from a server-directed
backup (those files listed in the Exclude List). For example, if you want to exclude all files
with a .bat extension except the autoexec . bat file from backups, you would add

* bat to the Exclude File List and autoexec .bat to the Include File List. Include lists
only apply to backups initiated by the NetBackup master server. Refer to “Syntax Rules
for Exclude and Include Lists” on page 111 for details.
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Include lists can be created for specific policies and schedules. The first include list has the
policy and schedule disabled. The list cannot be deleted, but it can be empty.

NetBackup Client Properties x|

ﬁenerall Exclude List  Include List |ﬁackups| ﬂetworkl lroubleshootingl

Policy: I
Schedule: I
Include File: I
Add |
Include File List:
Eemove |
Mew List | Delete List | <<Erevi0us| et 2 |
QK I Cancel | Help |

Note Only the system administrator should change the parameters on this tab.

To access this tab:
1. On the File menu, click NetBackup Client Properties.

2. Click the Include List tab.

Policy Enter the name of the policy. The name must match the policy name
on the master server. To create an include list with a different policy
and schedule combination, click the New List button.

The Include File List applies only to server-directed backups for the
specified policy.

Schedule Enter the name of the schedule. The name must match the schedule
name on the master server. To create an include list with a different
policy and schedule combination, click the New List button.

The Include File List applies only to server-directed backups for the
specified schedule. This requires that a policy be specified.
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Include File

Add
Include File List

Remove
New List

Delete List
Previous
Next

OK

Cancel

Help

Backups Tab

Enter the file or folder that you want to include in the list box. Click
Add to move the file or folder to the Include File List.

The include list is case sensitive unless the
case_sensitive exclude list datavalue inthe registry issetto
no.

Click this button to add a file or folder to the Include File List.

The file list applies only to scheduled backups. It shows the names of
the files that will be included in a scheduled backup. To remove a file
from the list, select the name and click Remove.

Click this button to remove a selected file or folder from the file list.

Use this button to create a new list with a policy and schedule.
Duplicates of policy and schedule are not allowed.

Use this button to delete the current list.

Use this button to view the previous list.

Use this button to view the next list.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

For information on this tab, see “Backups Tab” on page 63.
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Network Tab

Use this tab to view and change the port numbers used during communications between
your client and the NetBackup master server.

NetBackup Client Properties x|
General I Exclude List I Include List | Backups  MNetwork | Troubleshooting I
MetBackup Client Service Port:

I‘I a7e2 _Ij

MetBackup Bequest Service Port:

I‘I 3720 _Ij

Cancel | Help |

Note Only the system administrator should change the parameters on this tab.

To access this tab:
1. Onthe File menu, click NetBackup Client Properties.

2. Click the Network tab.

NetBackup Specify the port the NetBackup server uses to communicate with the
Client Service NetBackup client.

Port The default is 13782,

NetBackup Specify the port to which the client should send requests to the
Request Service NetBackup request service, bprd, on the NetBackup server.

Port The default is 13720.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Troubleshooting Tab

Use this tab to view and change the amount of information that NetBackup saves in its
debug/troubleshooting logs. NetBackup only creates log files if the log folders are
created. See “Troubleshooting Logs” on page 110 for more details. Also see the NetBackup
Troubleshooting Guide for UNIX or the NetBackup Troubleshooting Guide for Windows for
information on using these logs.

MNetBackup Client Properties ll

ﬁenerall Exclude ListI Include ListI ﬁackupsl Metwork  Troubleshooting |

— Debug Level
General: ICF:
P = [ =
Werbose: Elush
P = P =

Databaze:

b=

Eancell Help |

Note Only the system administrator should change the parameters on this tab.

To access this tab:

1. Onthe File menu, click NetBackup Client Properties.

2. Click the Troubleshooting tab.

General Controls the amount of information that NetBackup writes to the

troubleshooting logs. Supported values are 0, 1, or 2. The higher the
level, the more information that is written. The default is 0.
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Verbose Verbose controls the amount of information that the NetBackup
Windows NT server writes to its logs. This parameter is only in effect
when the local machine (where the NetBackup client is being run) is
also a NetBackup Windows NT server.

Supported values are:
0 No extra logging. This is the default.
1- 99 Verbose logging.

Use the default setting of 0 unless advised otherwise by VERITAS
Technical Support.

TCP Enables TCP debugging. Supported values are:
0 No extra logging. This is the default.
1 Log basic TCP/IP functions.
2 Log all TCP/IP functions, including all read and write requests.
3 Log contents of each read/write buffer.

Note: Setting TCP to 2 or 3 can cause the status reports to be very
large. It can also slow the performance of a backup or restore
operation.

Flush NetBackup periodically flushes the progress reports on NetBackup
operations. This setting specifies the frequency of the flushes or how
often the internal buffer gets written to the progress report. The higher
the flush level, the more often the buffer is written to the file.
Supported values are 0, 1 or 2. The default is 0.

Database Controls the amount of information the NetBackup Database
Extensions write to their log files.

Supported values are 0 through 9. The higher the level, the more
information is written. The default is 0.

OK To accept changes to the parameters, click this button.
Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.
Help To view online help for this dialog box, click this button.
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Troubleshooting Logs

NetBackup will generate troubleshooting logs only if you create the following folders on
your client.

Windows NT/2000
(This assumes that your install directory is C: \Program Files\VERITAS)

C:\
\Program Files
\VERITAS
\NetBackup
\logs
\BPBKAR
\BPCD
\BPINETD
\NBWIN
\TAR

Windows 95/98
(This assumes that your install directory is C: \Program Files\VERITAS)

C:\
\Program Files
\VERITAS
\NetBackup
\logs
\BPCD
\NBWIN

All log files use the format yymmdd . LOG.

BPBKAR Log files in this folder contain information about user-directed and
server-directed backups.

BPCD Log files in this folder have information useful for troubleshooting
communications between your NetBackup client and the NetBackup
server.

BPINETD Log files in this folder have information on the NetBackup Client
Service operation.

NBWIN Log files in this folder have information on user operations.

TAR Log files in this folder contain information about user-directed and

server-directed restores.
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Note If you use Notepad to view the log files, the file will appear as one long line.
Wordpad recognizes the line breaks and properly displays the lines.

Syntax Rules for Exclude and Include Lists

Syntax Rules

The following syntax rules apply to exclude lists and include lists.
¢ Only one pattern per line is allowed.

& The following meta or wildcard characters are recognized:

[]
2

*

& To use the wildcard characters literally (that is, as non wildcard characters), precede
them with a backslash (\). For example, assume that the brackets in the following
example are not being used as wildcards:

\home\abc\fun [ny [name

In your exclude list, precede the brackets with a backslash as in
\home\abc\fun\ [ny\ [name

to have NetBackup interpret the brackets literally.

Note Note that a backslash (\) acts as an escape character only when it precedes a
wildcard as in the above example. This means that NetBackup normally interprets a
backslash literally and it is a legal character to use in pathnames.

& Spaces are considered legal characters. Be careful to omit extra spaces unless they are
part of the file name.

For example, if you want to exclude a file named
C:\home\testfile (with no extra space character at the end)
and your exclude list entry is
C:\home\testfile (with an extra space character at the end)

NetBackup will not be able to find the file until you delete the extra space from the
end of the file name.
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¢ End afile path with \ to exclude only folders with that path name (for example,
C:\home\test\). If the pattern does not end in \ (for example, C:\usr\test)
NetBackup excludes both files and folders with that path name.

& To exclude all files with a given name, regardless of their folder path, just enter the
name without a preceding slash. For example:

test
rather than
C:\test
This is equivalent to prefixing the file pattern with
C:\
C:\*\
C:\*\*\
CaA*\*\*\
and so on.

Example of an Exclude List

If an exclude list has the following entries:
C:\home\doe\john
C:\home\doe\abc\
C:\home\*\test
C:\*\temp
temp
the following are excluded from server-directed backups:
& The file or folder named C: \home\doe\john.
& The folder C: \home\doe\abc (because the exclude entry ends with \).
& All files or folders named test that are two levels below home.
& Allfiles or folders named temp that are two levels below the root.
2

All files or folders named temp at any level.
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User-Directed Archive Operations (NTFS5 and later)

Mount Points

NetBackup will not enter mount points encountered in an archive operation. Instead, the
mount point will be unmounted and the then empty folder deleted. If an archive
operation starts inside a mounted volume (not at the root), the target items will be
removed.

For example, assume that a file structure exists as follows: Mount Point is a volume
mount point and d2 and is an object in the mounted volume.

c:\d1l\MountPoint\d2
Depending on what is archived, the following may occur:

¢ Archiving c¢:\d1 results in an unmount of Mount Point and its removal, along with
any other objects in ¢: \d1. Nothing in the mounted volume is deleted.

¢ Archiving c:\d1\MountPoint\d2 results in the deletion of
c:\d1\MountPoint\d2 and any non-mount point children of d2.

Single Instance Store (SIS)

NetBackup will not delete any items in the Common Store for Single Instance Store
volumes. If requested, links can be deleted, and the SIS manager will determine whether
or not to delete corresponding Common Store items.
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This section describes man pages specific to the NetBackup product.
The following are special conventions used in the command descriptions.
¢ Brackets [ ] mean that the enclosed command line component is optional.

& A vertical bar (or pipe) symbol | separates optional arguments from which the user
can choose. For example, assume that a command has the following format:

command [argl | arg2]
Here, the user can choose either argl or arg2 (but not both).

& Italics indicate that the information is user supplied. For example, the user supplies
policy, schedule, and filename in the following command:

bpbackup -p policy -s schedule filename

¢ Anellipses (...) means that you can repeat the previous parameter. For example,
consider the following command:

bpbackup [-S master_server [[master_server,...]] filename

Here, the - S option requires the first master server name. Additional names can be
added, separated by commas and followed by a file name as in:

bpbackup -Smars, coyote, shark,minnow memofile.doc
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bparchive(1)

bparchive(l)

NAME

bparchive - Archivefilesto the NetBackup server

SYNOPSIS

/usr/openv/netbackup/bin/bparchive [-p policy]l [-s schedule] [-S
master_server [, master_server,...]1]1 [-t policy_type] I[-L
progress log [-enl]] [-w [hh:mm:ss]] [-help] [-k
"keyword_phrase"] -f listfile | filenames

DESCRIPTION

bparchive processes files that you list on the command line or in the file you specify
with the - £ listfile option. Any file path entered can be a file or directory name. If the list of
files includes a directory, bparchive archives all files and subdirectories of that directory
starting at the directory itself.

By default, you are returned to the system prompt after bparchive is successfully
submitted. The command works in the background and does not return completion status
directly to you. The -w option lets you change this behavior so bparchive works in the
foreground and returns completion status after a specified time period.

bparchive writes its informative and error messages to a progress-log file. You must
create this file prior to running the bparchive command and then specify it with the -L
progress_log option. If bparchive cannot archive any of the requested files or
directories, you can use the progress log to determine the reason for the failure.

If you create a /usr/openv/netbackup/logs/bparchive/ directory with
public-write access, bparchive creates an debug log file in this directory that you can
use for troubleshooting.

In addition, if a nonroot user specifies USEMAIL = mail_address in their

$HOME /bp . conf file or a root user specifies it in the
/usr/openv/netbackup/bp.conf file, NetBackup sends mail on the archive
completion status to mail_address. This message is sent when the archive process is
complete.

The following restrictions apply to this command:

& Toarchive a file with the bparchive command, you must be either root or the owner
and a member of the primary group (as owner) to delete the file. Also, the file must
not be read-only. Otherwise, NetBackup saves the files but cannot reset their access
time (utime) and does not delete them from the disk.

¢ If you specify a UNIX file that is a link, bparchive archives only the link itself, not
the file to which it links.
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¢ bparchive does not archive the "." or ".." directory entries, and also does not archive
raw partitions.

OPTIONS

-p policy Namesthe policy to use for the user archive. If it is not specified, the NetBackup
server uses the first policy it finds that includes the client and a user archive
schedule.

-s schedule
Names the schedule to use for the user archive. If it is not specified, the
NetBackup server uses the first user archive schedule it findsin the policy it is
using (see the -p option).

-S master_server [, master_server,. . .]
Specifies the name of the NetBackup master server. The default isthe first
SERVER entry inthe /usr/openv/netbackup/bp . conf file

-t policy_type
Specifies one of the following numbers corresponding to the policy type. The
default for NT clientsis 13, for Apollo workstations the default is 3, and for
Netware clients the default is 10. The default for all othersis 0:

0 = Standard

4 = Oracle

6 = Informix-On-BAR
7 = Sybase

13 = MS-Windows-NT
14 =052

15 = MS-SQL-Server
16 = MS-Exchange-Server
19 =NDMP

Note The following policy types apply only to NetBackup DataCenter.

3 = Apollo-whak

11 = DataTools-SQL-BackTrack
17 =SAP

18 =DB2

20 = FlashBackup
21 = Split-Mirror
22 = AFS
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-L progress_log [-en]

Specifies the name of an existing file in which to write progress information. The
file name must begin with /.

For example: /home/tlc/proglog.

The default is to not use a progress log.

Include the -en option to generate alog in English. The name of the log will
contain thestring _en. Thisoption is useful to support personnel assisting in a
distributed environment where differing locales may create logs of various
languages.

-w [hh:mm:ss]

-help

Causes NetBackup to wait for a compl etion status from the server before
returning you to the system prompt.
The date and time format depend on the user'slocale. See NOTES.
You can optionally specify await time in hours, minutes, and seconds. The
maximum wait time you can specify is 23:59:59. If the wait time expires before
the archive is complete, the command exits with atimeout status. The archive,
however, still completes on the server.

If you use -w without specifying the wait time or if you specify avalue of 0,
NetBackup waits indefinitely for the completion status.

Prints acommand line usage message when -help isthe only option on the
command line.

-k keyword_phrase

-f

listfile

Specifies akeyword phrase that NetBackup associates with the image created by
this archive operation. You can then restore the image by specifying the keyword
phrase with the -k option on the bprestore command.

The keyword phrase is atextual description of the archive that is a maximum of
128 charactersin length. All printable characters are permitted including space
(" ") and period ("."). Enclose the phrase in double quotes ("...") or single quotes
(‘...") to avoid conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.
Specifies afile (listfile) containing alist of files to be archived and can be used
instead of the filenames option. In listfile, place each file path on a separate line.

The format required for the file list depends on whether the files have spaces or
newlinesin the names.

To archivefilesthat do not have spaces or newlinesin the names, use this format:
filepath

Where filepath is the path to the file you are archiving. For example:

/home

/etc
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/var
To archive files that have spaces or newlines in the names, use this format:
filepathlen filepath

Where filepath is the path to the file you are archiving and filepathlen is the
number of charactersin the file path.

For example:

5 /home

4 Jetc

4 /var

19 /home/abc/test file

filenames
Names one or more filesto be archived and can be used instead of the - £ option.

Any filesthat you specify must be listed at the end, after all other options.
For Apollo clients, specify absolute file paths (Apollo clients are supported only

by NetBackup DataCenter master servers).
NOTES

The format that you must use for date and time values in NetBackup commands varies
according to the locale setting.

If you are uncertain of the NetBackup command requirements for your locale, enter the
command with the -help option and check the usage. The following is part of the
bparchive usage statement output that shows the -w option:

[-w [hh:mm:ss]

Notice the hours:minutes:seconds requirements. These are for a locale setting of C and can
be different for other locales.

For more information on locale, see the 1ocale (1) man page for your system.

EXAMPLES
¢ Example 1
To archive a single file, enter:
bparchive /usr/userl/filel
¢ Example 2
To archive files listed in a file named archive list,enter:
bparchive -f archive list

¢ Example 3
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To associate the keyword phrase “Archive My Home Directory 02/02/02” to the
archive of the directory /home/kwc and use a progress log named
/home/kwc/arch.log enter the following (the backslash continues the command as
if it were on one line):

bparchive -k "Archive My Home Directory 02/02/02" \
-L /home/kwc/arch.log /home/kwc

FILES
SHOME /bp . conf

/usr/openv/netbackup/logs/bparchive/log. mmddyy

SEE ALSO
bp (1), bpbackup(1),bplist (1), bprestore (1)
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NAME
bpbackup - Back up files to the NetBackup server

SYNOPSIS

/usr/openv/netbackup/bin/bpbackup [-p policy] [-s schedule] [-S
master_server [, master_server,...]1]1 [-t policy_type]l I[-L
progress log [-enl]] [-w [hh:mm:ss]] [-help] [-k
"keyword_phrase"] -f listfile | filenames

/usr/openv/netbackup/bin/bpbackup -p policy -i [-h hostname] [-s
schedule] [-s master_server [, master_server,...]11 [-t
policy_typel [-w [hh:mm:ss]] [-k "keyword_phrase"]

DESCRIPTION
bpbackup starts either of the following processes:
On clients

Using the first form of the command above, bpbackup starts a user backup that is the
equivalent to what is performed by using the interface on the client. This type of backup
can be started from any NetBackup client in order to back up files from that client.

The bpbackup command processes the files that you list on the command line or in the
file that you specify with the - £ listfile option. A file path can be a file or directory name.
If the named files include a directory, bpbackup backs up all files and subdirectories of
that directory starting at the directory itself.

On master servers

Using the second form of the command shown above, bpbackup starts an
immediate-manual backup of a client. This variation requires the -i option on the
bpbackup command and is available only to the administrator on the master server. It is
the equivalent of starting a manual backup from the NetBackup administrator’s interface.
Use the -h option to specify the host.

Since progress logs are written only on clients, and since this form of the bpbackup
command is run from the master server only, the -1 option is undefined.

The following restrictions apply to this command:

4 You must be the owner of the file or an administrator to back up a file with
bpbackup.

4 You can back up files and directories owned by other users if you have the necessary
UNIX file permissions.
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¢ If you specify a UNIX file that is a link, bpbackup backs up only the link itself, not the
file to which it links.

& bpbackup does not back up the "." or ".." directory entries.

By default, you are returned to the system prompt after bpbackup is successfully
submitted. The command works in the background and does not return completion status
directly to you. The -w option lets you change this behavior so the command works in the
foreground and returns completion status after a specified time period.

bpbackup writes informative and error messages to a progress-log file if you create the
file prior to running the bpbackup command and then specify the file with the -1
progress_log option. If bpbackup cannot back up the requested files or directories, use
the progress log to determine the reason for the failure.

If you create a directory named /usr/openv/netbackup/logs/bpbackup/ with
public-write access, bpbackup creates a debug log file in this directory that can be used
for troubleshooting.

In addition, if a nonroot user specifies USEMAIL = mail_address in their

$HOME /bp . conf file or a root user specifies it in the
/usr/openv/netbackup/bp.conf file, NetBackup sends mail on the backup
completion status to mail_address. This message is sent when the backup process is
complete.

OPTIONS

-p policy Names the policy to use for the backup.

If this option is not specified for a user backup, NetBackup uses the first
policy it finds that includes the client and a user backup schedule.

The -p option is required for an immediate-manual backup (- i option).

-1 Starts an immediate-manual backup. This is the equivalent of starting a
manual backup from the NetBackup administrator interface. You must be
the administrator on the master server to use the -1 option.

-h hostname
It names the client host on which to run the backup. If it is not specified,
NetBackup runs the backup on all clients in the policy.

-s schedule
Names the schedule to use for the backup. If it is not specified, the
NetBackup server uses the first user backup schedule it finds for the
client in the policy it is using (see the -p option).

-S master_server [, master_server,. . .]
Specifies the name(s) of the NetBackup master server(s). The default is
the first SERVER entry found in the /usr/openv/netbackup/bp.conf
file.
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-t policy_type
Specifies one of the following numbers corresponding to the policy type.
The default for NT clients is 13, for Apollo workstations the default is 3,
and for Netware clients the default is 10. The default for all others is 0:

0 = Standard

4 = Oracle

6 = Informix-On-BAR
7 = Sybase

13 = MS-Windows-NT
14 =0S/2

15 = MS-SQL-Server
16 = MS-Exchange-Server
19 =NDMP

Note The following policy types apply only to NetBackup DataCenter.

3 = Apollo-wbak
11 = DataTools-SQL-BackTrack
17 = SAP
18 = DB2
20 = FlashBackup
21 = Split-Mirror
22 = AFS
-L progress_log [-enl]

Specifies the name of a file in which to write progress information.
NetBackup creates the file if it doesn’t exist.

For example: /home/t1lc/proglog
The default is to not use a progress log.

Include the -en option to generate a log in English. The name of the log
will contain the string _en. This option is useful to support personnel
assisting in a distributed environment where differing locales may create
logs of various languages.

-w [hh:mm:ss]
Causes NetBackup to wait for a completion status from the server before
returning you to the system prompt.

The date and time format depend on the user's locale. See NOTES.
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-help

You can optionally specify a wait time in hours, minutes, and seconds.
The maximum wait time you can specify is 23:59:59. If the wait time
expires before the backup is complete, the command exits with a timeout
status. The backup, however, still completes on the server.

If you use -w without specifying a wait time or you specify a value of 0,
NetBackup waits indefinitely for the completion status.

If you include -1 with -w, NetBackup waits until all initiated jobs have
completed before returning status. However, if more than one job starts,
the status is unpredictable. If the multiple jobs are due to there being
more than one client and the policy does not have Allow Multiple Data
Streams selected, you can include the -h option to restrict the operation
to one client and obtain predictable status. However, if the policy has
Allow Multiple Data Streams selected and there is more than one job
from the selected client, the status is still unpredictable.

Prints a command line usage message when -help is the only option on
the command line.

-k keyword_phrase

-f listfile

Specifies a keyword phrase that NetBackup associates with the image
being created by this backup operation. You can then restore the image by
specifying the keyword phrase with the -k option on the bprestore
command.

If you use the -1 option with -k, NetBackup establishes an association
between the keyword phrase and the backup policy and image.

The keyword phrase is a textual description of the backup that is a
maximum of 128 characters in length. All printable characters are
permitted including space (" ") and period ("."). Enclose the phrase in
double quotes ("...") or single quotes ( “...") to avoid conflict with the UNIX
shell.

The default keyword phrase is the null (empty) string.

Specifies a file (listfile) containing a list of files to be backed up. This
option can be used instead of the filenames option, but cannot be used
with the - i option. List each file on a separate line.

The format required for the file list depends on whether the files have
spaces or newlines in the names.

To back up files that do not have spaces or newlines in the names, use this
format:

filepath
Where filepath is the path to the file you are backing up. For example:

/home
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/etc
/var

To back up files that have spaces or newlines in the names, use this
format:

filepathlen filepath

Where filepath is the path to the file you are backing up and filepathlen is
the number of characters in the file path.

For example:
5 /home
4 Jetc
4 /var

19 /home/abc/test file

filenames
Names one or more files to be backed up. This option can be used instead
of the - £ option, but cannot be used with the - i option. Any files that
you specify must be listed at the end, following all other options.

For Apollo clients, specify absolute file paths ( Apollo clients are
supported only by NetBackup DataCenter master servers).
NOTES

The format that you must use for date and time values in NetBackup commands varies
according to the locale setting.

If you are uncertain of the NetBackup command requirements for your locale, enter the
command with the -help option and check the usage. The following is part of the
bpbackup usage statement output that shows the -w option:

[-w hh:mm:ss]

Notice the hours:minutes:seconds requirement. These are for a locale setting of C and may
be different for other locales.

For more information on locale, see the 1ocale(1l) man page for your system.

EXAMPLES
¢ Example 1
To perform a user backup of a single file, enter:
bpbackup /usr/userl/filel
¢ Example 2

The following command starts a user backup of the files that are listed in a file named
backup_ list
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bpbackup -f backup list

¢ Example 3

The following command (all on one line) starts an immediate-manual backup of the
client host named diablo, in the policy named cis_co. The policy type is Standard
policy and is in the configuration on the master server named hoss.

bpbackup -p cis co -i -h diablo -S hoss -t 0
Example 4

The following command (all on one line, or using the backslash continuation
character) associates the keyword phrase “Backup My Home Directory 01/01/0” to
the user backup of the directory /home/kwc. The progress log is

/home /kwec/bkup . log.

bpbackup -k "Backup My Home Directory 01/01/01" \
-L /home/kwc/bkup.log /home/kwc

Example 5

The following command (all on one line) associates the keyword phrase “Policy Win
NT 01/01/01” to the immediate-manual backup of the client host named slater in the
policy named win_nt_policy.

bpbackup -k "Policy Win NT 01/01/2001" -i -h slater \
-p win nt policy -t 13

FILES
SHOME /bp . conf

/usr/openv/netbackup/logs/bpbackup/log.mmddyy

SEE ALSO

bp(1),bparchive(1),bplist (1), bprestore (1)
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NAME
bplist - Listsbacked up and archived files on the NetBackup server

SYNOPSIS
/usr/openv/netbackup/bin/bplist [-A | -B] [-C client] [-S

master_server] [-t policy _typel [-k policy] [-F] [-R [n]l] [-b
| -¢ | -ul [-1] [-r] [-flops file_options] [-Listseconds]
[-T] [-unix files] [-nt files] [-s mm/dd/yy
[hh:mm:ss1] [-e mm/dd/lyy [hh:mm:ss]] [I] [PI] [-help]
[-keyword "keyword phrase"] [filename]

DESCRIPTION

bplist shows a list of previously archived or backed up files according to the options
that you specify. You can choose the file or directory and the time period that you want the
listing to cover. Directories can be recursively displayed to a specified depth.

The list shows only the files that you have read access to. You also must own or have read
access to all directories in the file paths. You can list files that were backed up or archived
by another client only if you are validated to do so by the NetBackup administrator.

If you create directory /usr/openv/netbackup/logs/bplist/ with public-write
access, bplist creates an debug log file in this directory that you can use for
troubleshooting.

The output of bplist goes to standard output.

OPTIONS

-A | -B Specifies whether to produce the listing from archives (-2) or backups
(-B). The default is -B.

-C client Specifies a client name to use for finding backups or archives to list. This
name must be as it appears in the NetBackup configuration. The default
is the current client name.

-S master_server
Specifies the name of the NetBackup server. The default is the first
SERVER entry found in the /usr/openv/netbackup/bp.conf file.

-t policy_type
Specifies one of the following numbers corresponding to the policy type
(the default is 0 on all clients except Apollos, where it is 3):

0 = Standard
4 = Oracle
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6 = Informix-On-BAR

7 = Sybase

10 = NetWare

13 = MS-Windows-2000/NT
14 =0S/2

15 = MS-SQL-Server
16 = MS-Exchange-Server
19 = NDMP

Note The following policy types apply only to NetBackup DataCenter.

policy

3 = Apollo-wbak

11 = DataTools-SQL-BackTrack
17 = SAP

18 = DB2

20 = FlashBackup

21 = Split-Mirror

22 = AFS

Names the policy to search to produce the list. If not specified, all policies
are searched.

Specifies that in the list output, symbolic links (applies only to UNIX
clients) will end with a trailing @ and executable files with a trailing *.

Recursively lists subdirectories encountered to a depth of n. The default
for n is 999.

| ¢ | -u

Specifies an alternate date and time to be used for printing with the -1
option:

-b displays the backup date and time of each file.

-c displays the last inode modification date and time for each file.

-u displays the last access date and time of each file.

The default is to display the time of last modification of each file.

Lists in long format, giving mode, owner, group, size in bytes, and time of
last modification for each file (see the EXAMPLES section of this man
page). The list shows the mode of each file as 10 characters that represent

the standard UNIX file permissions. The first character is one of the
following:

d (specifies a directory)
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| (specifies a link)

- (specifies a file)

The next nine characters show the three sets of permissions. The first set
shows the owner’s permissions, the next set shows the user-group
permissions, and the last set shows permissions for all other users. Each
set of three specifies the read, write, and execute permissions as follows:

r means the file is readable

w means the file is writable

x means the file is executable

- means the indicated permission is not granted

-Listseconds
Specifies that seconds granularity be used for the time stamp when the
the -1 option is used.

-r Lists raw partitions that were backed up. The default is to list file systems.

-flops file_options]
Allows either Backup Exec files to be listed, or both Backup Exec and
NetBackup files to be listed. The default (- £ 1ops not specified) is to list
only NetBackup files.

To list only Backup Exe files specify:
-flops 524288
To list Backup Exe and NetBackup files specify:
-flops 1048576

-T Lists directories in true-image backups. The default is to list
non-true-image backups.

-unix files
Lists the files and directories in UNIX format. For example:
/C/users/test

-nt_files
Lists the files and directories in Windows format. For example:
C:\users\test.

-s mm/dd/yy [hh:mm :ss]

-e mm/dd/yy [hh:mm:ss]
Specifies the start and end date range for the listing.
The date and time format are dependent on the user's locale. See NOTES.

- s specifies a start date and time for the listing. The resulting list shows
only files in backups or archives that occurred at or after the specified
date and time. Use the following format for the start date and time:
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-PI

-help

-keyword

filename

mm/dd/yy [hh[:mm[:ss]]]

The valid range of dates are from 01/01/1970 00:00:00 to 01/19/2038
03:14:07. The default is the current date minus six months.

-e specifies an end date and time for the listing. The resulting list shows
only files from backups or archives that occurred at or before the
specified date and time. Use the same format as explained above for start
date and time. The default is the current date and time.

Specifies a case-insensitive search. This means that capitalization is not
considered when comparing names (for example, Cat matches cat).

Specifies a path-independent search, which means that NetBackup
searches for a specified file or directory without regard to the path. For
example, if a file named test exists in the three directories shown below,
a search for test finds all three instances of the file:

/tmp/junk/test
/abc/123/xxx/test
/abc/123/xxx/yyy/zzz/test

Prints a command line usage message when -help is the only option on
the command line.

"keyword_phrase "

Specifies a keyword phrase for NetBackup to use when searching for
backups or archives from which to restore files. The phrase must match
the one that was previously associated with the backup or archive by the
-k option of the bpbackup or bparchive command

You can use this option in place of or in combination with the other
restore options in order to make it easier to restore your backups and
archives. The following meta characters can be used to simplify the task
of matching keywords or parts of keywords in the phrase:

* matches any string of characters.
? matches any single character.

[ 1 matches one of the sequence of characters specified within the
brackets.

[ - ] matches one of the range of characters separated by the "-".
The keyword phrase can be up to 128 characters in length. All printable

characters are permitted including space (" ") and period ("."). The phrase

must be enclosed in double quotes ("...") or single quotes (*..." ) to avoid
conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.

Names the file or directory to list. If you do not specify a path, the default
is the current working directory.
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Any files or directories that you specify must be listed at the end,
following all other options.

For directories, if you do not use the -R option, include the trailing path
separator (\ for Windows and / for UNIX) as in the following:

bplist -1 D:\WS_FTP.LOG\* (Windows)
bplist -1 /home/userl/* (UNIX)

NOTES

The format that you must use for date and time values in NetBackup commands varies
according to the locale setting.

If you are uncertain of the NetBackup command requirements for your locale, enter the
command with the -help option and check the usage. The following is part of the
bplist usage output that shows the -s and -e options:

[-s mm/dd/yy hh:mm:ss] [-e mm/dd/yy hh:mm:ss]
These formats are for a locale setting of C and may be different for other locales. For more
information on locale, see the 1ocale (1) man page for your system.
EXAMPLES
¢ Example 1
To list recursively, in long format, the files that were backed up in /home /userl.

bplist -1 -R /home/userl

lrwxrwxrwx userl eng 0 Apr 5 12:25 /home/userl/dirlink
drwxr-xr-x userl eng 0 Apr 4 07:48 /home/userl/testdir
drwxr-x--- userl eng 0 Apr 4 07:49 /home/userl/dir

-TWXT----- userl eng 1002 Apr 2 09:59 /home/userl/dir/file
lrwxrwxrwx userl eng 0 Apr 4 07:49 /home/userl/dir/link

& Example 2

To list, with details, the files that were backed up and associated with all or part of the
keyword phrase

"My Home Directory"
in directory /home/kwc, enter the following:
bplist -keyword "*My Home Directory*" -1 /home/kwc/
¢ Example 3

To list, with details, the files that were archived and associated with all or part of the
keyword phrase

"My Home Directory"
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in directory /home/kwc, enter the following:
bplist -A -keyword "*My Home Directory*" -1 /home/kwc/
¢ Example 4

To list, recursively and with details, the files that were backed up on drive D of
Windows NT client slater and associated with all or part of the keyword phrase

"Win NT"

enter the following:
bplist -keyword "*Win NT*" -C slater -t 13 -R -1 /D

FILES
/usr/openv/netbackup/logs/bplist/log. mmddyy

SEE ALSO
bp (1), bparchive (1), bpbackup (1), bprestore (1)
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NAME

bprestore - Restores files from the NetBackup server

SYNOPSIS
/usr/openv/netbackup/bin/bprestore [-A | -B] [-BR

be_redirection_path] [-F file_options] [-K] [-1 | -H | -y]
[-r] [-T] [-L progress log [-en]l] [-R rename_file] [-C
client] [-D client] [-S master_server] [-t policy typel [-p
policy]l] [-s mm/dd/yy [hh:mm:ss]1] [-e mm/dd/yy
[(hh:mm:ss]] [-w [hh:mm:ss]] [-k "keyword_phrase”] -f
listfile | filenames

DESCRIPTION

bprestore lets users restore a backed up or archived file or list of files. You can also
name directories to restore. If you include a directory name, bprestore restores all files
and subdirectories of that directory. You can exclude a file or directory path that was
previously included in the restore by placing an exclamation mark (!) in front of the file or
directory path (does not apply to NDMP restores). The exclude capability is useful, for
example, if you want to exclude part of a directory from the restore.

By default, you are returned to the system prompt after bprestore is successfully
submitted. The command works in the background and does not return completion status
directly to you. The -w option lets you change this behavior so bprestore works in the
foreground and returns completion status after a specified time period.

The bprestore command restores the file from the most recent backups within the time
period you specify, except for a true-image restore (see the -T option description).

bprestore overwrites any file of the same name that already exists on the local client
disk, unless you include the -x option. It is also possible to restore files that were backed
up or archived on another client (- option). You must be validated by the NetBackup
administrator to restore from other clients.

Use the bplist command to display information on the files and directories that were
backed up or archived.

bprestore writes informative and error messages to a progress-log file if you create the
file prior to running the bprestore command and then specify the file with the -L
progress_log option. If bprestore cannot restore the requested files or directories, you
can use the progress log to find the reason for the failure.

For detailed troubleshooting information, create a directory named
/usr/openv/netbackup/logs/bprestore with public-write access. bprestore
then creates an debug log file in this directory.
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In addition, if a nonroot user specifies USEMAIL = mail_address in their $SHOME /bp . conf
file, NetBackup sends mail on the restore completion status to mail_address. This message
is sent when the restore process is complete.

The following restrictions apply to bprestore:

4 You can restore files and directories that you own and those owned by other users if
you have read access. You need write access to another user’s directories and files to
restore that user’s files to their original location.

& The operating system restricts the number of files and directories that you can specify
on a single bprestore command line. If this is a problem, use the - £ option to
restore the files.

OPTIONS

-A | -B Specifies whether to restore from archives (-2) or backups (-B). The
default is -B.

-BR be_redirection_path
Contains the redirection path when restoring Backup Exec files. Valid
only when -F is set to 524288. For example, when only Backup Exec files
are being restored.

-F file_options
Allows either Backup Exec files to be restored, or both Backup Exec and
NetBackup files to be restored. The default ( -F is not specified), is to
restore only NetBackup files.
To restore only Backup Exe files specify:
-F 524288
To restore Backup Exe and NetBackup files specify:

-F 1048576
-K Specifying this option causes bprestore to keep existing files rather

than writing over them when restoring files with the same name. The
default is to overwrite existing files.

Note The -1 | -H | -y options apply only when restoring UNIX files to a UNIX system.

-1 | -H | -y
Specifying -1 renames the targets of UNIX links by using the -RrR
rename_file option in the same way as when renaming files.

Specifying -H renames UNIX hard links by using the -R rename_file
option in the same way as when renaming files. Soft links are unchanged.
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Specifying -y renames UNIX soft links by using the -R rename_file
option in the same way as when renaming files. Hard links are
unchanged.

See Example 5 in the EXAMPLES section.
-r Specifying this option restores raw partitions instead of file systems.

-L progress_log [-en]
Specifies the name of an existing file in which to write progress
information.

For example: /home/tlc/proglog
The default is to not use a progress log.

Include the -en option to generate a log in English. The name of the log
will contain the string _en. This option is useful to support personnel
assisting in a distributed environment where differing locales may create
logs of various languages.

-R rename_file
Specifies the name of a file with name changes for alternate-path restores.
Use the following form for entries in the rename file:
change backup_filepath to restore_filepath
The file paths must start with / (slash)

The first backup_filepath that is matched is replaced with the
restore_filepath string. The default is to restore using the original path.

For example, the following entry renames /usr/fred to /usr/fred2:
change /usr/fred to /usr/fred2
-C client Specifies a client name to use for finding backups or archives from which

to restore files. This name must be as it appears in the NetBackup catalog.
The default is the current client name.

Note The destination client does not default to the source client. See the description for
-D client option.

-D client Specifies a destination client. This can be done by a root user on the
master server in order to direct the restored files to a machine other than
the client specified with the - option. The default is the current client
name.

-S master_server
Specifies the name of the NetBackup server. The default is the first server
found in the /usr/openv/netbackup/bp . conf file.
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-t policy_type

Specifies one of the following numbers corresponding to the policy type
(the default is 0 on all clients except Apollos, where it is 3):

0 = Standard

4 = Oracle

6 = Informix-On-BAR

7 = Sybase

10 = NetWare

13 = MS-Windows-NT

14 =0S/2

15 = MS-SQL-Server

16 = MS-Exchange-Server
19 = NDMP

Note The following policy types apply only to NetBackup DataCenter.

3 = Apollo-wbak

11 = DataTools-SQL-BackTrack
17 =SAP

18 =DB2

20 = FlashBackup

21 = Split-Mirror

22 = AFS

-p policy Specifies the policy for which the backups or archives were performed.
-s mm/dd/yy [hh:mm :ss]
-e mm/dd/yy [hh:mm :ss]

Specifies the start and end date range for the listing. The bprestore
command restores only files from backups or archives that occurred
within the specified start and end date range.

The date and time format are dependent on the user’s locale. See NOTES.

- s specifies a start date and time for the restore window. bprestore
restores files only from backups or archives that occurred at or after the
specified date and time. Use the following format:

mm/dd/yy [hh[:mm[:ss]]]

The valid range of dates are from 01/01/1970 00:00:00 to 01/19/2038
03:14:07. The default start date is 01/01/1970 00:00:00.
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-e specifies an end date and time for the restore window. bprestore
restores only files in backups or archives that occurred at or before the
specified date and time. Use the same format as for the start date and
time.

The end backup date and time do not need to be exact, except for a
true-image restore (see the -T option description). The bprestore
command restores the file that has the specified backup date and time or
the file that is the most recent backup preceding the end date and time.
The default is the current date and time."

If you do not specify either -s or -e, bprestore restores the most
recently backed up version of the file.

-T Specifies a true-image restore, where only files and directories that
existed in the last true-image backup are restored. This option is useful
only if true-image backups were performed. If this option is not specified,
all files and directories meeting the specified criteria are restored, even if
they were deleted.

When the - T option is specified, the image requested must be uniquely
identified. Unique identification is accomplished by using the -e option
with seconds granularity. The -s option, if any, is ignored. The seconds
granularity of an image can be retrieved by using the bplist command
with the -1 and -Listseconds options.

-w [hh:mm:ss]
Causes NetBackup to wait for a completion status from the server before
returning you to the system prompt.

The date and time format are dependent on the user’s locale. See NOTES.

You can optionally specify a wait time in hours, minutes, and seconds.
The maximum wait time you can specify is 23:59:59. If the wait time
expires before the restore is complete, the command exits with a timeout
status. The restore, however, still completes on the server.

Specifying 0 or not specifying a time, means wait indefinitely for the
completion status.

-k "keyword_phrase™
Specifies a keyword phrase for NetBackup to use when searching for
backups or archives from which to restore files. The phrase must match
the one that was previously associated with backup or archive by the -k
option of the bpbackup or bparchive command.
You can use this option in place of or in combination with the other
restore options in order to make it easier to restore your backups and
archives. The following meta characters can simplify the task of matching
keywords or parts of keywords in the phrase:

* matches any string of characters.
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-f

listfile

? matches any single character.

[ ] matches one of the sequence of characters specified within the
brackets.

[ - ] matches one of the range of characters separated by the "-".

The keyword phrase can be up to 128 characters in length. All printable

characters are permitted including space (" ") and period ("."). The phrase

must be enclosed in double quotes ("...") or single quotes ("...") to avoid
conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.

Specifies a file (listfile) containing a list of files to be restored and can be
used instead of the filenames option. In listfile, list each file path on a
separate line.

The format required for the file list depends on whether the files have
spaces or newlines in the names.

To restore files that do not have spaces or newlines in the names, use this
format:

filepath

Where filepath is the path to the file that you are restoring. For example:
/home

/etc

/var

To restore files that have spaces or newlines in the names, use one of the
following formats:

filepathlen filepath

filepathlen filepath start_date_time end_date_time

filepathlen filepath -s datetime -e datetime

The filepath is the path to the file you are restoring.

The filepathlen is the total number of characters in the file path.

The start_date_time and end_date_time are the decimal number of
seconds since 01/01/1970 00:00:00.

datetime is the same as the command line (mm /dd /yy [hh[: mm[ : ss]]]).
The start and end date and time specified on the command line is used
unless a line in listfile overrides it. The dates may change from line to line.

The user’s locale affects how dates and time are specified. See NOTES.

You can exclude a file or directory path that was previously included in
the restore by placing an exclamation mark (!) in front of the file or
directory path (except when performing NDMP restores).

The following is an example that uses filepathlen filepath:
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5 /home
4 Jetc
4 /var
19 /home/abc/test file
12 !/etc/passwd

flenames Names one or more files to be restored and can be used instead of the - £
option.
Any files that you specify must be listed at the end, following all other
options. You must also specify absolute file paths. You can exclude a file
or directory path that was previously included in the restore by placing

an exclamation mark (!) in front of the file or directory path (except when
performing NDMP restores).

NOTES

The format that you must use for date and time values in NetBackup commands varies
according to the locale setting.

If you are uncertain of the NetBackup command requirements for your locale, enter the
command with the -help option and check the usage. The following is part of the
bpbprestore usage statement output that shows the - s, -e, and -w options:

[-s mm/dd/yyyy [HH:MM:SS]] [-e mm/dd/yyyy [HH:MM:SS]]
[-w [hh:mm:ss]]

Note formats for the month, day, year and hours, minutes, seconds. These are for a locale
setting of C, and may be different for other locales. For more information on locale, see the
locale (1) man page for your system.

EXAMPLES

¢ Example 1

To restore files from backups of /usr/userl/filel that were performed between
04/01/2001 06:00:00 and 04/10/2001 18:00:00, enter the following (all on one line):

bprestore -s 04/01/2001 06:00:00 -e 04/10/2001 18:00:00
/usr/userl/filel

& Example 2

To restore files listed in a file named restore 1ist by using the most recent
backups, enter the following:

bprestore -f restore list

& Example 3
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To restore the directory /home/kwc from the backups that are associated with a
keyword phrase that contains “My Home Directory” and use a progress log named
/home /kwc/bkup . log, enter the following (all on one line):

bprestore -k "*My Home Directory*" -L /home/kwc/bkup.log /home/kwc
¢ Example 4

To restore the D drive on the Windows NT client slater from the backups that are
associated with a keyword phrase that contains “My Home Dir” and use a progress
log named /home /kwc/bkup. 1log, enter the following (all on one line, or using the
backslash continuation character):

bprestore -k "*My Home Dir*" -C slater \
-D slater -t 13 -L /home/kwc/bkup.log /D

¢ Example5

Assume you have a rename file named /home /kwc/rename on a UNIX client and it
contains the following:

change /home/kwc/linkback to /home/kwc/linkback alt

To restore the hard link named /home /kwc/1linkback to alternate path
/home/kwc/linkback_alt on that client, run the following command:

bprestore -H -R /home/kwc/rename /home/kwc/linkback
¢ Example 6

Assume you want to restore files from backups of /home /user1 that were
performed between 04/01/01 06:00:00 and 04/10/01 18:00:00. You also want to
exclude all files with a .pdf extension, except for the one named £inal doc.pdf.
To do this, run the following (all on one line, or using the backslash continuation
character):

bprestore -s 04/01/01 06:00:00 -e 04/10/01 18:00:00 /home/userl \
! /home /userl/* .pdf /home/userl/final doc.pdf

FILES
SHOME /bp . conf

/usr/openv/netbackup/logs/bprestore/log.mmddyy

SEE ALSO
bp (1), bparchive (1), bpbackup(1),bplist (1)
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Open Transaction Manager Parameters

The Open Transaction Manager (OTM) parameters in the registry are used to define the
behavior of OTM. NetBackup uses OTM to back up files, databases, and applications that
are open or active.

Open Transaction Manager establishes a point-in-time view, or snapshot, of the data on
the drives that contain files to be backed up. NetBackup then backs up the selected files as
they existed at the time of the snapshot, regardless of file system activity. The snapshot is
maintained by using a cache system to store changes that occur during the backup.

In addition to eliminating problems with busy files, Open Transaction Manager keeps all
relationships between files in the backup intact. For example, assume that keywords in
files A and B must be synchronized for an application to work. Without OTM, if A is
backed up but B is changed before it is backed up, the two files are not synchronized after
a restore and the application will not work. With OTM, all files are backed up as they exist
at a single point in time so that relationships are maintained and these problems cannot
occur.

Windows Registry Description

The Windows registry is divided into sections and each section is formatted as follows:

[section name]
parameter name = value

Where:
[section name] Identifies the start of a new configuration file section.
parameter name Identifies the name of a configuration file parameter.
value Is the value to be set for the associated configuration file

parameter.
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The following describes the OTM section of the registry. An example registry follows
these descriptions.

[otm] Section
OTM_Cache File

Specifies the location of the cache file that contains the copy of data that changes
during the backup. For best performance, place the cache file on a drive that is not
backed up. By default, the program determines the cache location at run time (for
example, C: \temp).

OTM_Cache Control

Specifies the frequency with which Open Transaction Manager clears its cache during
a backup, which can help to reduce the size of the cache file. For example, if this value
is set to 50, then after every 50 files that are backed up, Open Transaction Manager
clears its cache of data that it has for those files. A lower number results in the cache
being cleared more often, but that can decrease performance. The default setting is 0,
which means cache clearing does not occur.

When 0TM_Current is set to 0 (meaning that global snapshots are used), the
OTM_Cache Control setting works as described in the following examples. For
these examples, assume that 0TM_Current is set to 0 and that there are two drives: C
and D. Also assume that both drives are backed up and that Open Transaction
Manager places the cache on drive C.

- IfoTM_cache Control is set to 0, the cache is never cleared and cannot grow
past the OTM_Cache Size Init setting. This means that
OTM_Cache_ Size Init mustalways be set for the maximum amout of data
expected.

- IfoTM_Cache Control is greater than 0, Open Transaction Manager clears the
cache of data for drive C after the backup of drive C is complete. Open
Transaction Manager then allows the cache to grow to the
OTM_Cache Size Max setting and clears it periodically, according to the
OTM_Cache Control setting. This allows you to set OTM_Cache Size Init to
a lower value because if more space is required, Open Transaction Manager can
increase the OTM_Cache Size Max setting.

OTM_Cache_Control is not used if Allow multiple data streams is also set for the
policy and more than one backup runs at a time. The action that occurs in this instance
depends on whether the backups were synchronized.

- If more than one backup is running and the backups were synchronized, then
cache control is not performed for any of the backups.
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- If more than one backup is running but the backups were not synchronized, then
open transaction management is enabled for the first backup but disabled for the
rest.

OTM_Cache_ Size Init

Specifies the initial size of the cache file (in megabytes). If you do not specify a value,
NetBackup sets it to 150 megabytes. See “Guidelines for Setting the OTM Cache” on
page 145 for more information.

OTM_Cache Size Max

Specifies the maximum cache size (in megabytes) of the cache file. The guideline for
maximum cache size is to set it to 10% of all used disk space. For example, if your
used disk space is 1 GB, set the maximum cache to 100 MB. A shortcut is to set the
maximum cache size to 0 MB and let NetBackup determine the appropriate value at
run time. The default maximum cache size for the client is 592 MB, and for a master or
media server is 250 MB.

If the cache file reaches this size and more cache is required, the action depends on the
OTM_Error Control setting:

- IfoTM_Error Control is set to 0 (abort on error), the backup aborts. This is the
default setting.

- IfoTM_Error Control isset to 1 (disable OTM), open transaction managment
is turned off and the backup continues. However, relationships between the
backed up files can be lost because the snapshot is not used.

- IfoTM_Error Control is set to 2 (retry OTM), NetBackup disables open
transaction management and then attempts to enable it again before continuing
the backup. This second try starts over with a new snapshot, so as with
OTM_Error Control setto 1 (disable OTM), relationships between backed up
files can be lost.

For more information, see “Guidelines for Setting the OTM Cache” on page 145.
OTM_Logging

Specifies the logging level for open transaction management but does not affect other
logging. This allows you to obtain more information about an open transaction
management problem without affecting the logging level for other parts of the
backup. The value can range from 0 to 3, with level 3 providing the most information.
The default value is 0.

OTM_Quiescent Timeout

Specifies how many seconds to wait for a quiet period to occur. If this time expires, the
backup proceeds, but without open transaction management. The default time period
is 60 seconds.
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OTM_Quiescent Wait

Specifies the duration (in seconds) of the quiet period that must occur before
NetBackup starts Open Transaction Manager. The quiet period is a period of time
during which no writes are being performed on the drives or volumes to be backed
up. The default time period is 5 seconds.

OTM_Sync_Timeout

Intended for use with multiple data streams and specifies how long NetBackup waits
to determine if other backup jobs are going to start for this schedule and client before
enabling open transaction managment. The default wait time period is 60 seconds.

If another backup starts up within this time period, the wait cycle restarts. For
example, if this setting is at the default, the first backup starts and waits 60 seconds for
other backups. If a second backup starts 30 seconds into the wait cycle, the wait cycle
restarts for both backups. If no further backups start within the second 60 second
period, the first backup will have waited 90 seconds and the second backup will have
waited 60 seconds.

If the Allow multiple data streams is not set for the policy, you can eliminate the
initial wait period by setting OTM_Sync_Timeout toO0.

OTM_TUse

Enables open transaction management. This must be turned on for open management
to occur. Enter yes or 1 to enable OTM, or no or 0 to disable OTM.

OTM_Error_Control

Specifies the behavior of the backup when an open transaction management error is
encountered during a backup. The most likely error is a cache full condition. The
possible settings are as follows:

- IfoTM_Error Control is set to 0 (abort on error), the backup aborts. This is the
default setting.

- IfoTM_Error Control isset to 1 (disable OTM), open transaction managment
is turned off and the backup continues. However, relationships between the
backed up files can be lost because the snapshot is not used.

- IfoTM_Error Control is set to 2 (retry OTM), NetBackup disables open
transaction management and then attempts to enable it again before continuing
the backup. This second try starts over with a new snapshot, so as with
OTM_Error Control setto 1 (disable OTM), relationships between backed up
files can be lost.

Use 1 (disable OTM) or 2 (retry OTM) only if there is no concern about file
relationships. With either of these settings, file relationships can be affected, if, for
example, two files are backed up from different snapshots or if one is from a snapshot
and the other is not from a snapshot.
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OTM_Current

The oTM Current setting determines the type of snapshot that is taken of the drive.
Two snapshot types are available: individual drive or global.

Individual Drive Snapshots

Specifies that OTM takes a snapshot of each drive and backs it up before proceeding
to the next drivet. For example, assume that drives C and D are being backed up.
OTM first takes a snapshot of drive C, backs it up, and discards the snapshot. Next,
OTM takes a snapshot of drive D, backs it up, and discards the snapshot. To specify
this type of snapshot, the OTM_Current setting should be 1.

Open transaction management is enabled on only one drive at a time, depending on
which one is being backed up. This mode is useful when it is not necessary to
maintain relationships between files on the different drives.

Global Drive Snapshots

Specifies that OTM takes a snapshot that includes all drives that are part of the
backup, then backs up the drives. For example, assume that drives C and D are being
backed up. OTM first takes a snapshot of drives C and D. Drive C is backed up, then
drive D is backed up. OTM then discards the snapshot. To specify this type of
snapshot, the OTM_Current setting should be 0.

Open transaction management is enabled on both the C and D drives for the entire
duration of the backup. This mode is useful when it is necessary to maintain
relationships between files on the different drives.

Guidelines for Setting the OTM Cache

The required settings for OTM_Cache Size Init and OTM Cache Size Max depend
on the system that is being backed up, and on how Open Transaction Manager is
configured. The following explains how NetBackup chooses a drive for the cache and how
this choice affects the cache requirements.

When open transaction management is enabled and a backup starts, the cache file is
created and NetBackup attempts to place it on a drive where open transaction
management is not used. If it is used on all drives, NetBackup places the cache file on a
drive that is big enough to contain it.

The requirement for the initial cache size depends on whether the cache is placed on a
drive where open transaction management is used:

& If the cache file is on a drive where open transaction management is being used, the
size of the cache file does not grow past the initial size. Here, the initial cache size
must be large enough to hold the maximum amount of data that is anticipated (10% of
the used disk space is the guideline).
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& If the cache file is placed on a drive where open transaction management is not used,
the size of the cache file can grow to the maximum size. Here, initial cache size can be
set to less than the maximum because it will grow.

The snapshot setting determines the drives where NetBackup uses open transaction
management and at what point is it enabled:

¢ Individual drive snapshot (set 0TM_Current to 1) enables open transaction
management on each drive as it is backed up. Here, it is possible to place the cache on
a drive where open transaction is not used so a smaller initial cache size is possible.

¢ Global drive snapshot (set 0TM_Current to 0) enables open transaction management
on all drives that are backed up at the start of the backup. Here, the cache can grow
from its initial size only if there is a drive that is not being backed up so that cache can
be placed on that drive.

Open Transaction Manager uses a kernel mode driver. The type of Windows system (NT
or 2000) on which OTM is installed can affect the amount of memory available and the
maximum cache file size.

Windows | Windows

2000 NT
Memory that can be allocated by kernel mode drivers 380 MB 192 MB
(the memory is shared by all kernel mode drivers in the system)
Memory used by Open Transaction Manager per MB of OTM cache | 40 KB 40 KB
file
Maximum cache file size, which is dependent on the number of 3GB 2GB
kernel mode drivers on the server
The OTM_Cache_Size Max setting may need to be manually 30GB 20GB
configured downward if the total amount of data on the server is
greater than:
(This is dependent on the amount of memory being used by other
kernel mode drivers on the server.)

If OTM has reached the kernel driver memory limitation or the physical memory

limitation available for the Windows NT or Windows 2000 system, the following entry is

logged in the bpkar log from the client:

OTM: not enabled (err=0x000005aa)

The backup will continue but will not use OTM, and the backup may end with an exit
code of “Status 1 - not all files backed up”. A smaller OTM_Cache Size Max size should
be set if there is enough physical RAM available in the server.
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Example Windows Registry

The following is an example of the OTM section in a Windows registry:

[otm]

OTM Cache File = C:\temp
OTM_Cache_Control = 0
OTM_Cache Size Init = 10
OTM_Cache Size Max = 50
OTM_Logging = 0
OTM_Quiescent Timeout = 60
OTM_Quiescent Wait = 5
OTM_Sync_Timeout = 60
OTM Use = 1
OTM_Error_Control = 0
OTM_Current = 0
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Glossary

access control list (ACL)

Security information associated with files on some file systems.

ACS
Automated Cartridge System. ACS can refer to any of the following:

& A type of Media Manager robotic control. This robot type is supported only by
NetBackup DataCenter servers.

& The StorageTek (STK) system for robotic control.

¢ The highest-level component under STK’s ACS library software, which refers to a
specific standalone robotic library or to multiple libraries connected with a media
passthru mechanism.

active job

A job for which NetBackup is currently processing backup or restore data.

activity logs

See “debug logs.”

activity monitor
A NetBackup administration utility that displays information about NetBackup jobs and
provides limited control over them.

administration client

See “remote administration console.”

administrator

A user that is granted special privileges to install, configure, and manage the operation of
a system, network, or application.
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AIT
Sony Advanced Intelligent Tape, a type of tape drive or media type.

alternate-client restore

See “redirected restore (different client).”

alternate-target restore

See “redirected restore (different target).”

alternate path restore

See “redirected restore (different path).”

alternate read server

A server used to read a backup image which was originally written by a different media
server. The media server specified as Alternate Read Server must have access to the media
containing the backup image or images it is configured to read.

archive
A special kind of backup where NetBackup backs up the selected files, and if the backup
is successful, deletes the files from the local disk. In this manual, references to backups
also apply to the backup portion of archive operations except where otherwise noted.
archive bit

A file-status bit that the Microsoft based operating system sets when it writes a file,
thereby indicating that the file has changed.

attributes for a policy
Configuration parameters that control the behavior of NetBackup during operations
involving this policy.

autochanger

See “robotic library.”

autoloader

See “robotic library.”

automatic backup

A scheduled backup by the master server.
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back up

The act of copying and saving files and folders to storage media.

backup

Refers to the process of copying and saving files and directories to storage media. For
example, the backup is complete. This term can also refer to the collection of data that
NetBackup saves for a client during a backup or archive. For example, duplicate the backup.

Backup is two words when used as a verb. For example, back up the file.

backup, archive, and restore interface

The name of the NetBackup Microsoft Windows and Java based user interfaces for clients.
On servers these interfaces can be started through the NetBackup Administration
Console.

backup window

The period of time during which backups can begin.

block size

The number of bytes in each block of data written on the media during a backup.

bp
A backup, archive, and restore utility for users on NetBackup UNIX clients. It has a
character-based, menu interface that can be run from terminals that do not have X
Windows capabilities.
bpadm
An administrator utility that runs on NetBackup UNIX servers. It has a character-based,
menu interface that can be run from terminals that do not have X Windows capabilities.
bp.conf file
A NetBackup configuration file on UNIX servers and also on UNIX, Macintosh, and OS/2
clients.
bp.ini file
NetBackup initialization file for Novell NetWare target clients.
bpcd
NetBackup Client service on Windows and the NetBackup Client daemon on UNIX.
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bprd

NetBackup Request Manager service on Windows and NetBackup Request daemon on
UNIX.

cancel a job

Terminating a job and removing it from the job queue.

carousel
See “robotic library.”

catalogs
Internal NetBackup and Media Manager databases. These catalogs contain information
about configuration, media, devices, status, errors, and the files and directories in the
stored backup images.

CDF
Context-dependent file, which is a type of directory structure on a Hewlett-Packard
system.

changer
See “robotic library.”

class
See “policy.”

client

The system with the files to back up, archive, or restore.

client-user interface

See “user interface.”

cluster

See master and media server cluster.

command lines

Commands that users can execute either from the system prompt or in scripts.

compression

The process of compacting data to enable more efficient transmission and storage.

-~ 152 NetBackup User’s Guide - Microsoft Windows



configuration

The parameters that govern the behavior of an application. This term can also refer to the
manner in which a network or system is laid out or connected (for example, a network
configuration).

consolidated eject

A process of ejecting media for more than one Vault session at a time. A Consolidated
Eject can be performed for one or more logical vaults at one time.

consolidated report

cpio

ctime

A process of generating reports for more than one Vault session at a time. A Consolidated
Report can be performed for one or more logical vaults at one time. Consolidated reports
are organized by report title, not by vault.

A UNIX command that can be used for copying files to or from a cpio archive on disk or
tape.

The time that a UNIX inode was changed.

cumulative-incremental backup

daemon

A backup that is scheduled by the administrator on the master server and backs up files
that have changed since the last successful full backup. All files are backed up if no prior
backup has been done. Also see “differential-incremental backup.”

A program on a UNIX system that runs in the background and performs some task (for
example, starting other programs when they are needed). Daemons are generally referred
to as services or processes on Windows server systems.

database-agent clients

Clients with additional NetBackup software that is designed to back up relational
databases.

database-extension clients

See “database-agent clients.”
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debug logs
Logs that can be optionally enabled for specific NetBackup and Media Manager programs
and processes and then used to investigate problems.

destination storage unit
A storage unit to which Vault sends the data from a duplication operation. If the
duplicated backup images are to be vaulted, then the destination storage unit must
correspond to the robotic volume group.

device delays
Delays caused by the device that are beyond the control of the storage application. An
example is the time required to position tape under the read and write heads.

device host
A host (that has Media Manager installed) where a drive or robotic control is attached or is
defined.

device monitor

A Media Manager administration utility that provides monitoring and manual control of
Media Manager storage devices. For example, an administrator or computer room
operator can use this utility to manually reset devices or set them to the UP or DOWN
state.

DHCP
Dynamic host configuration protocol. This TCP/IP protocol automatically assigns
temporary IP addresses to hosts when they connect to the network.

differential-incremental backup

Scheduled by the administrator on the master server and backs up files that have changed
since the last successful incremental or full backup. All files are backed up if no prior
backup has been done. Also see “cumulative-incremental backup.”

directory depth
The number of levels below the current directory level that the NetBackup interfaces
show in their directory and file list displays.

directory tree

The hierarchical structure in which files are organized on a disk. Each directory lists the
files and directories that are directly below it in the tree. On UNIX, the topmost directory
is called the root directory.

= 154 NetBackup User’s Guide - Microsoft Windows



disaster recovery

Recovering data from backups after a disk crash or other catastrophe.
disk
Magnetic or optical disk storage media.
disk-image backup
A bit-by-bit rather than a file system backup of a disk drive on a Windows platform.

DLT

Digital-linear tape or tape drive type.

Domain Name Service (DNS)

A program that handles name translation for network communications.

drive cleaning

The use of a special cleaning tape to clean the heads on a drive.
duplicate image

A copy of a backup image.
eject

Move media out of a robotic library.

encryption

Provides additional security by encrypting backup data on the client. This capability is
available only with the NetBackup Encryption option.

entry and exit ports

See “media access port.”

exclude list
A list that designates files or directories to exclude from automatic backups.
expiration (image)

The date and time when NetBackup stops tracking a backup image.
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expiration (volume)

The date and time when the physical media (tape) is considered to be no longer usable.

external media ID

This is an identifier written on a media cartridge or canister to help the operator identify
the volume before inserting it into a drive or robot. For labeled media, the external media
ID should be the same as the media ID recorded on the media.

EVSN

See “external media ID.”

FlashBackup
A special type of raw-partition backup that requires the NetBackup FlashBackup
separately-priced option (this option is available only for NetBackup DataCenter).

flush level
Controls how often Netbackup clears its log files on a Novell NetWare or Microsoft
Windowvs client platform.

fragment
A part of a backup or archive image. NetBackup can be configured to divide images into
fragments when they exceed a certain size or span tapes.

frequency (backup)
How often NetBackup performs scheduled backups. For example, if the frequency is
seven days then backups occur once a week.

FROZEN media state
If a volume is FROZEN, NetBackup keeps it indefinitely and can restore from it but not
use it for further backups or archives.

full backup
A backup that copies, to a storage unit, all files and directories that are beneath a specified
directory.

FULL media state

If this appears in a report or listing, it indicates the volume is FULL and cannot hold more
data or be used for further backups.
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global attributes

NetBackup configuration attributes that affect all policies.

GDM Dashboard
The name for the Global Data Manager interface. The Dashboard enables monitoring job
and drive activity on multiple master servers, as well as providing alerts to problem
conditions.

GDM Managed Server
A NetBackup master server that appears as a managed master server in the left pane of
the GDM Dashboard.

GDM Server

A NetBackup master server that has the Global Data Manager license activated. When
logging into this host, the user can monitor the activity on multiple master servers using
the GDM Dashboard interface. If the host has installed the Advanced Reporter option, the
reports show information on multiple master servers.

Global Data Manager (GDM)

A separately-priced option (for UNIX servers) that provides an interface with a tree view
where the administrator can view and administer multiple master servers. The server
where the option is installed is called a GDM Server.

Global Device Database

A single host that serves as the repository for global device configuration information.
When you install NetBackup, by default the master server is configured as the global
device database host.

GNU tar

A public domain version of the UNIX tar program.

goodies directory

A directory containing programs, scripts, and other files that are not formally supported.

GUI
Graphical user interface.
e
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hard link

heap level

On UNIX, a hard link is a pointer to the inode for the data. On a Windows server, a hard
link is a directory entry for a file. Every file can be considered to have at least one hard
link. On NTFS volumes each file can have multiple hard links, and a single file can appear
in many directories (or even in the same directory with different names).

A parameter for memory-heap debugging on a Novell NetWare or Windows NetBackup
client.

hierarchical storage management

host

host name

HSM

image

import

include list

The process of automatically migrating selected files from a managed file system to
specified migration levels on secondary storage, while maintaining transparent access to
those files.

A computer that executes application programs.

Name by which a host computer is identified by programs and other computers in the
network.

See storage migrator.

The collection of data that NetBackup saves for an individual client during each backup or
archive. The image contains all the files, directories, and catalog information associated
with the backup or archive.

The process of recreating NetBackup records of images so the images can be restored.

A list that designates files or directories to add back in from the exclude list.

incremental backup

See “cumulative-incremental backup” and “differential-incremental backup.”
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inject

Move media into a robotic library.

inport
See “media access port.”
inode
A UNIX data structure that defines the existence of a single file.
install_path
Directory where NetBackup and Media Manager software is installed. The default on
Windows servers is C: \Program Files\VERITAS and on UNIX itis /usr/openvw.
jbpSA
The Java-based NetBackup interface for performing user backups, archives, and restores.
jnbSA
The Java-based NetBackup interface for administrators.
job
A parcel of work submitted to a computer. NetBackup jobs are backups, archives, or
restores.
kernel

The nucleus of an operating system.

keyword phrase

A textual description of a backup.

kill a job
See “cancel a job.”

label
Identifier of a tape or optical disk volume. A recorded label includes a media ID.
A barcode label allows a barcode scanner to be used for media tracking.

library

See “robotic library.”
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link

See “hard link” or “symbolic link.”

LMF - Library Management Facility

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

load
(noun) Amount of work that is being performed by a system or the level of traffic on a
network. For example, network load affects performance.
(verb) Copy data to internal memory. For example, load the installation program.
(verb) Used to indicate tape drive initialization done when new media is being added.
logs
Files where a computer or application records information about its activities.
mailslot
See “media access port.”
man pages

Online documentation provided with UNIX computer systems and applications.

Master and media server cluster

A NetBackup master server and the remote media servers that it is using for additional
storage. It is possible to configure clusters only with NetBackup DataCenter servers.
NetBackup BusinesServer supports only a single server, the master.

Master of Masters

A NetBackup host where Global Data Manager software is installed. When logging into
this host, the interface has a tree view where the administrator can view and administer
multiple master servers.

master server

The NetBackup server that provides administration and control for backups and restores
for all clients and servers in a master and media server cluster. NetBackup BusinesServer
supports only a single server and it is the master.
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media

Physical magnetic tapes, optical disks, or magnetic disks where data are stored.

media access port

A slot or other opening in a robot where you can insert or remove a tape without having
to access the interior of the robot. After inserting a tape, you move it to a slot by using an
inject command. Prior to removing a tape, you move it to the port by using an eject
command. The inject and eject commands are supported through the add and move
screens in the Media Manager administration interface.

media host

NetBackup server to which the job (client) is sending the data.

media ID

An identifier that is written on a volume as part of the recorded label.

Media Manager
Software that is part of NetBackup and manages the storage devices and removable
media.

Media Manager Host

Host where Media Manager is installed (may have devices attached).

media server

A NetBackup server that provides storage within a master and media server cluster. The
master can also be a media server. A media server that is not the master is called a remote
media server. NetBackup BusinesServer does not support remote media servers.

menu interface

A character-based interface for use on terminals that do not have graphical capabilities.

mount

Make a volume available for reading or writing.

mount point

The point where a file system on a disk logically connects to a system’s directory structure
so the file system is available to users and applications.
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MPX

See “multiplexing.”

mtime

The point in time when a UNIX or NTFS file is modified.

multiplexing
The process of sending concurrent-multiple backups from one or more clients to a single
storage device and interleaving those images onto the media.

multiplexed group

A set of backups that were multiplexed together in a single multiplexing session.

NDMP
Network data management protocol. NetBackup requires the NetBackup for NDMP
separately-priced option to support NDMP.

NetBackup Client service

NetBackup Windows service that runs on clients and servers and listens for connections
from NetBackup servers and clients in the network. When a connection is made, this
service starts the necessary programs.

NetBackup configuration options

On UNIX servers and on UNIX and Macintosh, clients, these settings are made in the

bp . conf file. On NetWare target and OS/2 clients, they are in the bp . ini file. On
Windows servers and Windows clients, these settings are called properties and are made
through the Backup, Archive, and Restore interface or the Host Properties dialog in the
NetBackup Administration Console.

NetBackup databases

See catalogs.

NetBackup Database Manager service

NetBackup Windows service that runs on the master server and manages the NetBackup
internal databases (called catalogs). This service must be running on the master server
during all NetBackup administrative operations.
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NetBackup Device Manager service
The NetBackup Windows service that runs on a NetBackup server and starts the robotic
control processes and controls the reservation and assignment of volumes. This service
runs only if the server has devices under Media Manager control. The process is 1tid.

NetBackup properties
Same as NetBackup configuration options but are called NetBackup properties on
Microsoft Windows platforms.

NetBackup Request Manager service
The NetBackup Windows service that runs on the master server and starts the scheduler
and receives requests from clients.

NetBackup Volume Manager service

A NetBackup Windows service that runs on a NetBackup server, allows remote
administration of Media Manager, and manages volume information. The process is vmd.

NIS

Network information service.
NLM

NetWare loadable module.
NFS

Network file system.
nonrobotic

See “standalone.”
ODL

Optical disk library. This robot type is supported only by NetBackup DataCenter servers.

offsite volume group

A volume group in which media will appear after having been ejected from the robot for
vaulting. When Vault ejects media it is moved from the robotic volume group to the
off-site volume group.
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offsite volume pool

A volume pool that contains media that is to be ejected and vaulted. Backup images
written to an off-site volume pool by an original NetBackup backup policy or by Vault’s
duplication feature will be ejected and vaulted. More than one off-site volume pool can be
specified for the Eject step of a Vault profile.

original backup

A backup image created by a backup job. A single backup image or all backup images
created by an Inline Tape Copy (multiple copy) configuration are considered original
backups. A backup image created by a duplication job is not an original backup.

outport
See “media access port.”
partitions
The logical partitions into which a magnetic disk is divided.
patch
A program that corrects a problem or adds a feature to an existing release of software.
path length
Number of characters in a pathname.
pathname
The list of directories in the path to a destination directory or file.
PC clients
NetBackup clients that have Microsoft Windows, Macintosh, or IBM OS/2 operating
systems.
peername
The name by which a computer identifies itself when establishing connections to other
systems.
policy
Defines the backup characteristics for a group of one or more clients that have similar
backup requirements.
———
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port
A location used for transferring data in or out of a computer.

Also see “media access port.”

primary copy
The copy of an image that NetBackup uses to satisfy restores. When NetBackup duplicates
an image, the original is designated as the primary copy.

privileges

The tasks or functions that a user, system, or application is authorized to perform.

profile

A vault profile is a way to save configuration settings. Specific parameters for duplication,
catalog backup, eject, and report or any combination of these steps, are configured within
a profile.

progress report

Log where NetBackup records events that occur during user operations.

proxy restore

A proxy restore allows the user to restore files that he has write access to, on a machine
other than his desktop. The files must be in a backup of the machine to which they are
being restored.

QIC

Quarter-inch-cartridge tape.

gueued job

A job that has been added to the list of jobs to be performed.

raw-partition backup
Bit-by-bit backup of a partition of a disk drive on UNIX. On Windows, this is called a
disk-image backup.

rbak

The program that Apollo clients use to read data from tape during a restore.
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recorded media ID

This is an identifier written as part of the label on a volume and used by Media Manager
to ensure that the correct volume is mounted. The recorded media ID should match the
external media ID.

redirected restore (different client)

Restoring files to your client when they were originally backed up from a different client.
The administrator using the interface on the master server can direct a restore to any client
(this variation is called a server directed restore).

redirected restore (different target)

On a Novell NetWare server platform running the NetBackup target version of client
software, this operation restores files to a different target than the one from which they
were backed up.

redirected restore (different path)

Restores files to a different directory than the one from which they were backed up.

registry

A Microsoft Windows database that has configuration information about hardware and
user accounts.

remote administration console
A Windows NetBackup client that has the administration interface software installed and
can be used to administer NetBackup servers.

remote media server
A media server that is not the master. Note that only NetBackup DataCenter supports
remote media servers. NetBackup BusinesServer supports only a single server, the master.

residence

In Media Manager, information about the location of each volume is stored in a volume
database. This residence entry contains information, such as robot number, robot host,
robot type, and media type.

resource

A Novell NetWare term that refers to a data set on the target. For example, in DOS,
resources are drives, directories, and files. Also see “target service.”
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restore

(verb) The act of restoring selected files and directories from a previous backup or archive
and returning them to their original directory locations (or to a different directory).

(noun) The process of restoring selected files and directories from a previous backup and
returning them to their original directory locations (or to a different directory).

retention level
An index number that corresponds to a user-defined retention period. There are 10 levels
from which to choose (0 though 9) and the retention period associated with each is
configurable. Also see “retention period.”

retention period
The length of time that NetBackup keeps backup and archive images. The retention
period is specified on the schedule.

robotic arm

The component of a robotic library that physically selects the media (tape or optical disk).

robotic library

Refers to a robot and its accompanying software. A robotic library includes a collection of
tapes or optical platters used for data storage and retrieval. For example, a Tape Library
DLT (TLD) refers to a robot that has TLD robotic control.

robotic volume group

A volume group from which media will be ejected and vaulted. When Vault duplicates
backups, they are duplicated to media in the robotic volume group.

root
The highest level directory in a hierarchical directory structure. In MS-DOS, the root
directory on a drive is designated by a backslash (for example, the root on drive C is C:\).
On UNIX;, the root directory is designated by a slash (/).
Also, a UNIX user name having administration capability.

RS-232
An industry-standard interface for serial communications and sometimes used for
communicating with storage peripherals.
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RSM Interface

Application in Windows 2000 used to manage Removable Storage Manager (RSM)
devices.

RSM - Removable Storage Manager

RVSN

schedules

SCSI

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

Also, a component of the Windows 2000 operating system that manages storage devices.

See “recorded media ID.”

Controls when backups can occur in addition to other aspects of the backup, such as: the
type of backup (full, incremental) and how long NetBackup retains the image.

Small computer system interface. This is a type of parallel interface that is frequently used
for communicating with storage peripherals.

server-directed restore

Using the user interface on the master server to restore files to any client. Only the
administrator can perform this operation.

server independent restore

server list

service

Restoring files by using a NetBackup server other than the one that was used to write the
backup. This feature is available only with NetBackup DataCenter.

The list of servers that a NetBackup client or server refers to when establishing or
verifying connections to NetBackup servers. On a Windows server and Microsoft
Windows clients, you update the list through a dialog box in the interface. On a UNIX
server and UNIX and Macintosh clients, the list is in the bp . conf file. On NetWare target
and OS/2 clients, the list is in the bp . ini file.

A program on a Windows server system that runs in the background and performs some
task (for example, starting other programs when they are needed). Services are generally
referred to as daemons on UNIX systems.
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session

An instance of NetBackup checking its schedules for backups that are due, adding them to
its worklist, and attempting to complete all jobs in the worklist. For user backups and
archives, a session usually consists of a single backup or archive.

Session (Vault)

A vault session consists of executing a particular profile or profiles.

shared drives

See “Shared Storage Option (SSO).”

Shared Storage Option (SSO)

A separately priced VERITAS software option that allows tape drives (standalone or in a
robotic library) to be dynamically shared among multiple NetBackup and Storage
Migrator servers.

This option is supported only on NetBackup DataCenter servers.

SMDR
Storage management data requestor, a Novell NetWare program that provides its services
transparently to all SMS modules and lets remote and local modules communicate with
one another.

SMS

Novell NetWare storage management services.

source volume group

A volume group from which Vault can select backups to duplicate. This parameter is used
to restrict the list of backups from all backups that reside on media in any volume group
to backups that reside on media in a single volume group. Where a volume group
corresponds to a particular robot, the profile will duplicate only backups on media in that
robot. The Source Volume Group is normally only specified if you have multiple robots
attached to the same server, for example you want to duplicate backups that reside in
robot 0 to media that reside in robot 1.

SSO

See “Shared Storage Option (SSO).”
stacker

Usually a small robotic library that contains one drive only. See “robotic library.”
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standalone

A qualifier used with drives and media to indicate they are not associated with a robot.
For example, a standalone tape drive is one where you must manually find and insert
tapes before using them. A standalone volume is one that is located in a standalone drive
or is stored outside of a drive and designated as standalone in the volume configuration.
status code
A numerical code, usually accompanied by a troubleshooting message, that indicates the
outcome of an operation.
storage migrator

Refers to the VERITAS Storage Migrator line of hierarchical storage management products
for UNIX and Windows. These products make extra room on a disk by transparently
moving data to other storage and then transparently retrieving the data when it is needed
by a user or application.

Storage Migrator is available only for NetBackup DataCenter servers.

storage unit

Refers to a storage device where NetBackup or Storage Migrator stores files. It can be a set
of drives in a robot or consist of one or more single tape drives that connect to the same
host.

SUSPENDED media state

If a volume is SUSPENDED, NetBackup can restore from it but cannot use it for backups.
NetBackup retains a record of the media ID until the last backup image on the volume
expires.

symbolic link

On a UNIX system, this is a pointer to the name of the file that has the source data.

TapeAlert

Allows reactive cleaning for most drive types and is a function of the tape drive.

tape format

The format that an application uses to write data on a tape.

tape marks

A mark that is recorded between backup images on a tape.
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tape overhead
The space required for data that is not part of the backup images. For example, tape marks
and catalogs of what are on the tape are considered overhead.

tape spanning

Using more than one tape to store a single backup image.

tar

Tape Archive program that NetBackup uses to extract backup images during a restore.

target

See “target service.”

target service
A Novell NetWare service that needs storage management. The SMS views all services
(for example, print services, communication services, workstations) as targets.

Target Service Agent
A Target-service agent is a Novell NetWare agent that prepares the target's data for SMS
during a backup and for the target during a restore.

TLD - Tape Library DLT
A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

TLH - Tape Library Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TLM - Tape Library Multimedia

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TL4 - Tape Library 4AMM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.
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TL8 - Tape Library 8MM
A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

timeout period

The period of time that an application has allotted for an event to occur.

TIR

See “true image restore.”

tpconfig

A Media Manager administration utility for configuring devices which is started from the
command line. On UNIX; it has a character-based menu interface that can be run from
terminals that do not have X Windows capabilities. tpconfig also has a command line
interface.

transfer rate

The rate at which computer information is transferred between a source and a destination.

transport

See “robotic arm.”

true image restore

Restores the contents of a directory to what it was at the time of any scheduled full or
incremental backup. Previously deleted files are ignored.

TS8 - Tape Stacker 8MM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

TSA

See “Target Service Agent.”

TSD - Tape Stacker DLT

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.
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TSH - Tape Stacker Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

unassigned media

Media that contain no valid images. A piece of unassigned media has an entry in the
volumes database but no entries in the images database. Unassigned Media do not have a
“time assigned” in the Media section of the GUI.

user interface

The program used to perform user backups, archives, and restores.

user operation

A backup, archive, or restore that is started by a person on a client system.

Vault

Vault is a separately-priced NetBackup option that provides offsite backup management.
Vault automatically duplicates specified backup images, and automates the process of
offsite media rotation (a critical component of any backup or disaster recovery strategy).
Vault manages offsite storage and retrieval of media for original backups, duplicate
backups, and catalog backups. Additionally, NetBackup Vault generates reports to track
the location and content of each piece of media.

vault

In the context of the NetBackup Vault, a vault is logical entity associated with a particular
robot that acts as a designated holding place for backups that will eventually be sent to a
physical offsite vault. The term ‘vault’ is used to refer both to the process, and to the
physical storage location of a set of tapes offsite.

vault process

Vaulting is the process of choosing backup images to duplicate or eject, optionally
duplicating backups, ejecting duplicate or original media, storing it at an offsite location,
and later returning expired media to your robot. Vaulting is an integral part of the disaster
recovery process.

verbose flag

Configuration file entry that causes a higher level of detail to be written in the logs.

Glossary 173 ——



verify

An operation that compares the list of files that are actually on a volume with what
NetBackup has recorded as being on it. The data that is on the media is not verified.

vmadm
A Media Manager administrator utility for managing volumes. It runs on UNIX and has a
character-based, menu interface that can be run from terminals.
vm.conf
A Media Manager configuration file with entries that include the servers that can manage
local devices and default media ID prefixes for media that do not contain barcodes.
volume

Media Manager volumes are logical units of data storage or cleaning capability on media
that have been assigned media IDs and other attributes, which are recorded in the Media
Manager volume database.

volume configuration

Refers to configuration information that is stored in the Media Manager volume database.

volume database

An internal database where Media Manager keeps information about volumes. All hosts
(where Media Manager is installed) have a volume database. However, the database is
empty unless the host is designated as a volume database host.

volume database host

The host (where Media Manager is installed) that contains information about the volumes
that Media Manager uses in a device. Because NetBackup BusinesServer supports only a
single server, the volume database host is always on the same server.

volume group
A set of volumes that are configured within Media Manager to reside at the same physical
location (for example, in a specific robot).

volume pool
A set of volumes that are configured within Media Manager to be used by a single
application and are protected from access by other applications and users.

wakeup interval

The time interval at which NetBackup checks for backups that are due.
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wildcard characters

A character that can be used to represent other characters in searches.

Microsoft Windows
(noun) Describes a line of operating systems developed by Microsoft, Inc.
For more information on the Windows operating systems that NetBackup supports, refer
to the VERITAS support web site at http: //www. support .veritas.com.
Windows
(adjective) Used to describe a specific product or clarify a term. Some examples are:
Windows 95, Windows 98, Windows NT, Windows 2000, Windows servers, Windows
clients, Windows platforms, Windows hosts, and Windows GUI.
Windows servers
A term that defines the Windows server platforms that NetBackup supports; those
platforms are: Windows NT and 2000.
Windows clients
A term that defines the Windows client platforms that NetBackup supports; those
platforms are: Windows 95, 98, ME, NT, 2000, XP (for 32- and 64-bit versions), and LE.
Windows Display Console

A NetBackup-Java interface program that runs on Windows 2000, NT, 98, and 95
computers. Users can start this interface on their local system, connect to a UNIX system
that has the NetBackup-Java software installed, and then perform any user operations
that their permissions allow.

WORM media

Write-once, read-many media for optical disks. NetBackup BusinesServer does not
support WORM media.

xbp
The X Windows-based backup, archive, and restore program for users on NetBackup
UNIX clients.
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